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About This Manual

This manual describes how to use BD FACSDiva™ software. For information on 
how to operate and maintain your flow cytometer, refer to the instrument user’s 
guide. 

The BD FACSDiva Software Reference Manual assumes you have a working 
knowledge of basic Microsoft® Windows® operation. If you are not familiar 
with the Windows operating system, refer to the documentation provided with 
your computer.

First-time users of BD FACSDiva software should read

• Chapter 1 for software requirements and compatibility, installation, and 
administrative options

• Chapter 2 and Chapter 3 to learn about basic software functions and 
instrument controls

• Chapter 4 to learn about analysis tools like worksheets, plots, gates, and 
statistics

• Chapter 5 to learn how to manage data and import and export files

For practice tutorials to help you get started with the software, use the 
BD FACSDiva Software Quick Start Guide.

Once you become familiar with routine operation and need only a quick 
reminder of the software menus or keyboard shortcuts, see Appendix A. For a 
review of digital theory, see Appendix B. 
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Conventions

The following tables list conventions used throughout this guide. Table 1 lists 
symbols that are used to alert you to a potential hazard. Text and keyboard 
conventions are shown in Table 2. 

Table 1  Hazard symbols

Symbol Meaning

CAUTION: hazard or unsafe practice that could result in material damage, 
data loss, minor or severe injury, or death

Table 2  Text and keyboard conventions

Convention Use

Tip     Highlights features or hints that can save time and prevent 
difficulties

NOTICE     Describes important features or instructions

Italics Italics are used to highlight book titles and new or unfamiliar 
terms on their first appearance in the text. 

> The arrow indicates a menu choice. For example, “choose 
File > Print” means to choose Print from the File menu.

Ctrl-X When used with key names, a dash means to press two keys 
simultaneously. For example, Ctrl-P means to hold down the 
Control key while pressing the letter p. 
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Using Microsoft Windows

Tip     To delete objects in the workspace, be sure to press the Delete key rather 
than the Backspace key.

You will notice that the Windows mouse has two selection buttons. Most actions 
are performed with the left button. Press the right mouse button while clicking an 
icon or object to open a contextual menu. Contextual menus contain common 
commands that apply to the selected item. For example, by clicking an open 
Experiment with your right mouse button, you can choose to copy, rename, or 
close the Experiment.

Technical Assistance

For technical questions or assistance in solving a problem:

• In BD FACSDiva software, choose Help > Online Help. Locate and read 
topics specific to the operation you are performing. 

• Refer to the Troubleshooting section in the Software or Instrument Help 
books.

If additional assistance is required, contact your local BD Biosciences technical 
support representative or supplier. 

When contacting BD Biosciences, have the following information available:

• product name, part number, and serial number; software version and 
computer system specifications

• any error messages

• details of recent instrument performance

For instrument support from within the US, call (877) 232-8995, prompt 2, 2.

For support from within Canada, call (888) 259-0187.
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Customers outside the US and Canada, contact your local BD representative or 
distributor.

Limitations

For in vitro diagnostic (IVD) use when used with IVD reagents and instruments. 
Refer to the information supplied by the manufacturer for application-specific 
limitations.
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Software Installation and Setup

The following topics are covered in this chapter:

• About BD FACSDiva Software on page 16

• Installing BD FACSDiva Software on page 19

• Starting the Software on page 34

• Administrative Options on page 36

• Quitting the Software on page 41
15



About BD FACSDiva Software

BD FACSDiva software is a flexible data acquisition and analysis package 
specifically designed for digital-based flow cytometers. The software uses flexible 
features to simplify acquisition, including Experiment templates, user-definable 
experiment layouts, and automated compensation calculation. The unique 
software also provides powerful analysis features including one-click Snap-To 
gating tools, hierarchical gating, and biexponential display. 

To simplify Experiment and data management, BD FACSDiva software uses a 
Browser view that allows users to easily organize Experiments, group Specimens 
and Tubes, design global or tube-specific analyses, and set independent 
instrument settings. The Browser also allows you to manage and process 
recorded data in the context of a single Tube or panel as well as an entire 
Experiment.

Supporting the BD FACSCanto™, BD FACSAria™, BD™ LSR II, or 
BD FACSVantage™ SE upgraded with the digital electronics option, this PC-
based software provides the user with all the setup, acquisition, control, and 
analysis features to quickly and efficiently generate quality data from a 
BD FACS™ brand digital flow cytometer.

What’s Included

The BD FACSDiva installer installs the following applications:

• BD FACSDiva software for acquiring and analyzing data

• BD FACSDiva Data Management Utility program for backing up and 
restoring data

• Sentinel System Driver™ for using the security module

• Java™ 2 Runtime Environment (JRE) for running BD FACSDiva software

• Sybase™ SQL Anywhere™ Studio for running the database

• Adobe® Acrobat® Reader for viewing the PDF version of the reference 
manual and quick start guide
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Documentation

The software includes online and paper documentation to help you learn how to 
use the application. 

• The BD FACSDiva Software Quick Start Guide contains tutorials to help 
new users get started using the software, or experienced users become 
familiar with new features. A PDF file of the quick start guide can be 
accessed from Start > Programs > BD FACSDiva Software.

• The online help system contains information on how to use BD FACSDiva 
software and your instrument. To access the online help, choose Help > 
Online Help within BD FACSDiva software. 

The online help opens in a separate window so you can access the 
documentation while working in the software. You can quickly locate 
information using the Search tab.

• The BD FACSDiva Software Reference Manual contains reference 
information on all software components. It is available as a PDF that can 
be opened, searched, and printed using Adobe Acrobat Reader.

To access the BD FACSDiva Software Reference Manual, choose 
Help > Software Manual or double-click the shortcut icon on 
the desktop.

System Requirements

Hardware

• BD FACS brand digital flow cytometer: BD FACSAria, BD FACSCanto, 
BD LSR II, or BD FACSVantage SE cytometer upgraded with the digital 
electronics option.

• (BD FACSVantage SE instruments only) BD FACS™ Accudrop option
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• PC workstation configured to BD Biosciences specifications

- Acquisition workstations can be purchased only from BD Biosciences. 
The computer must have at least 2 GB of RAM.

- Analysis-only workstations must be equipped with a Pentium® III 
Xeon® 1 GHz processor or higher with at least 512 MB of RAM 
(2 GB for large data files), 10 GB of available hard-drive space, and the 
Windows 2000 Pro or Windows XP Pro operating system. For optimal 
performance and full analysis capability, we recommend that you 
purchase a workstation that has been validated by BD Biosciences. 
Contact your sales representative for more information.

NOTICE     Make sure your operating system has been upgraded to Service 
Pack 4 (SP4) for Windows 2000 Pro, or SP1 or 1A for Windows XP. You 
can order or download service packs from the Microsoft website at 
http://www.microsoft.com/Windows2000/downloads/servicepacks/sp4/.

Workstation requirements are subject to change. Contact your 
BD Biosciences sales representative for up-to-date requirements.

• Universal Serial Bus (USB) security module (provided with the computer)

Software

The following software is required to run BD FACSDiva software. The installer 
for each application is launched automatically during BD FACSDiva software 
installation.

• Sentinel System Driver

• Sybase SQL Anywhere Studio 

• Java 2 Runtime Environment

Adobe Acrobat Reader is optional; it is needed to view the PDF version of the 
reference manual or quick start guide. You can install Acrobat Reader during 
BD FACSDiva software installation.
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Compatibility

• BD FACSDiva software can import files in FCS 2.0 or 3.0 format, including 
files generated by BD CellQuest™, BD CellQuest™ Pro, or BD FACSDiva 
software. 

NOTICE     BD FACSDiva software cannot open BD CellQuest or 
BD CellQuest Pro Experiment documents.

• BD FACSDiva software can export FCS 2.0 or 3.0 data files. FCS 2.0 files 
can be analyzed by other software applications such as BD CellQuest, 
BD CellQuest Pro, FlowJo™, or ModFit LT™. 

NOTICE     Use BD FACS™ Convert software to translate certain exported 
FCS 2.0 files into a Macintosh®-compatible format. BD CellQuest Pro 
software can analyze FCS 2.0 data files containing up to 16 parameters; it is 
provided with the BD FACStation™ data management system.

Installing BD FACSDiva Software

BD FACSDiva software has already been installed on workstations purchased 
from BD Biosciences. Use the following instructions for recovery purposes in case 
you need to reinstall the software, or when you are installing the software for the 
first time. An installation CD is included with the BD FACSDiva Software 
Reference Manual.

If you are upgrading the software, carefully follow the upgrade instructions 
provided with the CD.

NOTICE     You must have Administrative access to install BD FACSDiva software. 
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Before Beginning This Procedure

Do the following before you begin installing the software.

If you are upgrading or reinstalling the software:

1 Make a backup copy of your current database. 

See Backing Up the Database on page 212.

2 Uninstall the previous version of the software.

See Uninstalling the Current Software on page 29.

3 (Acquisition workstations, only) Reset the instrument electronics.

• Turn on the instrument main power. (If the power is already on, turn it 
off, and then on again.)

• Wait 5 minutes and restart the computer.

All customers:

• Make sure your operating system has been upgraded to Service Pack 4 
(SP4) for Windows 2000 Pro, or SP1 or 1A for Windows XP. You can order 
or download service packs from the Microsoft website at 
http://www.microsoft.com/Windows2000/downloads/servicepacks/sp4/.

• Close all open applications and windows.

• BD Biosciences recommends that you defragment the hard disk before you 
install new software.

It takes approximately 5 minutes to fully boot up the cytometer electronics. 
To successfully complete the installation, you must restart the computer 
only after the cytometer electronics are fully booted.
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Installing New Software

The installer adds the following components to the hard drive. When the correct 
version of a required component is not installed, the installer upgrades the 
component.

• BD FACSDiva software

• Data Management Utility

• Sentinel System Driver v5.41.1

• Java 2 Runtime Environment (JRE) v1.4.2_02

• Sybase SQL Anywhere v8.0.2

• Adobe Acrobat Reader v6.0

1 Insert the BD FACSDiva installation CD into the CD-ROM drive.

If the installer does not start automatically, use Windows Explorer to view 
the CD contents; find and double-click the Setup.exe icon. 

2 Review the ReadMe file; click the close box to continue with installation.

The ReadMe file contains important software information that is not 
included in this manual. Carefully review the file; then click the close box 
to return to Software Setup.

Tip     BD Biosciences recommends that you print the ReadMe file and place 
the printed copy with your BD FACSDiva Software Quick Start Guide or 
instrument manual for reference.
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3 When the welcome screen appears, click Next.

4 Click Yes to accept the license agreement and continue installation.

5 Review the installation instructions, and click Next.

6 Verify the destination folder; click Next.

By default, the software is installed in the Program Files\BD FACSDiva 
Software folder on the C: drive. 
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7 In the Cytometer Selection window, select the checkbox for your flow 
cytometer, and click Next.

The selection determines which firmware update and instrument online 
help files will be installed.

Tip     For offline workstations, choose the instrument that is used most 
often in your laboratory. 

8 Verify the destination folder for the database; click Next.

By default, the database is installed in the BDDatabase folder on the D: drive. 
If there is no logical D drive on your system, database installation defaults 
to the C: drive.

NOTICE     Ensure that the destination folder does not reside on a removable 
media drive such as a Zip, CD, or DVD drive, or on a network drive. If you 
need to change the drive, keep the same folder name and path.

select one
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9 If you are prompted to do so, select a database option, and click Next. 

• (Recommended) Select Existing database to continue working with 
data in the current database. The database will be upgraded to work 
with the new software version.

• Select New empty database... to install an empty database. The existing 
database will be renamed BDFACS.dbx, where x is the next 
consecutive number.

10 (Optional) Click Yes to install or upgrade Adobe Acrobat Reader.

This version of BD FACSDiva software provides an updated version of 
Acrobat Reader (version 6.0), which is used to view the PDF version of the 
reference manual and quick start guide. To install or upgrade the software, 
follow the instructions in the dialog boxes and accept all default options.
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11 Wait 15–20 seconds while the installer checks your version of JRE; click 
Yes to install it if prompted to do so.

Follow the instructions in the dialog boxes and accept all default options to 
install JRE. If the correct version of JRE is already installed, the installer 
skips to the next installation.

12 Wait 15–20 seconds while the installer checks your version of Sybase SQL 
Anywhere; click Yes to install it if you are prompted to do so. 

An information message appears; click OK to dismiss the message. The 
following dialog box appears:

Click OK to dismiss the message. For instructions on installing Sybase SQL 
Anywhere, turn to page 30. When finished, return to this section and 
continue with step 13 to finish BD FACSDiva software installation.

Do not restart your computer after you install Sybase SQL Anywhere 
software. If you do, the BD FACSDiva software installation process will 
stop and you might have problems completing it later. 
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13 Review the installation settings; click Next to begin copying files. 

The installer loads BD FACSDiva software and its support files on the 
specified drives. If the workstation is connected to a cytometer, the installer 
downloads a new version of VxWorks (operating system that runs the 
cytometer). 

While the installer is checking to see if the workstation is connected to a 
cytometer, the following message appears on the screen:

When all required files have been installed, a screen appears with the 
message “BD FACSDiva software has been installed.” 

If the VxWorks download is unsuccessful, the following message appears:

• If you are installing the software on an analysis-only workstation, 
click No. The VxWorks download is not required.

• If you are installing the software on an acquisition workstation, verify 
that the instrument is turned on and connected to the workstation, and 
then click Yes to try the VxWorks download again.

Do not click the mouse or press any keys while the DownloadVxWorks 
message is displayed. Doing so could cause the installer to lock up and 
prevent installation from continuing. 
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If the same message appears again, click No, finish the installation, and 
contact BD Biosciences technical support. Do not run your flow 
cytometer until VxWorks has been installed successfully.

14 If you have not already done so, click Next to review the ReadMe file; click 
the close box to continue with installation.

Tip     BD Biosciences recommends that you print the ReadMe file and place 
the printed copy with your BD FACSDiva Software Quick Start Guide or 
instrument manual for reference.

15 Install the security module in the USB port at the back of the computer 
workstation, if needed.

The security module must be in place to run BD FACSDiva software.

NOTICE     The location of your USB port and the cables on your workstation 
might be set up differently from those shown in this figure. The security 
module can be installed in any USB port.

16 Click Finish to complete the installation. 

It is recommended that you reboot the computer before starting the 
software for the first time.
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NOTICE     If you are reinstalling the software, turn the flow cytometer 
power off and then on, and then restart the computer. 

Files Installed

The installer places shortcuts to BD FACSDiva Software, 
BD FACSDiva Data Manager, the BD FACSDiva Software 
Reference Manual (PDF file), and the ReadMe file on the 
desktop. These shortcuts are also added to the Start menu 
(Start > Programs > BD FACSDiva Software...).

The software and all supporting files are placed in the 
Program Files folder on the specified drive. You will find a copy of the ReadMe 
file and supporting documentation, including a PDF file of the reference manual 
and quick start guide, in Program Files\BD FACSDiva Software as well as on the 
software CD.

To ensure that data can be accessed by the software, do not move, rename, 
or delete the BDFACS.db file, BDFACS.log file, or BDData folder inside the 
BDDatabase folder. Do not change the name of any file or folder within the 
BDData folder.

shortcuts 
on desktop
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Uninstalling the Current Software

Follow the steps in this section only if you need to remove the current software 
version from your system. The uninstall process removes the current software 
and associated files while preserving the database and list-mode data files. When 
you reinstall the software, you will have the option to reuse your existing data 
files or install an empty database.

NOTICE     Area scaling, window extension, and laser delay values are stored in the 
database. If you plan to install an empty database, record these values before 
uninstalling the software so you can reenter them later. To preserve these settings 
when you are running a BD FACSCanto flow cytometer, copy the existing 
cytometer.dat file in C:\Program Files\Common Files\BD into the D:\Service\ 
directory. When prompted, click Yes to overwrite the existing file. After the 
upgrade is finished, replace the new cytometer.dat file with the backed-up copy.

1 From the Windows Start menu, choose Settings > Control Panel.

2 Double-click the icon for Add/Remove Programs.

3 Locate and select BD FACSDiva software in the list of currently installed 
programs; click Change/Remove.

4 Follow the prompts on the screen to remove all installed components, and 
then click Finish.

If you are reinstalling the software, DO NOT uninstall Sybase SQL 
Anywhere (there might be two versions on your system). If you uninstall 
Sybase, it will break the environment variable PATH and prevent many 
applications from running, including BD FACSDiva software. Reinstalling 
Sybase does NOT fix the problem.
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5 Restart your computer.

6 If you are reinstalling the software, go to Installing New Software on 
page 21 to complete the process.

Installing Sybase SQL Anywhere Studio

This version of BD FACSDiva software provides an updated version of Sybase 
SQL Anywhere, which is required to use BD FACSDiva software. Do the 
following to install the new version of Sybase SQL Anywhere.

The SQL Anywhere Studio Setup program is started automatically from within 
BD FACSDiva Setup.

1 Click Next to begin installing SQL Anywhere.

2 Review the license agreement, select the radio button to accept the terms of 
the agreement, and then click Next.
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3 Verify the install location and click Next.

By default, SQL Anywhere is installed on the C: drive.

4 At the shared folder screen, click Next.

5 (Optional) At the Select Components screen, scroll to Tools. Deselect the 
Documentation component, and then click Next.

Tip     Save disk space by installing the software without its accompanying 
documentation.

deselected
component
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6 At the Server License screen, change the License Type to Concurrent Seat 
model, and click Next.

7 At the Select Program Folder screen, click Next.

8 Click Next to start copying files.

9 When Setup is complete, deselect the checkbox to review the ReadMe file, 
and click Finish.

10 At the Install Complete screen, select the radio button to restart the 
computer later, and click Finish (Figure 1-1 on page 33).

Do not restart your computer until you have finished installing 
BD FACSDiva software. If you restart the computer now, the installation 
process will stop and you might have problems completing it later.

click to
select
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Figure 1-1  Deferring restart until after BD FACSDiva installation is complete

11 Return to step 13 on page 26 to continue installing BD FACSDiva 
components.
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Starting the Software

NOTICE     If you are using the software for acquisition from the cytometer, start 
the software as described in your instrument manual.

Before starting the software for the first time, review the BD FACSDiva ReadMe 
file. A shortcut is copied to the Windows desktop during installation. 

To start the software, do the following:

1 Double-click the shortcut icon on the desktop.

Alternatively, choose Start > Programs > 
BD FACSDiva Software > BD FACSDiva Software.

The BD FACSDiva workspace appears, showing the 
Log In dialog box.

2 Leave the login name as Administrator, and click OK. 

No password is required the first time you log into the software. You 
should assign a password to the administrator account as soon as possible. 
For instructions, see Adding or Modifying a Password on page 40.

To create additional user names, see Adding Users on page 36.

After a successful login, frames appear in the workspace (Figure 1-2 on 
page 35). (Your workspace might look slightly different from that shown in 
this example.) For a full description of workspace components, see 
Chapter 2.

shortcut icon
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Figure 1-2  BD FACSDiva workspace

NOTICE     To verify the workstation has successfully connected to the cytometer, 
check that the Instrument frame displays the message “Instrument connected” or 
“The system is ready” at the bottom of the frame. If the message reads 
“Instrument Disconnected,” see Electronics Troubleshooting on page 219 for 
assistance.

close box

connectivity status
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Administrative Options

If you have administrator privileges in BD FACSDiva software, you can add or 
disable users as described in the following sections. For instructions on changing 
your password, see Adding or Modifying a Password on page 40. Note that all 
users can add or modify passwords; you do not need administrative access.

Adding Users

Only the system administrator or users with administrative access can add users.

1 Log into the software.

2 Choose File > Administration.

The Account Administration dialog box appears, where you can add or 
modify the attributes of a user, enable or disable users, or grant 
administrative access.

3 Click Add to add a user.
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4 Select the generic name in the User Name field, and enter a new name. 

User names can consist of 4–20 alphanumeric characters. Spaces are not 
allowed.

5 Press the Tab key or click in the next field; enter a password, if needed.

Passwords are not required. If you want to add one, enter one from 1–16 
alphanumeric characters.

6 Confirm the password, if entered, by typing it again.

7 (Optional) Enter the user’s full name, initials, and institution in the 
remaining fields.

This information is not required; you can leave the fields blank, if you like. 
To add an institution, define choices by clicking on the “…” button next to 
the Institution drop-down menu:

generic name

button
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The following dialog appears where you can add or modify choices:

• To add an institution, click Add. “Institutex” is added to the list of 
names. Change the name by selecting “Institutex” in the Name field 
and entering a new name. Press Enter to apply the change, or click OK 
to apply the change and dismiss the dialog box.

• To delete an institution, select the name in the list and click Delete. 
Click OK to dismiss the dialog box.

Once you click OK, all listed institutions can be chosen from the Institution 
drop-down menu in the Account Administration dialog box. Note that 
unassigned institutions are not saved from one login session to the next.

8 To grant the user administrative access, select the Administrator checkbox.

Users with administrative access can add or modify other user accounts.

9 Ensure all user information is correct, and click Save.
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Deleting Users

Note that you must have administrative access to delete a user.

1 Export and then delete the user’s Experiments from the Browser. 

See Exporting Experiments on page 208 for instructions. Note that you can 
enable the option to automatically delete Experiments after export.

2 Choose File > Administration.

3 Select the user name in the list, click Delete, and then click Save.

Disabling a Saved User

When users have saved Experiments in the database, they cannot be deleted, but 
they can be disabled. Disabled users can no longer log into the software. 
However, their Experiments are saved in the database and their shared 
Experiments are available to all users.

1 Log into the software.

2 Choose File > Administration.

3 Select the user in the list of user names, and deselect the Enabled checkbox; 
click Save.
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Adding or Modifying a Password

BD Biosciences recommends that you assign a password to the administrator 
account as soon as possible. If you are not an administrator but have an assigned 
password, you can change your password as follows.

1 Log into the software.

2 Choose File > Administration.

The Account Administration dialog box appears showing only your user 
name, unless you have administrative access.

3 Enter a new password of up to 16 alphanumeric characters.

4 Confirm the password by re-entering it in the Confirm field.

Tip     Keep a copy of your password in a secure location in case you forget it.
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Quitting the Software

Do one of the following to quit the software:

• Choose File > Quit.

• Click the close box in the upper-right corner of the workspace (Figure 1-2 
on page 35).

All Browser and worksheet elements are automatically saved when you quit the 
software.
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2

BD FACSDiva Workspace

This chapter contains a description of the following BD FACSDiva workspace 
elements. Descriptions for other software components can be found in Chapter 3 
and Chapter 4.

• Workspace Components on page 44

• Inspector on page 47

• Browser on page 48

• Experiments on page 58

• Specimens on page 70

• Tubes on page 74

• Instrument Settings on page 78

• Analysis Objects on page 79

• Keywords on page 82

• User Preferences on page 86
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eet
Workspace Components

When you start BD FACSDiva software, the workspace appears (Figure 2-1). 
Frames containing the main software components are displayed within the 
workspace. Display or close frames by clicking buttons in the Workspace toolbar.

Most software functions are accessed using the menu bar at the top of the 
workspace and toolbars within the Browser and Worksheet frames. Acquisition 
and data loading is controlled using the Current Tube pointer or buttons within 
the Acquisition Controls frame. 

Figure 2-1  BD FACSDiva workspace

The following elements are displayed in the workspace:

• menu bar—contains pull-down menus with commands to operate the 
software

• Workspace toolbar—displays buttons used to save the current Experiment 
and to show or hide frames; see Workspace Toolbar on page 45.

menu bar

Workspace

Current Tube
pointer

Browser
toolbar

Worksh

acquisition
controls

 toolbar

toolbar
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Workspace Toolbar

The following buttons are displayed in the Workspace toolbar. Note that some 
buttons are shown only for certain instruments; refer to your instrument manual 
for details.

Save—saves the current Experiment to the database. Experiments are also 
saved when you close an Experiment or quit the software.

Browser—hides or shows the Browser frame; see Browser on page 48.

Instrument—hides or shows the Instrument frame; see Instrument 
Controls on page 92.

Inspector—hides or shows the Inspector frame; see Inspector on page 47.

Worksheet—hides or shows the Worksheet frame; see Worksheets on 
page 138.

Acquisition Controls—hides or shows the Acquisition Controls frame; see 
Acquisition Controls on page 104.

Acquisition Status—hides or shows the Acquisition Status frame; see 
Acquisition Status on page 108.

Sort Setup—hides or shows the Sort Setup frame

This button appears only if your instrument is equipped with sorting 
features. 

Carousel Controls—hides or shows the Carousel Controls frame

This button appears only if your instrument is equipped with the 
BD FACS™ Loader option. 

Plate Layout—hides or shows the Plate Layout frame

This button appears only if your instrument is equipped with the 
BD™ High Throughput Sampler (HTS) option. 

save view/hide buttons
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View Options

The BD FACSDiva workspace can be rearranged to suit your needs. You can 
resize the workspace window, or reposition or resize frames within the 
workspace. Changes are user-specific, and are saved from one login session to the 
next.

If you have a second monitor, the BD FACSDiva workspace can be viewed on 
both monitors. To maximize the workspace, click the maximize button. The 
Workspace will expand to fill the screen (or two screens, if applicable).

Whether viewed on one monitor or two, individual frames can be resized and 
repositioned for the most efficient operator workflow.

• To move a frame, drag the title bar to a new position on the screen.

• To resize a frame, position the cursor on the border of the frame. When the 
cursor changes to a double-headed arrow, drag the border.

Figure 2-2  Resizing a workspace frame

maximize button

double-headed arrow

close button
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• To view or hide different frames in the 
Workspace, choose an option from the View 
menu, or click the corresponding button in the 
Workspace toolbar.

You can also hide a frame by clicking the close 
button (Figure 2-2 on page 46).

• To restore frames to their default position and 
size, choose View > Reset Positions.

Inspector

The Inspector provides an easy-to-use interface for viewing or modifying the 
attributes of a single object or set of objects on the worksheet or in the Browser. 
For example, the Inspector can be used to change plot attributes like the 
background color, title, axes labels, and scale, or to enter the name of an 
Experiment, Specimen, or Tube.

To display the Inspector frame, click the Inspector button in the Workspace 
toolbar ( ). The contents of the Inspector frame vary depending on the object 
selected. For example, Figure 2-3 compares the contents of an Experiment 
Inspector (displayed when an Experiment is selected in the Browser) with those of 
a Statistics Inspector (displayed when a statistics view is selected on a worksheet). 

Figure 2-3  Experiment Inspector (left) vs Statistics Inspector (right)

Different Inspectors are described in the following sections.
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Browser

Unlike other BD software, BD FACSDiva software does not generate separate 
files for data display, instrument settings, and data. The software stores and 
accesses all experimental data from a single database. As you create Experiments 
and record data, the software writes Experiment components to the database. 
Stored elements are shown in the Browser. 

The Browser is where you create and access experimental data stored in the 
database. Data is listed by login name in a hierarchical view. You can hide or 
display the Browser by clicking the Browser button in the Workspace toolbar ( ).

Figure 2-4  Browser with representative Experiments

Users with administrative access can view all Experiments in the database. Those 
without administrative access can view only their own Experiments and any 
Experiments that have been designated as shared. For more information about 
private vs shared Experiments, see Making Experiments Private or Shared on 
page 65.

search field

column header

column divider

Browser toolbar

Experiment

closed
Experiment

open

Current Tube
pointer

user icon
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Using the Browser

The Browser has the following functions.

• lists Experiments saved in the BDFACS database

Adding or deleting elements from the Browser will add or delete elements 
from the database. Browser elements can be listed by name or date in 
ascending or descending order. Folders can be used to group Experiments. 
See Organizing the Browser on page 56.

Use the search field above the Browser to enter criteria to restrict the 
number of listed Experiments. See Using the Search Field on page 50. 

• provides an interface for setting up Experiments 

You must select elements in the Browser to activate certain buttons. For 
example, you must select a Specimen or Tube to activate the New Tube 
button. See Adding New Elements to the Browser on page 53.

• organizes experimental elements in a hierarchical view

- View elements listed under an Experiment, Specimen, or Tube by 
clicking once on the plus sign (+) next to the corresponding icon. 

- Sort Experiments in the Browser by clicking inside a column header. 
Click in the same header again to reverse the sort order.

- Resize columns in the Browser by dragging the column dividers.

Tip     Use the arrow keys on your keyboard to move between elements in the 
Browser. Use the right arrow key to expand an element, or the left arrow key 
to collapse it.

• provides shortcuts for renaming database elements, accessing element-
specific options, and acquiring and recording data

- Rename any Browser element in an open Experiment by selecting the 
element and entering a new name. (Alternatively, you can select the item 
and choose Edit > Rename, or right-click the item and choose Rename.)
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- Right-click any item in the Browser to display a contextual menu with 
options specific to that item. A summary of all contextual menus is 
provided in Contextual Menus on page 235.

- Use the Current Tube pointer to start and stop data acquisition and 
recording and to load data. See Using the Current Tube Pointer on 
page 52.

Using the Search Field

Use the search field in the Browser frame to find Experiments containing specific 
elements or to limit the number of Experiments listed in the Browser. For more 
search options, see Finding Saved Data on page 66.

1 Enter a search criterion (element name, fluorochrome label, custom 
keyword name or value, or population name), and then click the Find 
button. 

The Browser lists only Experiments containing the specified element, along 
with the currently open Experiment. In the example shown in Figure 2-5 on 
page 51, Experiment_001 is open at the time the search was performed, so 
it remains displayed even though it does not contain anything matching the 
search criteria. 

Note that you might have to expand a folder or user icon to see all 
Experiments. In Figure 2-5, the user icon for Administrator has a plus sign 
(+) next to it, indicating that one or more Experiments containing the 
required element are stored under the administrator login name.

Find
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Figure 2-5  Browser before and after using Find

2 (Optional) To hide shared Experiments matching the search criterion, click 
the View Own button ( ).

Experiments under the Shared View icon are hidden.

Note that all Experiments must be closed before you can use this button. If 
an Experiment is open, the button is disabled.

3 To list all Experiments again, click the Display All button ( ).

NOTICE     You cannot use the Search function to locate a folder. If a folder 
contains an Experiment that meets the search criteria, it will have a plus sign (+) 
next to it, indicating Experiments are inside the folder. 

If there are no Experiments containing the requested information, the Browser 
will list only the currently open Experiment along with any existing folders. To 
display all Browser elements again, click Display All.

open
Experiment

hidden
Experiment
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Using the Current Tube Pointer

When an Experiment is open, a grey pointer or plot icon appears next to Tubes in 
the Browser (Figure 2-6). Click the icon next to a Tube to set the Current Tube 
pointer, which indicates the Tube currently selected for data acquisition, 
recording, or data display on a global worksheet. When the software is connected 
to the instrument, the pointer can also be used to control acquisition and 
recording.

During Acquisition

When the software is connected to the cytometer, a grey pointer icon is displayed 
next to Tubes in the open Experiment. Click on the grey pointer icon to select the 
next Tube for acquisition or data display—the pointer turns green to indicate the 
currently selected Tube and acquisition starts if specified in user preferences. The 
name of the current Tube is displayed in the Acquisition Controls and 
Acquisition Status frames (Figure 2-6).

For other pointer states, see Current Tube Pointer on page 106.

Figure 2-6  Current Tube pointer during acquisition

current Tube
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During Analysis

When the software is disconnected from the cytometer or a recorded Tube 
contains incompatible instrument settings, a plot icon is displayed next to Tubes 
with recorded data in the open Experiment. Click on the grey plot icon to select 
that Tube for analysis—the plot icon is shaded and data for the selected Tube is 
shown in the global worksheet. To display data for a different Tube, click to 
move the Current Tube pointer.

Figure 2-7  Current Tube pointer during analysis

Adding New Elements to the Browser

Use buttons in the Browser toolbar to add new items to the Browser. You can 
also add items using menu commands or keyboard shortcuts. You must select 
elements in the Browser to activate certain buttons, as shown in the following table.

Tip     You can customize Browser toolbar buttons to add a predefined template to 
the Browser. See Template Preferences on page 89 for instructions.

To add…
First select or right-
click…

And then choose one of these 
options…

Folders •

•  (to create a 
folder inside a 
folder)

• Click the New Folder button ( ).

• Choose Experiment > New Folder.

• Choose New Folder from the 
contextual menu.

• Press Ctrl-N.

current Tube

shown only on sorting instruments shown only on instruments with a plate loader
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Experiments or 
Experiment templates

•

•  (to create an 
Experiment inside 
a folder)

• Click the New Experiment button 
( ).

• Choose New Experiment from the 
contextual menu.

• Choose Experiment > New 
Experiment or press Ctrl-E.

Specimens or panel 
templates

• • Click the New Specimen button 
( ).

• Choose New Specimen from the 
contextual menu.

• Choose Experiment > New 
Specimen or press Ctrl-M.

Tubes or analysis 
templates

•

•

• Click the New Tube button ( ).

• Choose New Tube from the 
contextual menu (available only 
when a Specimen is selected).

• Choose Experiment > New Tube 
or press Ctrl-T.

Specimen-specific 
instrument settings

• • Click the New Instrument Settings 
button ( ).

• Choose Experiment > New 
Instrument Settings.

• Choose New Instrument Settings 
from the contextual menu.

Tube-specific 
instrument settings

• • Click the New Instrument Settings 
button ( ).

• Choose Experiment > New 
Instrument Settings.

• Choose New Instrument Settings 
from the contextual menu.

To add…
First select or right-
click…

And then choose one of these 
options…

or

or
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NOTICE     Each new Experiment starts with default instrument settings. After 
recording a Tube, a copy of the instrument settings in effect at the time of 
recording is stored with the Tube. User-defined instrument settings can be created 
at the Experiment, Specimen, or Tube level. See Instrument Settings on page 78.

Sort Layouts 
(if appropriate)

•

•

• Click the New Sort Layout button 
( ).

• Choose Sort > New Sort Layout.

• Choose New Sort Layout from the 
contextual menu.

Global worksheets 
or analysis templates

• • Click the New Global Worksheet 
button ( ).

• Choose New Global Worksheet 
from the contextual menu.

• Choose Experiment > New Global 
Worksheet.

Plates or Plate 
templates
(if appropriate)

• • Click the arrow control and choose 
a plate type from the drop-down 
menu.

• Choose Experiment > New Plate.

To add…
First select or right-
click…

And then choose one of these 
options…
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Organizing the Browser

Experiments are set up hierarchically to help organize experimental data. You 
can use Tubes and Specimens to help organize your work, and use folders to 
group similar Experiments in the Browser. It is important to name Browser 
elements with meaningful names to help you find the data later. 

BD Biosciences recommends that you determine an organization strategy before 
you generate a lot of data. You can name Experiments according to the nature of 
the analysis to be performed, such as 5-color analysis or Immunophenotyping. 
Specimens can be named according to the type of cells to be analyzed, such as 
LWB (lysed whole blood) or Hybridoma Line. Tubes can be named according to 
the reagents used to stain the sample, such as CD4 FITC or Multitest TBNK.

The following examples show different organization strategies for naming and 
grouping Experiments in BD FACSDiva software. Figure 2-8 shows Experiments 
grouped by studies or month.

Figure 2-8  Example folder organization

Figure 2-9 shows two strategies for organizing QC Experiments. In one, 
Experiments are organized by month at the Experiment level, by date at the 
Specimen level, and by samples run at the Tube level. The second example 
organizes QC work by month at the folder level, by date at the Experiment level, 
and by sample run at the Tube level.

Figure 2-9  Example organization of QC work
56 BD FACSDiva Software Reference Manual



Figure 2-10 shows an example of how you can organize your daily work by 
month. By including both a descriptor (6 Color) and date in the Experiment 
name, you can easily search for an Experiment by the descriptor or date using the 
search field in the Browser or the Edit > Find feature.

Figure 2-10  Example organization of daily work

Tip     To minimize the number of Experiments in the Browser, click the View Own 
button to see only your Experiments, or use the Find feature to limit the number 
of Experiments displayed. List Experiments by date by clicking the Date column 
header in the Browser, or list Experiments alphabetically by clicking in the Name 
column header.

NOTICE     To move Experiments between folders, use the Cut and Paste With 
Data commands. BD FACSDiva software does not support dragging Experiments 
between folders. 

Tip     Folders can be nested inside outer folders for additional levels of 
organization.
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Experiments 

An Experiment is a group of elements used to acquire and analyze data from the 
flow cytometer. Experiments can include global worksheets, Specimens (material 
to be analyzed), Tubes (acquisition data and reagents used to analyze the 
specimen), Analysis objects (plots, gates, and statistics views), and Sort Layouts 
or Plates (if applicable). Instrument settings can be applied at the Experiment, 
Specimen, or Tube level.

You build Experiments as you acquire and analyze data. Each new Experiment 
adds another group of objects to the Browser. Experiments can be private or 
shared, and can be exported with data for archival purposes or exported without 
data for use as a template. 

Starting a New Experiment

• To start a new Experiment, click the New Experiment button . 

The currently open Experiment closes and a new, 
open Experiment is added to the Browser. (If you are 
recording data when the button is clicked, the current 
Experiment does not close. The new Experiment is added as a closed 
Experiment.) 

By default, the New Experiment button adds an Experiment with default 
instrument settings and a blank worksheet, but the button can be 
customized to add a predefined Experiment template. For more 
information, see Template Preferences on page 89.
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• To start an Experiment based on a saved template, choose 
Experiment > New Experiment or press Ctrl-E. The Experiment Templates 
dialog box appears where you can select the template type and number of 
experiments to create (Figure 2-11). 

Figure 2-11  Selecting a template

To view details about the Experiment template, click the details button. 
The Experiment Layout dialog appears showing the Specimens and Tubes 
in the Experiment, any defined labels, keywords, and acquisition criteria. 
See Using Experiment Layout on page 67.

Note that you can create 1–50 copies of an Experiment template at a time. 
To change the number of copies, click the up arrow next to the Copies field.

For information about creating Experiment templates, see Exporting 
Experiments as Templates on page 61.

• To import an Experiment stored on the hard drive or an external storage 
device, choose File > Import > Experiments. Locate the Experiment to 
import in the dialog box that appears. 

For more information, see Importing Experiments on page 210.

details

more copies
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Opening Experiments

You can edit elements and acquire data only within an open Experiment, and 
only one Experiment can be open at a time. An open Experiment is indicated by 
an open-book icon ( ). You cannot close an open Experiment during 
acquisition.

Do one of the following to open a closed Experiment:

• Double-click a closed Experiment icon in the Browser ( ).

• Select an Experiment in the Browser and choose Experiment > Open 
Experiment (Ctrl-O).

• Right-click an Experiment icon in the Browser and choose Open Experiment.

There might be a short delay while the software retrieves the Experiment from 
the database.

Using the Experiment Inspector

The Inspector displays Experiment options when you 
select an Experiment in the Browser.

In the Inspector, you can 

• name the Experiment

• specify the number of logs to display for all plots 
in the Experiment (see Changing Log Display on 
page 155)

• select whether to update global instrument settings automatically (see Using 
Global Instrument Settings on page 119)

• (on the Keywords tab) create or view Experiment-level keywords (see 
Keywords on page 82)
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Note that Experiment names cannot contain commas or periods. Spaces at the 
beginning or end of the name are automatically removed. The Experiment 
modification date is the date the Experiment was created or the date data was 
last collected; the Owner name is the name of the logged-in user who created the 
Experiment. These fields cannot be changed.

Saving Experiments

All Experiments are stored in the BDFACS database. (See Working with 
BD FACSDiva Data on page 196.) Any changes to an open Experiment, related 
Browser elements, and worksheet are saved when you close an Experiment, quit 
the software, or click the Save button on the Workspace toolbar ( ). List-mode 
data is saved after a Tube is successfully recorded. (Green highlighting indicates 
data has been saved.) The Experiment modification date is automatically updated 
each time data in the Experiment changes. 

Tip     Locate saved data more easily by naming Experiments and Experiment 
elements with meaningful names.

Exporting Experiments as Templates

Any Experiment can be exported as a template. Experiment templates include all 
Specimens, Tubes, keywords, Sort Layouts, instrument settings, labels, worksheet 
elements, and worksheets (including all settings such as page breaks), but do not 
include recorded data.You can set up Experiment templates for common 
functions such as instrument optimization or sorting. Templates are stored 
outside the Browser to simplify the Browser display. 

To export an Experiment as a template, do the following. Note that Experiments 
can be exported as templates whether they are open or closed.

1 Right-click an Experiment, and choose Export > Experiment Template.

An “Export Wizard” dialog box appears, with steps that show you how to 
create and export a template.
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2 Choose the template type and verify the name; click Next.

Templates can be grouped by category so they are easier to find later. To 
add a category to the Type drop-down menu, enter a name in the Type 
field. Your new type will be available from the drop-down menu the next 
time you create a template. Note that types cannot include any of the 
following characters: \ / : * ? " < > | , .

The template name is based on the name of the Experiment in the Browser, 
To change the name, enter a new name in the Name field. Note that 
Experiment names cannot include periods or commas.

Select the Lock Template checkbox to ensure the template cannot be 
overwritten by a template with the same name. Locked templates and 
default templates provided with the software cannot be overwritten.

You must enter a template type and name to proceed.
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3 (Optional) Enter Study Details when prompted; click Next.

Study details are not required, but they can be used to distinguish between 
Experiment templates with similar names when you have a lot of templates.

4 (Optional) Enter operator and investigator information; click Finish.

Templates are saved in a folder in the D:\BDExport\Templates\Experiment 
directory. A new folder is created for each template type. When you create 
a new Experiment based on a template, each type is represented by a tab in 
the Experiment Templates dialog box. See Figure 2-11 on page 59.
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Editing Templates

• To add or delete elements from a template, create an Experiment from the 
template, make the required changes, and then export the Experiment as a 
template. Save it with the same template type and name. When prompted, 
overwrite the previous template.

NOTICE     A locked template cannot be overwritten.

• To rename a template, use Windows Explorer to navigate to the 
BDExport\Templates folder, open the folder corresponding to the template 
type, and rename the template.xml file in the folder. 

To rename a template type, rename the folder.

• To change the template type, locate the template.xml file it its 
corresponding type folder, and move it to a different folder at the same 
hierarchical level.

• To remove templates from the template directory, use Windows Explorer to 
navigate to the BDExport\Templates folder. 

- To delete a template type and all templates within it, delete the 
corresponding folder in the Templates folder. 

- To delete a single template, open the folder corresponding to the 
template type, and delete the folder with the same name as the 
template.

folder for
template Type

folder for
single template
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Making Experiments Private or Shared

When you log into BD FACSDiva software, all of your saved Experiments are 
listed under your user icon in the Browser. Other users will not be able to view 
your Experiments unless they have administrative access, or you have designated 
an Experiment as shared.

To make an Experiment available to other logged-in users, right-click the 
Experiment icon in the Browser, and choose Share Experiment. The Experiment 
icon changes to show that the Experiment is shared.

When other users log into the software, they will be able to view your shared 
Experiments under the Shared View icon in the Browser.

To remove the shared status, right-click a shared Experiment and choose Make 
Private. 

You can view only your Experiments (ie, hide all shared Experiments) by clicking 
the View Own button in the Browser. (All Experiments must be closed to enable 
the button.) Click the View Shared button to see all Experiments again.

shared icon

shared Experiments shown
shared Experiments hidden

ViewView
Own Shared
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Exporting and Importing Experiments

Experiments can be exported to the hard drive or an external storage device. See 
Exporting and Importing Experiments on page 208.

Experiment data can be exported in FCS 2.0 or 3.0 file format. You can also 
import FCS files from another BD application. See Exporting FCS Files on 
page 201 and Importing FCS Files on page 204.

Finding Saved Data

Use the search field at the top of the Browser frame to search the database for 
Experiments containing specific Browser elements, reagents, custom keyword 
names or values, or population names. See Using the Search Field on page 50.

Alternatively, choose Edit > Find (Ctrl-F) and use the drop-down menus to 
restrict your search to predefined data categories (see the following figure).

• Use the Find drop-down menu to choose the type of information you are 
searching for. Select a category from the menu; then enter specific 
information in the text field next to the menu. For example, choose 
Fluorochrome Label and enter CD4 in the text field.

• Use the Search drop-down menu to search only within a certain type of 
data element (Experiments, Specimens, or Tubes).

• Search within a specified time period by entering dates in the On or After 
and On or Before fields. Enter the month first, followed by the day and the 
year (ie, 5/17/01 or May 17, 2001).

text field
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• Select the Append to currently shown checkbox to list Experiments 
containing the required information along with the current Experiments in 
the Browser. Deselect the checkbox to display only Experiments containing 
the required information.

NOTICE     You cannot use the Find function to locate a folder. If a folder contains 
an Experiment that meets the search criteria, it will have a plus sign (+) next to it, 
indicating Experiments are inside the folder. 

If there are no Experiments containing the requested information, the Browser 
will list only the currently open Experiment along with any existing folders. To 
display all Browser elements again, click Display All.

Using Experiment Layout

Use the Experiment Layout dialog box to create fluorochrome labels, enter values 
for keywords, or enter acquisition criteria for each Tube in your Experiment. To 
access this feature, open an Experiment, and choose Experiment > Experiment 
Layout. A dialog box appears listing all Specimens and Tubes in the Experiment.

Figure 2-12  Experiment Layout dialog box
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Editing Labels

Use the Labels tab of the Experiment Layout dialog box (Figure 2-12 on page 67) 
to enter parameter labels for each fluorochrome in your experiment. Parameter 
labels will be displayed on plot axes and in statistics views. 

• To add or change labels, select the field(s) listing the fluorochromes to be 
labeled, and type to enter a label.

If a label has been previously defined, choose it from the drop-down Label 
menu. (The menu is blank until you have defined at least one label.)

Tip     Drag the mouse or hold down the Control key while clicking to select 
and label multiple fields at a time. For example, if all samples in the 
experiment were stained with CD3 FITC, select all the FITC fields in the 
table, and then enter CD3. All selected fields are labeled with CD3 at once.

• To delete a Label, click its field and press the Delete 
key. Alternatively, click the Label drop-down menu 
and select the blank label field at the top of the list; 
then press Enter.

Note that labels can also be entered on the Labels tab of 
the Tube Inspector. See Using the Tube Inspector on page 74.

Editing Keywords

All keywords currently defined for the Experiment are listed in the Keywords tab 
of the Experiment Layout dialog box. See Defining Keywords on page 82. 

Enter a keyword value by selecting a cell and then entering a value in the Value 
field. If the keyword was set up with selectable choices, the Value field changes to 
a drop-down menu where you can choose an available value. Keyword changes 
are automatically updated in the Keywords tab of the corresponding Inspector.

If more than one cell is selected, the change will be made in all selected cells at the 
same time. Keywords must be of the same type and range of values to be included 
in a multiple selection.

(blank field)
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Use the following methods to select multiple keyword fields at the same time.

• Select multiple contiguous fields by 

- dragging the mouse across a selection while holding down the left 
mouse button.

- holding down the Shift key while clicking the first and last fields in a 
range.

• Select multiple non-contiguous fields by holding down the Ctrl key while 
clicking each selection. 

• Cancel a value entered in a field or text box by pressing the Esc key before 
you click OK. This restores the previous value and returns you to the 
Experiment Layout dialog box.

NOTICE     An individual field cannot be deselected from a selected group. 

Editing the Number of Events to Record

The Acquisition tab in the Experiment Layout 
dialog box shows the number of events to 
record for each Tube. Edit this number by 
selecting one or more fields and then entering a 
new number. You can also choose a value from 
the Events to Record drop-down menu. 

If more than one cell is selected, the change will 
be made in all selected cells at the same time. 

Note that the number of Events to Record can 
also be entered on the Acq. tab of the Tube 
Inspector or in the Acquisition Controls frame. 
See Using the Tube Inspector on page 74 or 
Acquisition Controls on page 104 for more 
information.
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Specimens 

A Specimen consists of the name of the material to be analyzed and a list of the 
Tubes used to analyze the material. Specimens can also contain instrument 
settings (see Creating Specimen- or Tube-Specific Settings on page 118).

• To create a new Specimen, see Adding New Elements to the Browser on 
page 53. 

• To save a Specimen as a panel, see Exporting a Specimen as a Panel on page 71.

• To create a new Specimen from a panel template, see Importing a Panel 
Template on page 73.

• To edit a panel template, see Editing Templates on page 64.

Using the Specimen Inspector

Use the Specimen Inspector for the following:

• Use the Name field to enter the Specimen 
name or sample type. 

Note that Specimen names cannot contain 
commas or periods. Spaces at the beginning 
or end of the name are automatically 
removed.

• Use the Collected field to specify the date your sample was collected.

• Use the Global Sheet menu to choose a default global worksheet for this 
Specimen. The menu lists all global worksheets in your Experiment. 

The chosen worksheet will be displayed automatically when you select a 
Tube below this Specimen. 

• Click the Keywords tab to view or edit keywords that will be stored with 
the Specimen. For more information, see Keywords on page 82. 
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Exporting a Specimen as a Panel

A panel is a collection of tests, reagents, or markers commonly used together in 
the same experiment. Any Specimen can be exported as a panel. Along with the 
Specimen name and collection date, an exported panel contains a list of Tubes 
and any parameter labels defined for each Tube. Exported panels can also include 
global worksheets and their associated Analysis objects.

Panels are stored outside the Browser to simplify the Browser display. To export a 
Specimen as a panel, do the following. Note that Specimens can be exported as 
templates only from open Experiments.

1 Set up your Specimen with a list of Tubes, define labels for each Tube, and 
create Analysis objects on a global worksheet.

2 Right-click the Specimen and choose Export > Panel Template.

An “Export Wizard” dialog box appears, with steps that show you how to 
export a template.

3 Select the global worksheet(s) you would like to include in the panel, and 
click Next.

All defined global worksheets are shown. Click to select the checkbox next 
to each worksheet you would like to include.
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4 Choose the template type and verify the name; click Next.

Panels can be grouped by category so they are easier to find later. To add a 
category to the Type drop-down menu, enter a name in the Type field. Your 
new type will be available from the drop-down menu the next time you 
create a panel. Note that types cannot include any of the following 
characters: \ / : * ? " < > | , .

The panel name is based on the name of the Specimen in the Browser. To 
change the name, enter a new name in the Name field. Note that panel 
names cannot include periods or commas.

Select the Lock Template checkbox to ensure the panel cannot be 
overwritten by a panel template with the same name. Locked panels and 
any default panels provided with the software cannot be overwritten.

You must enter a template type and name to proceed.

5 (Optional) Enter comments for the panel template, and click Finish.

Comments can be viewed when you are importing a panel template. See 
Importing a Panel Template on page 73.

Panels are saved in a folder in the D:\BDExport\Templates\Panel directory. 
A new folder is created for each panel type. When you create a new 
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Specimen based on a panel, each type is represented by a tab in the Panel 
Templates dialog box. See Figure 2-13 on page 73.

Importing a Panel Template

To create a new Specimen based on a panel template, choose Experiment > New 
Specimen or press Ctrl-M.

The Panel Templates dialog box appears where you can choose a panel to import. 
If any comments were saved with the panel, they are shown in the box next to the 
list of panel templates.

Figure 2-13  Selecting a panel to import

To view details about the panel template, click the details button. The 
Experiment Layout dialog appears showing a list of Tubes in the panel, any 
defined labels, keywords, and acquisition criteria. See Using Experiment Layout 
on page 67.

Note that you can import 1–50 copies of a panel at a time. Each panel will be 
imported as a single Specimen. To change the number of copies, click the up 
arrow next to the Copies field.

For information about creating panels, see Exporting a Specimen as a Panel on 
page 71.

details

more copies

comments
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Tubes 

A Tube can contain acquisition criteria, information about the reagents used to 
analyze the Specimen, the data for recorded events, Tube-specific instrument 
settings, Analysis objects (plots, gates, and statistics views), and Sort Layouts (if 
applicable). Keywords can also be saved with Tube data.

Most Tube-specific information is entered using the Tube Inspector.

• To create a new Tube, see Adding New Elements to the Browser on page 53.

• To create a new Tube with a predefined analysis template, see Creating a 
Tube with a Predefined Analysis Template on page 77.

• To duplicate a Tube, right-click the Tube and choose Duplicate Without 
Data, or use Copy and Paste commands.

Using the Tube Inspector

There are four components to the Tube Inspector, accessed by clicking the tabs at 
the top of the Inspector: Tube, Labels, Acquisition, and Keywords. If a Tube 
contains instrument settings (ie, Tube-specific settings or settings copied during 
recording), an Instrument Settings tab is also shown.

NOTICE     Many values defined on the Labels, Acquisition, and Keywords tabs 
can be viewed and edited using the Experiment Layout dialog box. (See Using 
Experiment Layout on page 67.)

• Use the Tube tab to name the tube and to view certain keywords and 
settings saved with recorded data (Figure 2-14 on page 75). 

Tube names cannot contain periods. Spaces at the beginning or end of the 
name are automatically removed. 

Note that keyword fields in the Tube tab cannot be edited. 
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Figure 2-14  Tube tab before (left) and after (right) recording data 

• Use the Labels tab to enter parameter labels 
for each fluorochrome used by the Tube. 
Parameter labels will be displayed on plot 
axes and in statistics views.

Tip     Labels can also be entered in the 
Experiment Layout dialog box. See Using 
Experiment Layout on page 67.

• Use the Acq. tab to specify the following acquisition criteria:

- the number of events to record 

Choose a number from the drop-down 
menu or enter a value in the field.

- whether you want the number of counted 
events restricted to a predefined 
population (Stopping Gate)

- whether you want to record only events within a predefined population 
(Storage Gate)
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The Stopping Gate and Storage Gate settings control the number of events 
collected and saved to the database. Any population can be used for a 
stopping or storage gate except one defined by a Snap-To gate, a tethered 
gate, or a gate drawn on a biexponential plot.

For example, if you were performing an immunophenotyping experiment 
and wanted to collect data only for the T cells, you could direct the 
software to collect 10,000 lymphocyte events for the stopping gate and 
record only events in the T-cell storage gate. 

Your Acq. tab would look like the following:

The instrument would keep acquiring events until 10,000 events were 
collected in the Lymphocyte gate; however, only events that fell into the 
T cells gate would be saved to the database.

You can also specify the Number of Events to record, the Stopping Gate, 
and the Storage Gate using the drop-down menus in the Acquisition 
Controls frame. (See Acquisition Controls on page 104.) Inspector values 
are updated if you change the settings from these menus.

• When available, use the Instr Settings tab to view or edit Tube-specific 
instrument settings.

Instrument settings can apply at the Tube, Specimen, or Experiment level. 
See Creating Specimen- or Tube-Specific Settings on page 118 for details.

During offline use, you can edit instrument settings for unrecorded Tubes in 
the Inspector. (Instrument settings for recorded Tubes cannot be edited.) 
When you are connected to the instrument, you can change voltages, 
thresholds, and ratios only in the Instrument frame; the Inspector shows a 
report of the settings for a selected Tube or Instr Settings icon. For more 
information, see Instrument Settings on page 109.
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• Use the Keywords tab to view or edit keywords that will be stored with the 
Tube. See Keywords on page 82.

Creating a Tube with a Predefined Analysis Template

If you have an analysis template already defined, you can create one or more 
Tubes using the predefined analysis in a single step. For instructions on creating 
an analysis template, see Saving an Analysis Template on page 79.

1 Choose Experiment > New Tube, or press Ctrl-T.

The Analysis Templates dialog box appears where you can choose an 
analysis template to import. If any comments were saved with the template, 
they are shown in the box next to the list of templates.

2 Specify the number of copies, and click OK.

One Tube will be created for each specified copy. You can create 1–50 
Tubes at a time with the selected analysis. To change the number of copies, 
click the up arrow next to the Copies field.

When you click OK, the designated number of Tubes are added to the 
Browser, with a copy of your templated Analysis object under each Tube. 
Plots, gates, and statistics views are added to the current worksheet unless 
the Tube-specific worksheet preference is enabled. In this case, Analysis 
objects are placed on an individual worksheet for each new Tube.

more copies

comments
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Instrument Settings 

Instrument settings represent the collection of values for parameters measured, 
photomultiplier (PMT) voltages, threshold, compensation, and the calculated 
parameters Log and Ratio. Instrument settings can apply to Tubes, Specimens, or 
Experiments. When no Tube-specific instrument settings exist, Specimen settings 
apply; when no Specimen-specific settings exist, Experiment settings apply.

Every new Experiment starts with default instrument settings values. These 
values can be optimized manually or overwritten by copying optimized settings 
into the Experiment or applying a saved compensation Setup. Default parameters 
are determined by the current instrument configuration.

During offline use, you can edit instrument settings in the Inspector. When you 
are connected to the instrument, you can change voltages, thresholds, and ratios 
only in the Instrument frame; the Inspector shows a report of the settings for a 
selected Tube or Instr Settings icon. For more information, see Instrument 
Settings on page 109.

instrument settings editor

Inspector:
instrument settings report

Instrument frame:
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Analysis Objects  

An Analysis object contains the plots, gates, and statistics used to analyze the 
event data in a Tube. An Analysis object appears under a Tube in the Browser 
after you create a plot, statistics view, or population hierarchy for that Tube. 
Analysis objects can also be associated with global worksheets, which are not 
tied to specific Tubes. Tools for data analysis are described in more detail in 
Chapter 4; analysis examples can be found in the BD FACSDiva Software Quick 
Start Guide.

Analysis objects are displayed only in open Experiments and are associated with 
a particular Tube or with a global worksheet. You can select an Analysis object 
and save it as a template, copy it from one Tube to another, or copy it from a 
global worksheet to a Tube. When an Analysis object is copied or saved as a 
template, all plots, gates, statistics views, and population hierarchies are 
included.

Saving an Analysis Template

Any Analysis object can be saved as a template, including plots, gates, statistics 
views, and population hierarchies. You can set up analysis templates for common 
functions such as acquisition or analysis. Analysis templates can be assigned as a 
default worksheet or applied to one or more Tubes at a time.

To create an analysis template, do the following. Note that templates can be 
exported only from open Experiments.

1 Right-click an Analysis object or a Tube with an Analysis object, and 
choose Export > Analysis template.

An “Export Wizard” dialog box appears, with steps that show you how to 
export a template.

2 Choose the template type and verify the name; click Next.

Group templates by type so they are easier to find later. To add a new type 
to the drop-down menu, enter a name in the Type field. Your new type will 
be available from the drop-down menu the next time you create a template. 
Types cannot include any of the following characters: \ / : * ? " < > | , .
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The template name is based on the name of the worksheet in the Browser, 
To change the name, enter a new name in the Name field. Template names 
cannot include periods or commas.

Select the Lock Template checkbox to ensure the template cannot be 
overwritten by a template with the same name. Locked templates and any 
default templates provided with the software cannot be overwritten.

You must enter a template type and name to proceed.

3 (Optional) Enter comments for the analysis template, and click Finish.

Comments can be viewed when you are importing an analysis template. See 
Creating a Tube with a Predefined Analysis Template on page 77.

Templates are saved in a folder in the D:\BDExport\Templates\Analysis 
directory. A new folder is created for each template type. When you create 
a new Tube or worksheet based on a template, each type is represented by a 
tab in the Analysis Templates dialog box. 
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Copying Analysis Objects

1 Open an Experiment and expand the Tube or global worksheet containing 
the Analysis you want to copy.

Tip     Use the arrow keys on your keyboard to access and expand Browser 
elements. Use the down arrow key to locate an element, and use the right 
arrow key to expand it.

2 Right-click the Analysis object and choose Copy.

Alternatively, select the Analysis object and press Ctrl-C.

3 Select the icons for the Tubes or global worksheets where you want to 
apply the analysis and press Ctrl-V.

You can also right-click the selected icons and choose Paste. 

Tip     To select discontiguous icons in the Browser, hold down the Control 
key while clicking. 

The new Analysis object overwrites any plots, gates, population 
hierarchies, and statistics that already exist. When pasted to a Tube, the 
new plot(s) and statistics are pasted into the active worksheet (worksheet 
currently displayed). 

NOTICE     When pasting an Analysis object from a global worksheet to a 
Tube, some of the analysis can be lost if the Tube uses a different set of 
parameters.
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Keywords

Keywords can be defined and saved in the database with Experiments, 
Specimens, or Tubes. Experiment- and Specimen-level keywords are also saved 
with Tubes. When you export FCS data, user-defined keywords are included in 
the header of exported FCS files.

Use keywords for the following:

• Define a list of terms (Selectable Strings) that can be stored with each 
Experiment.

• Attach numerical data, such as cell count, to a Tube or Specimen.

• Attach labels to data, making it easier to find in the database. See Finding 
Saved Data on page 66.

• Display Tube, Specimen, or Experiment keywords in the headers of 
statistics views. Keywords are exported along with the statistics. 

Defining Keywords

Keywords can be defined at the Experiment, Specimen, or Tube level. 

NOTICE     If custom keywords of the same name are defined for more than one 
level in an Experiment hierarchy, the lower-level definition overwrites the one at a 
higher level.

1 In an open Experiment, select an Experiment, Specimen, or Tube in the 
Browser.

2 Click the Keywords tab in the Inspector of the selected item.

3 Click the Edit button to add or change a keyword (Figure 2-15 on 
page 83).
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You can create or edit keywords only for the item that was selected in the 
Browser. For example, if a Tube was selected, you cannot edit Specimen or 
Experiment-level keywords.

Figure 2-15  Creating custom keywords

4 Click the Add button.

5 Name the keyword and add any required suffix.

Select the generic name in the Name field and enter a new name. Each 
keyword name must be unique; use the suffix to define values, such as units 
of measure.
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6 Select the type and define the keyword(s).

• Use Numeric for keywords defined by numerical values, such as 
numbers of cells (Figure 2-16). Limit the range by entering Minimum 
and Maximum values; enter a number to specify the number of digits 
to the right of the decimal place (maximum of 14).

Specify a Value in the dialog box or check Value Editable from 
Inspector and enter the value there.

Figure 2-16  Defining a numeric keyword

• Use String for keywords defined by text, such as sample identifiers. In 
the Value field, enter up to 128 characters.

• Use Boolean for keywords that require a true 
or false answer. Select true or false from the 
Value drop-down menu in the dialog box or 
the Keyword Inspector.

• Use Selectable Numeric to define a set of selectable numeric keywords, 
such as a list of values. Define the set of values by clicking Add Value, 
selecting the value in the Value field, and entering the required value. 
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All defined values will appear in a drop-down menu in the Value field 
of the Keyword Inspector.

Use the Decimal Places field to specify the number of digits to the right 
of the decimal place (maximum of 14).

• Use Selectable String to define a set of selectable text keywords. Define 
selections by clicking Add Value, selecting the value in the Value field, 
and entering the required text. All defined values will appear in a drop-
down menu in the Value field of the Keywords Inspector.

7 Click OK to dismiss the Edit Keywords dialog box.

Deleting Keywords

Only custom keywords can be deleted. BD-defined keywords (such as $OP for 
operator or $INST for instrument) cannot be edited or deleted.

1 In an open Experiment, select the Browser item containing the keyword 
you want to delete.

2 Click the Keywords tab in the Inspector of the selected item.

3 Click the Edit button to access the Edit Keywords dialog box.

4 Select a keyword, and click Delete.
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User Preferences

Certain default settings can be changed using the User Preferences command on 
the Edit menu. Preferences apply to all Experiments in the Browser; changes are 
saved with your login name and are retained from one session to the next. Note 
that additional preferences might be available for your instrument type; refer to 
your instrument manual for a description.

There are five types of user preferences available to all users: General Preferences, 
Gate Preferences, Plot Preferences, FCS Preferences, and Template Preferences.

General Preferences

General preferences apply to worksheets, acquisition controls, and instrument 
settings.

 

• Tube-specific worksheet—When selected (checked), a new worksheet is 
automatically created for each Tube when you duplicate without data or 
click the Next button, or when the Save analysis after recording preference 
is enabled for global worksheets. If a worksheet with the name of the 
Specimen and Tube already exists, the copied elements are pasted into the 
existing worksheet. By default, this preference is not selected.

• Start acquisition on pointer change—acquisition will begin each time the 
Current Tube pointer is moved to a new Tube that does not already contain 
recorded data. By default, this preference is not selected.
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• Remove tube-specific instrument settings on duplicate—tube-specific 
instrument settings are not included when you duplicate a Tube, or copy 
and paste a Tube. Note that settings are included when you paste with data, 
even when the preference is enabled. By default, this preference is selected.

• Save analysis after recording through global worksheet—analysis elements 
on the global worksheet are automatically copied to a Tube-specific 
worksheet after recording. An Analysis object is saved for each Tube unless 
it already contains an Analysis object. By default, this preference is selected.

• Automatically update instrument settings according to the latest setup—
when you open an Experiment, instrument settings that are linked to a 
Setup are automatically updated if Setup settings were changed. By default, 
this preference is selected.

Gate Preferences

Gate preferences define how populations are colored within Interval and 
Quadrant gates. 

• Interval Gate Default Color—Select one of the 
two radio buttons to specify whether 
populations defined by an Interval gate should 
be assigned a color or retain the color of the 
parent population. 

By default, populations are not colored.

• Quadrant Gate Default Color—Select one of 
the three radio buttons to specify how 
populations defined by Quadrant gates should 
be colored:

- no color used (color is determined by parent population)

- all quadrants (gated populations) assigned the same color

- each quadrant (gated population) shown in a different color 

By default, Quadrant populations are not colored.
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Plot Preferences

By default, plots are created with a white 
background. To change the default background 
color, click the color box on the Plot preference tab. 
A palette appears from which you can choose a new 
color. 

If you set the default background to black, select 
the checkbox to print plots with a white background; white gates and 
populations are then automatically printed in black.

FCS Preferences

Enable the Export FCS preference to automatically export an FCS 3.0 file after 
each Tube is recorded. To export FCS 2.0 data, you need to export manually. See 
Exporting FCS Files on page 201 for more information.

When the preference is selected, you can specify an export folder location by 
clicking the Browse button, or by entering a folder path in the Folder location 
field.

Tip     Select the Date folder checkbox to automatically create a dated folder in the 
specified directory each day files are exported. 
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Template Preferences

Template preferences allow you to select which predefined template will open 
when you click the corresponding button on the Browser toolbar. By default, the 
New Experiment, Specimen, Tube, and Global Worksheet buttons create a blank 
Experiment, panel (Specimen), and worksheet respectively. 

• To assign a saved template as a default Experiment, Specimen, Tube, or 
global worksheet, click the Templates button next to the corresponding 
item and select a saved template in the dialog box that appears. The 
selected template remains in effect for the current user until it is changed in 
User Preferences.

• To add a normal worksheet (instead of a global worksheet) to each new 
Experiment, deselect the Default global worksheet checkbox. This 
checkbox is only available for the Blank Experiment template, and by 
default, it is selected.

Note that when you assign an analysis template as the default global 
worksheet, the assigned template is added to each new blank Experiment. 
To add a blank global worksheet, leave the global worksheet template as 
Blank Analysis, and leave the Default global worksheet checkbox selected. 
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3

Instrument and
Acquisition Controls

BD FACSDiva software supports several different instruments. This chapter 
contains information about instrument and acquisition controls that are common 
to all instruments. For other instrument-specific controls, consult your 
instrument manual.

Many instrument functions can be controlled within BD FACSDiva software. 
Most instrument controls are located in the Instrument frame; other instrument 
controls are accessed from the Instrument menu. Acquisition controls are 
available in the Acquisition Controls frame and the Browser. 

You must be connected to an instrument (working from an acquisition 
workstation) to enable many of these functions.

The following sections contain an overview of these controls: 

• Instrument Controls on page 92

• Acquisition Controls on page 104

• Instrument Settings on page 109

• Controls for Compensation Correction on page 122
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Instrument Controls

Instrument controls are accessed within the Instrument menu or the Instrument 
frame. To display the Instrument frame, click the Instrument button in the 
Workspace toolbar ( ).

• Use the Instrument menu to access instrument 
configuration options, identify the instrument name 
and serial number, display an Instrument Status 
report, perform instrument setup functions, and 
connect or disconnect communication between the 
workstation and the cytometer.

• Use the Instrument frame to view workstation connectivity status. When 
the software is connected to the cytometer, Status messages and Laser 
controls are also shown in the frame. If an Experiment is open and the 
Current Tube pointer is set, the frame displays instrument settings for the 
current acquisition Tube.

The following sections contain descriptions of Instrument menu commands, 
Status messages, and Laser controls. For a description of instrument settings tabs, 
see Instrument Settings on page 109.

connectivity
status
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Instrument Configuration

Flow cytometers are equipped with specific sets of lasers, filters, and dichroic 
mirrors. The Instrument Configuration dialog box lets you define which 
fluorochromes or cell parameters will be measured at each photomultiplier tube 
(PMT) detector. 

BD FACSDiva software is provided with default configurations specific to your 
instrument. In addition, you can define custom configurations, or add or modify 
labels in an existing configuration. As you change fluorochromes, filters, or 
mirrors, you can switch between predefined configurations that match your 
optics setup.

For example, Figure 3-1 shows how the Instrument Configuration dialog box 
corresponds to the optical stage for the BD FACSAria cell sorter. Refer to your 
instrument manual for instrument-specific configuration information. 

Figure 3-1  Instrument Configuration dialog box corresponding to BD FACSAria detector arrays

Selections made in the Instrument Configuration dialog box determine which 
parameters are listed on the Parameters tab in the Inspector or the Instrument 
frame. If you commonly use one PMT detector to measure multiple parameters, 
you can list all possible parameters in the Instrument Configuration dialog box 
and choose the appropriate fluorochrome for your Experiment in the Parameters 
tab.

For accurate data results, the instrument optics setup must match the 
current instrument configuration.
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Defining a New Configuration

Follow these steps to create a custom configuration. 

1 Choose Instrument > Instrument Configuration.

The Instrument Configuration dialog box appears.

2 Click the Add Configuration button.

3 Name the configuration, and click OK.

4 Select the new configuration in the list of configurations; click once on the 
Add Parameter button for each parameter to be added.

5 Specify the laser and detector, and enter a name for each parameter.

You must first assign a detector before you can enter a parameter name. To 
change the laser or detector, click the field in the corresponding column. A 
drop-down menu appears listing all available choices. 

The parameter names you enter are the names that will appear on the 
Parameters tab in the Inspector or Instrument frame. When more than one 
fluorophore is entered for a given channel, the first listed fluorophore will 
be shown by default. Note that parameter names must be unique within the 
configuration, and cannot include commas or periods. Spaces at the 
beginning or end of the name are automatically removed.

6 Use the drop-down menu at the top of the dialog box to assign the side-
scatter parameter (all systems except the BD FACSVantage SE).

You must assign the side scatter parameter to ensure it is excluded from 
compensation calculations. Once it has been assigned, the SSC parameter 
name cannot be edited.
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7 To make the new configuration the current configuration, click Set 
Configuration; then click OK.

Adding or Modifying Parameters

To add or modify parameters in a configuration, do the following.

1 Choose Instrument > Instrument Configuration.

2 Select the configuration to be modified.

NOTICE     For the BD FACSCanto instrument, only user-defined 
configurations can be modified. Default configurations cannot be changed.

3 Click Add Parameter to add a new parameter; choose the laser used to 
excite the fluorochrome and the detector used to detect it.

You must first assign a detector before you can change a parameter label.

You must click Set Configuration for the new configuration to apply. For 
accurate data results, always verify that the instrument optics setup matches 
the current instrument configuration.
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4 Click in any parameter field except FSC or SSC and enter a new name.

FSC and SSC parameter names cannot be changed.

5 Continue adding or modifying parameters as needed.

6 Make sure the appropriate configuration is listed as the Current 
Configuration, and click OK.

To use a different configuration as the current one, select the name in the 
list of configurations, and click Set Configuration.

Changing Configurations

To switch between defined configurations, select the configuration name in the 
Instrument Configuration dialog box, and click Set Configuration.

Tip     To ensure that the right parameters appear on your Parameters tab, set the 
configuration you want to use before you create a new Experiment.

Deleting a Parameter or Configuration

Use the buttons at the bottom of the Instrument Configuration dialog box to 
delete a parameter or defined configuration. Note that the current configuration 
cannot be deleted.

1 Select the parameter or configuration to be deleted.

2 Press the Delete Parameter button or the Delete Configuration button.

You must click Set Configuration for the new configuration to apply. For 
accurate data results, always verify that the instrument optics setup matches 
the current instrument configuration.

The software does not prevent you from deleting a predefined 
configuration. If you delete one of the default configurations, it will have to 
be re-created as if it were a new configuration. Refer to your instrument 
manual for examples if you need to re-create a default configuration.
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Instrument Name

Each instrument is assigned a name and serial number, which are used to label 
FCS files and might also be needed during troubleshooting. Choose Instrument > 
Instrument Name to access a dialog box where you can enter or locate the unique 
serial number for the connected instrument. (The instrument name is specified 
during software installation and cannot be subsequently changed.)

If your software lists the default serial number of 1, BD Biosciences recommends 
that you input the actual serial number, found on the name plate of your 
instrument.

 

Status Messages

The Status tab of the Instrument frame lists status messages specific to your 
instrument such as communication errors, fluidics errors, or sorting errors. 
Messages are listed next to the time the event occurred. To view the whole 
message, resize the Instrument frame.
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If the Status tab is hidden by another tab, it turns red to alert you each time a 
message is sent from the cytometer. If the Instrument frame is hidden when a 
message is sent, the frame icon appears at the top of the workspace with a 
message alerting you to check the Status tab:

To resolve instrument errors, try shutting down the computer and the instrument, 
and then restarting them. If the message reappears, contact technical support for 
assistance. Provide the exact wording of the status message when you call for 
assistance.

Click the Clear button to clear the current status messages.

Laser Controls

Lasers are instrument-specific, thus laser controls for your instrument might be 
different from those shown in this section. If the following controls do not apply, 
consult your instrument user’s guide. For the BD FACSCanto system, laser name, 
delay, and laser area scaling settings can be edited only by field service engineers.

The values entered in the Laser tab apply globally to BD FACSDiva software—
values are not saved with Experiments or Tubes. The default values at startup are 
the last set of values used by the software. 
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Tip     Although delay and area scaling values are not saved with Experiments or 
Tubes, you can view the values used for a recorded Tube by viewing Tube 
information in the Inspector. See Using the Tube Inspector on page 74. 

• Name—displays the laser name. Rename a laser by clicking in a field and 
entering a new name. The corresponding fields are updated in the 
Instrument Configuration dialog box.

• Delay—adjusts the amount of time between signals from different laser 
intercepts, from –200 to 200 µsec, to align signals from multiple lasers. 
Laser delay values are applied to all channels detected from their respective 
lasers, as specified in the current instrument configuration.

• Area Scaling—adjusts area measurements to be the same magnitude as 
height measurements for signals from the corresponding laser. See the 
following section for more information.

• Window Extension—extends the time in which area is measured by a value 
of 0–25 µsec. For more information, see Using the Window Extension on 
page 101.

• FSC Area Scaling—adjusts area measurements to be the same magnitude as 
height measurements for signals from the FSC detector. See the following 
section for more information.

Using Area Scaling

To ensure detectors are working within a linear dynamic range, it is important to 
adjust height and area measurements to the same magnitude. The relationship 
between area and height is affected by sheath velocity, particle size, and the type 
of detector. For example, photodiode-generated pulses can be different from 
those generated by PMTs. 

While height measurements can be adjusted with voltages, area measurements 
can be changed by applying a scaling factor. To determine whether an adjustment 
is needed, area signal is usually compared to height signal for one parameter from 
each laser, as well as for FSC. (When FSC is detected using a photodiode, FSC 
area scaling might need a different area scaling factor than that applied to the 
other parameters for that laser.) 
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By default, area scaling is set to 1. Notice how different scaling values affect the 
data display in the following plots. In this example, an area scaling value of 0.75 
best matches the magnitude of the height (fourth plot). 

Refer to your instrument manual for specific examples on when to adjust area 
scaling, if applicable. Note that area scaling does not change the height 
measurements in any way, nor does it affect the threshold.

Area Scaling Sample Plot

0.75

1.00

1.25

N/A
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Using the Window Extension

A sample pulse is the electronic representation of the amount of signal received at 
the detector from a single cell. The window gate is the amount of time during 
which the pulse is sampled. Depending on where the threshold is set, you can 
miss signal at the beginning and end of the pulse, especially if you have to raise 
the threshold to exclude debris.

The window extension extends the detection time to allow a more complete 
recording of the pulse. When you increase the window extension (up to 25 µsec), 
half of the setting is applied to each side of the pulse so the entire pulse area is 
inside the gate (Figure 3-2). Note that if the window extension is too wide, more 
noise is included and CVs increase. If the window is too narrow, pulses might be 
measured incompletely.

Figure 3-2  Setting a window extension

Instrument Status Report

The instrument status report provides a list of all instrument settings at the time 
the report was created. You must be connected to the instrument to create the 
report. To do so, click to set the Current Tube pointer, and choose Instrument > 
Instrument Status Report. The report is displayed in a separate window with a 
menu bar above the report header. The header lists the instrument, instrument 
serial number, and the date and time the report was prepared. 

window extension set at 0 window extension set accurately

(threshold)
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Three types of information are displayed on the report: instrument information, 
instrument settings, and sorting settings (for instruments equipped with sorting 
features). The report can be printed or exported. 

• The Instrument Info section lists lasers used, with corresponding delay and 
area scaling values, along with the window extension. (These values are 
described in Laser Controls on page 98.) Some instruments will show 
additional information; refer to your instrument manual for information.

• The instrument settings section displays settings for the current acquisition 
Tube. All parameters collected for the Tube are listed, along with voltage 
settings and whether Log is on or off. Threshold and ratio settings are 
shown only if values have been entered in instrument settings. 
Compensation is displayed in a table of spectral overlap values. 

• The Sorting Settings section contains a list of all sort settings. Refer to your 
instrument manual for more information.
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Printing or Exporting the Report

• To print the report, choose File > Print Report within the Instrument Status 
Report window. You can preview the printed report or set up the page for 
printing by choosing the corresponding selections from the File menu.

• To export the report, choose File > Export within the Instrument Status 
Report window. A dialog box appears where you can specify the file 
storage location and choose the export format.

The file is exported as a list of comma-separated values (CSV) that can be 
opened with a spreadsheet application such as Microsoft Excel.

Standby and Connect

For acquisition workstations (computer connected to a cytometer), use the 
Instrument > Standby command to interrupt communication between the 
software and the instrument. The command is disabled during acquisition, 
recording, or fluidics procedures (for instruments with software-controlled 
fluidics modes). For information about working offline, see Working Offline on 
page 194. 

NOTICE     If your instrument has software-controlled fluidics (eg, BD FACSCanto, 
BD FACSAria), you cannot operate the fluidics when the instrument is in 
Standby.

When in Standby, choose Instrument > Connect to reestablish communication.
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Acquisition Controls

Acquisition and recording are controlled using buttons in the Acquisition 
Controls frame or the Current Tube pointer in the Browser. The Acquisition 
Controls frame is described in this section. For information about the Current 
Tube pointer, see Current Tube Pointer on page 106.

To display the Acquisition Controls frame, click the corresponding button on the 
Workspace toolbar ( ). Controls are displayed only when the workstation is 
connected to the cytometer. The top of the frame shows the current Tube 
(indicated by the Current Tube pointer), along with the threshold rate and 
elapsed time. See Acquisition Status on page 108 for a description of these 
counters.

Figure 3-3  Acquisition Controls frame

Other controls are as follows. Note that additional acquisition controls might be 
available for your instrument; refer to your instrument manual for information.

• Next—moves the Current Tube pointer to the next Tube in the Browser. If 
no Tube exists, clicking Next creates a new Tube by duplicating the 
previous Tube without data. If the Tube Specific Worksheets preference is 
enabled (see General Preferences on page 86) and you are viewing a normal 
worksheet, clicking Next automatically places Analysis objects for the new 
Tube onto a new, blank worksheet.

• Acquire—starts acquisition for the current Tube (indicated by the Current 
Tube pointer). Events are displayed in any plots created for the Tube but data 
is not saved to the database. Statistics are displayed in the statistics views and 
the values are updated in accordance with the Events to Display setting. 

When acquisition is in progress, click the Acquire button to stop 
acquisition.

current Tube
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• Record—starts recording data for the current Tube. The acquisition timer 
and all counters reset to zero when this button is clicked (except during a 
sort). Events are recorded until the requested number of Events to Record 
has been reached. The resulting data is saved in the database.

Tip     Use the Processed Events counter in the Acquisition Status frame to 
view the number of events recorded to the data file as you record data.

When recording is in progress, click the Record button to stop recording 
data before reaching the specified number of events. If you click the 
Acquire button while data is being recorded, a confirmation dialog box 
appears where you can choose to stop or continue recording.

NOTICE     If you click Record for a Tube that already has data, you can 
choose to Append, Overwrite or Cancel. Data can be appended only if the 
current instrument settings are identical to the settings saved with the 
recorded Tube. If the settings were changed, you can only overwrite or 
cancel.

• Restart—clears data from plots, resets the timer and counters to zero 
(except during a sort), and restarts statistics. Restart can be used during 
acquisition or recording.

• Storage Gate—specifies the population for which events are to be recorded.

• Stopping Gate—specifies the population for which events are to be 
counted. 

• Events to Record—specifies the number of events to be recorded for the 
current Tube. Recording will stop when the valid event counter reaches the 
specified value. If a Stopping Gate is specified, recording stops when the 
number of valid events within that gate reaches the specified value. 

Note that the Events to Record, Storage Gate, and Stopping Gate are 
reflected in the Acquisition tab of the Tube Inspector. See Using the Tube 
Inspector on page 74.

Clicking Restart during recording overwrites all previously recorded data.
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• Events to Display—determines the number of events shown in plots during 
acquisition. Enter any value from 10–100,000 events. For example, if you 
choose 1,000, only the most recently acquired 1,000 events will be shown. 
Selecting a lower number will allow the display to update more quickly. 

NOTICE     During acquisition or recording, statistics are calculated only on 
the number of currently displayed events. Statistics are updated as the 
display changes. For this reason, responsiveness can decline as the software 
calculates more statistics on a greater number of displayed events. When 
recording is complete and acquisition is stopped, statistics are calculated on 
the total number of recorded events.

Current Tube Pointer

When the workstation is connected to the cytometer, a grey pointer icon is 
displayed next to Tubes in an open Experiment. 

• To select a Tube for acquisition, click the grey pointer next to the Tube. The 
pointer changes to green and the name of the selected Tube is displayed in 
the Acquisition Controls and Acquisition Status frames.

• To start acquisition, click the green pointer. The pointer changes to yellow 
indicating that acquisition is in progress. Click the pointer again to stop 
acquisition.

Tip     In User Preferences, you can specify that acquisition begin 
automatically every time the Current Tube pointer moves to a new Tube. See 
General Preferences on page 86 for more information.

• To start recording data, hold down the Alt key while clicking the pointer. 
The pointer changes to orange indicating that recording is in progress. 
While recording, Alt-click the pointer to switch from recording to 
acquisition; click the pointer without holding down the Alt key to stop 
acquisition and recording.
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The following examples show how the pointer appearance changes depending on 
the acquisition status and the visibility of Browser elements. 

When you close and then open an Experiment, the green pointer disappears. You 
must click to set the Current Tube pointer. As a general rule, always verify that 
the appropriate Tube is indicated by the Current Tube pointer before you click 
Acquire.

A green pointer indicates the current acquisition 
Tube (Tube_002 in this example). Events will be 
acquired for this Tube when the pointer is 
clicked. The pointer can be moved to any other 
Tube within the open Experiment by clicking its 
associated gray pointer (such as next to 
Tube_003).

A blue pointer indicates the current acquisition 
Tube is hidden within a collapsed Specimen or 
Experiment. Expand the Specimen to see the 
current acquisition Tube.

A yellow pointer indicates the Tube is currently 
acquiring data.

An orange pointer indicates the Tube is 
currently recording events. 

After events have been recorded, the pointer 
reverts to green and the Tube icon is highlighted 
with green. Instrument settings in effect at the 
time the Tube was recorded are saved with the 
Tube.

The pointer does not automatically advance to the next Tube after data has 
been recorded. To acquire the next Tube, you must click the gray pointer to 
the left of the subsequent Tube in the Browser, or click the Next button in 
the Acquisition Controls frame. 
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Acquisition Status

The Acquisition Status frame provides ongoing status during acquisition or 
recording. The fields in the frame cannot be edited. 

To display the frame, click the Acquisition Status button in the Workspace 
toolbar ( ). When the workstation is connected to the cytometer and the 
Current Tube pointer has been set, the name of the current Tube appears at the 
top of the frame. A progress bar appears behind the Tube name when data is 
being recorded.

Figure 3-4  Acquisition Status frame

The following information can be viewed in the Acquisition Status frame:

• Threshold Rate—events/second for events that trigger the system threshold

• Threshold Count—cumulative count of all events that trigger the system 
threshold (ie, events that pass through the laser beam)

Because processed events and electronic aborts are measured in different 
system locations, discrepancies between these counters can be observed 
during and after acquisition.

• Electronic Abort Rate—aborted events/second, usually zero at 
recommended event rates or when the window extension is zero

• Electronic Abort Count—cumulative count of events that are not processed 
by the system, including events that arrive too close together to be 
processed individually and events that arrive too fast for the system to 
process

current acquisition Tube
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• Processed Events—cumulative count of events processed by the software 
for the current Tube

Statistics are calculated only on processed events.

• Elapsed Time—amount of time that has passed since the Acquire, Record, 
or Restart button was clicked

Instrument Settings

Instrument settings represent the collection of values for parameters measured, 
PMT voltages, threshold, compensation, and the calculated parameters Log and 
Ratio. Instrument settings can apply to Tubes, Specimens, or Experiments.

During offline use, instrument settings are edited in the Inspector. When you are 
connected to the instrument, you can change voltages, thresholds, and ratios only 
in the Instrument frame; the Inspector shows a report of the settings for a selected 
Tube or Instr Settings icon. You can use this feature to compare settings for the 
current Tube with those from another Tube or Experiment (Figure 3-5). 

Figure 3-5  Viewing instrument settings

instrument settings editor

Inspector:
instrument settings report

Instrument frame:
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See the following sections for information about instrument settings:

• Adjusting Instrument Settings on page 110

• Creating Specimen- or Tube-Specific Settings on page 118

• Printing Instrument Settings on page 121

Adjusting Instrument Settings

To edit instrument settings during acquisition, click to position the Current Tube 
pointer in an open Experiment. Once a Tube has been selected, four instrument 
settings tabs are shown in the Instrument frame. (These four tabs appear in the 
Inspector frame during offline use.) Use controls in each tab to edit or adjust 
instrument settings. Within certain tabs, you can adjust settings using software 
controls or your keyboard. 

To adjust a setting, select the field containing the value you want to change. 
Software controls, consisting of up and down arrows and a slider bar, appear 
next to the value as shown in Figure 3-6. 

Figure 3-6  Software controls for adjusting instrument settings

Do one of the following to change any value:

• Select the value in the field and enter a new value.

• Click the pointer in the slider bar and drag it to a new value.

pointer in
slider bar
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• Use the mouse to click the up and down arrows or press the arrow keys on 
your keyboard to increase or decrease the values in small increments.

• Hold down the Control key while clicking the arrows or pressing the keys 
to increase stepped values ten-fold.

Using the Parameters Tab

A parameter is a measurement of a cell property determined as the cell passes 
through the laser beam. Each parameter is the output of a single PMT or 
photodiode, measuring fluorescent or scattered light. During acquisition, 
parameter data is sent from the cytometer to the workstation. By default, data is 
acquired and stored for the parameters listed in the current instrument 
configuration (see Instrument Controls on page 92). 

Use the Parameters tab to specify which parameter data should be sent and 
stored, to apply PMT amplification (or electronic gain for FSC), and to convert 
the parameter display to log. 

• Add unlisted parameters by clicking the Add button.

Parameters are listed in the order they are defined in the Instrument 
Configuration dialog box. When more than one fluorophore is defined for 
a given channel, the first listed fluorophore is added by default.

• Change to an alternate fluorophore for any channel by clicking the 
parameter field and choosing a different fluorophore from the drop-down 
menu that appears (see the following figure).

selection

drop-down

button

menu
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• Delete parameters by clicking the selection button next to the row to delete, 
and then clicking the Delete button.

Tip     To save space in the database, delete parameters that are not 
applicable for the corresponding Tube.

Tip     Select multiple contiguous rows by holding down the Shift key as you 
click; select multiple non-contiguous rows by holding down the Control key 
as you click. Click the Delete button to delete all selected rows.

• Measure signal height or width along with area by selecting the appropriate 
checkboxes. To measure height only, select Height and then deselect Area. 
(Either Area or Height must be selected for all listed parameters.) When 
Area or Height is selected, it will be measured for all fluorescent 
parameters.

For more information about parameter measurements, see Parameter 
Values on page 241.

• Adjust the signal for events displayed in plots by changing PMT voltages 
(electronic gain for FSC). Higher voltages increase detector sensitivity, 
resulting in increased signal; lower voltages decrease detector sensitivity, 
resulting in decreased signal.

Voltages can be adjusted from 0–1,000 V. To use the controls, see Adjusting 
Instrument Settings on page 110.

• For any listed parameter, select the Log checkbox to convert the parameter 
display to a log scale. Log data can be displayed over four- or five-log 
decades by selecting the appropriate option in the Experiment Inspector. 
See Using the Experiment Inspector on page 60.

Tip     Select multiple rows before clicking the checkbox to turn log on or 
off for multiple parameters at once. 
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Considerations When Using the Log Display

All data originating from the digital electronics is linear data from 0–262,143 
(218 – 1). BD FACSDiva software does not use log values, only linear values that 
can be displayed on a linear, log, or biexponential scale. Changing the data 
display does not affect statistics because statistics are always calculated on linear 
data.

Linear plots have tickmarks on 0, 10,000, 20,000, and so on. Logarithmic plots 
show a range of 26–262,143 (four-log decades) or 2.6–262,143 (five-log 
decades). In order to display all height measurements on a similar scale, 
BD FACSDiva software multiplies height values by 16. For this reason, the lowest 
decade on a log plot is always empty for height. For more information, see 
Parameter Values on page 241.

You can convert to log display before or after acquisition because data is always 
measured and stored in linear. If you change from linear to log or biexponential 
during analysis, the data will be redisplayed.

Using the Time Parameter

The Time parameter can be used to show how events change over time. In 
calcium flux experiments, the Time parameter is used to display the rate at which 
the cells in the sample respond to a stimulus. 

The Time parameter is displayed on a fixed scale of 0–262,143, where each tick 
represents 10 ms. Thus, an event that appears at position 50,000 on the Time 
scale is equal to 8 min 20 sec; an event that appears at 60,000 is equal to 
10 minutes. A plot can display up to 43 minutes of Time data.

When you append data to a recorded Tube, time is added to the existing data set. 
Thus, after appending 5 minutes of data to a 10-minute data set, the Time 
parameter of the last event would appear at 90,000.

Tip     To allow enough time for Ca++ flux response and resolution, enter a large 
value for the Events to Record before recording events for a calcium flux 
experiment. You cannot enter a specific time in which to record events or assign 
a time resolution. 

NOTICE     If a plot displaying the Time parameter is hidden during acquisition or 
recording, no data will be shown for the time in which it was hidden.
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Using the Threshold Tab

Use the Threshold tab to specify a boundary below which data will not be 
acquired. Threshold data consists of uncompensated linear signal height. 
Threshold values can be adjusted from 200 to approximately 262,143.

• Add a Threshold parameter by clicking the Add button.

• Change a listed parameter by clicking the parameter name and choosing a 
different item from the drop-down menu that appears.

• Delete a Threshold parameter by clicking the selection button next to the 
row to delete, then clicking the Delete button.

When more than one parameter is listed, use Or/And to define combined 
threshold values. 

• Or Threshold—signals must be equal to or greater than any one of the 
listed threshold values to be displayed and counted.

• And Threshold—signals must be equal to or greater than all listed 
threshold values to be displayed and counted.

drop-down menuselection
button
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Using the Compensation Tab

The Compensation tab displays Spectral Overlap values for all parameter 
combinations in the Experiment. For general information about compensation, 
see Controls for Compensation Correction on page 122.

There are two ways to adjust compensation in BD FACSDiva software: 
automatically using the Instrument Setup feature, or manually. To practice using 
each of these methods, try the corresponding tutorials in the BD FACSDiva 
Software Quick Start Guide.

When compensation is calculated using Instrument Setup (see Calculating 
Compensation Using Instrument Setup on page 123), you should not need to 
adjust the values after calculation. 

If you are adjusting compensation manually, click in the Spectral Overlap field to 
access controls to adjust the values, or click to select the value in the field and 
enter a new value. To clear one or more values, select one or more rows and click 
Clear. To clear all values, select all rows, and then click Clear.

Compensation values range from 0–1,000%; the slider control displays 
increments of 100. Adjustments can be made during acquisition or on previously 
recorded data. View or record uncompensated data by deselecting the Enable 
Compensation checkbox.
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Copying Spectral Overlap Values

If you are performing compensation manually, you can copy spectral overlap 
values from one instrument settings object to another. To do so,

1 Right-click the Tube or Instr Settings icon containing the values you want 
to copy and choose Copy Spectral Overlap.

This command copies only the Spectral Overlap values from the current 
instrument settings.

2 Select the Browser item(s) for which you want to update the Spectral 
Overlap values, right-click the selected items, and choose one of the Paste 
options.

• Choose Paste Spectral Overlap to update existing values with the 
values from the copied settings without overwriting non-zero values in 
the target settings with zeros from the source. This is useful when you 
are combining compensation settings from multiple Tubes for a 
complete compensation matrix.

• Choose Paste Spectral Overlap with Zeros to update existing values 
with the values from the copied settings, and to overwrite non-zero 
values in the target settings with zeros from the source. This is useful 
when you are copying compensation values to a Tube that already has 
compensation values.

For example, note how the two Paste options affect the data for the 
following compensation Tubes.

NOTICE     If the target instrument settings use a set of parameters or PMT 
voltages that are different from the pasted object, a warning message is 
displayed. Only compensation values that use a matching set of parameters 
can be pasted. 

Source Tube Destination Tube
Result after

Paste Paste with Zeros

FITC-% PerCP 7 5 7 7

PerCP-% FITC 0 2 2 0
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When a parameter exists in the target, but not in the source, the values for that 
parameter will not be changed. Conversely, if a parameter exists in the source 
but not the target, the values for that parameter are not added to the target.

Using the Ratio Tab

Ratios are most commonly used for calcium flux experiments. They are 
calculated by dividing the signal from one fluorescence detector by the signal 
from another fluorescence detector and then multiplying by a percentage value 
(25%, by default).

Ratios are calculated from uncompensated linear data and are always reported in 
linear. Ratios can be used for sorting just like any other parameter.

• Include up to 10 ratio 
calculations by clicking the Add 
button at the bottom of the Ratio 
tab.

• Specify the numerator and 
denominator by choosing 
parameters from the drop-down 
menus in each field. All 
parameters listed in the 
Parameters tab are available for 
ratio calculations.

• Adjust the ratio scaling factor by entering a value in the Scaling % column, 
from 0–200%.

• Delete a ratio calculation by clicking the selection button next to the row to 
delete, and clicking the Delete button.

NOTICE     If a parameter used in a ratio calculation is subsequently removed from 
the Parameters tab, the ratio will be deleted. 

selection button drop-down menu
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Creating Specimen- or Tube-Specific Settings

Create Specimen- or Tube-specific settings when you need to collect data for a 
subset of your Experiment using different settings than other parts of the 
Experiment. For example, some Tubes or Specimens might use different scatter, 
fluorescent, or ratio parameters or different measurement types or thresholds. 

Do one of the following to add instrument settings at the Specimen or Tube level:

• Select the Tube or Specimen in the Browser, and then click the New 
Instrument Settings button in the Browser toolbar ( ).

• Right-click the Specimen or Tube icon in the Browser and choose New 
Instrument Settings. 

• Select the Specimen or Tube and choose Experiment > New Instrument 
Settings.

• Copy instrument settings from another Browser element (Experiment, 
Specimen, or Tube), and paste them to the target Tube or Specimen.

When you create new settings, initial values are copied from the closest parent 
settings. Further adjustments apply to the Experiment-level settings only when 
the Use global instrument settings preference is enabled (selected by default). 

If you want to create Specimens or Tubes with varying settings that do not update 
with the latest settings changes in the Experiment, deselect the preference. For 
more information, see Using Global Instrument Settings on page 119.
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Using Global Instrument Settings

The Use global instrument settings option is available in 
the Experiment Inspector. When this preference is 
enabled, Experiment-level instrument settings are 
automatically updated to reflect changes to Tube- or 
Specimen-specific settings, and subsequent Tubes are 
automatically updated to use the latest Experiment-level 
settings.

NOTICE     If Tube- or Specimen-specific settings are 
linked to a Setup (see Applying a Setup to Instrument 
Settings on page 131), Experiment-level settings are not 
updated automatically, even when this preference is enabled.

For example, if you disable the Use global instrument settings option and make 
changes to Tube-specific settings (Instrument frame), notice that the global 
settings (in the Inspector) do not change.
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If you make the same changes to Tube-specific settings with the global settings 
option enabled, the changes are automatically applied to the Experiment-level 
settings:

Additionally, updated settings are automatically applied to the remaining 
unrecorded Tubes in the Experiment, even when they have Tube-specific settings. 
Updated settings are applied when you move the Current Tube pointer:
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Printing Instrument Settings

To print instrument settings for the current Experiment, Specimen, or Tube, select 
the item in the Browser and click the Print button in the Instrument Settings 
Inspector (report view), or right-click the selected item and choose Print from the 
contextual menu. 

A printout will be generated that includes:

• name of Experiment, Specimen, and Tube

• collection date

• list of parameters collected, voltage values, and whether log is on or off

• threshold parameter(s) and value(s)

• compensation state and values

• ratio parameters

A more detailed, formatted report of instrument settings can be printed, viewed, 
or exported using the Instrument Status Report option on the Instrument menu. 
See Instrument Status Report on page 101 for more information.
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Controls for Compensation Correction

Different fluorochromes can emit light over a common range of wavelengths. In 
the following example, FITC, PE, and APC all emit fluorescence in the 550–
625 nm range.

When the emission of one fluorochrome is detected by a detector designated for 
another fluorochrome, it is impossible to separate the two signals optically. The 
following example illustrates PE spillover into the APC detector.

Compensation is the correction applied to the raw data to remove the effects of 
this spillover emission (ie, fluorescence). For example, when you are measuring 
APC fluorescence, compensation removes the PE fluorescence that is detected by 
the APC detector, or APC–%PE. 

spectral overlap

PE APC
detectordetector

spillover
emission
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Generally, in analog systems, compensation correction is applied electronically 
before the data is stored, while in digital systems, the software applies the 
correction real time or after the data is stored. This section describes the 
compensation controls available in BD FACSDiva software.

Calculating Compensation Using Instrument Setup

As the number of fluorescence parameters in an experiment increases, compensation 
becomes increasingly difficult to set manually. For a six-color experiment, 30 
spectral overlap values need to be adjusted, and for an eight-color experiment, 56 
values need to be adjusted. The process of manually correcting spectral overlap 
values can take several hours and is very difficult to set accurately.

The Instrument Setup feature in BD FACSDiva software is designed to 
automatically calculate spectral overlap values for an experiment, saving the user 
time and eliminating the inaccuracies introduced with manual compensation.

Instrument Setup is designed to work with single-stained controls. These controls 
can consist of single-stained cells, capture beads, or other setup beads. An 
unstained control is required as well, in a separate tube or in the same tube as one 
of the single-stained controls. Refer to your instrument manual for a specific 
example.

Instrument Setup features are accessed from the Instrument menu. Choose 
Instrument > Instrument Setup to access setup functions. For details on each 
function, see the following:

• Creating Compensation Controls on page 124

• Defining Label-Specific Controls on page 125

• Calculating Compensation on page 128

• Viewing the Setup Catalog on page 128

To practice using the Instrument Setup feature, do the corresponding tutorial in 
the BD FACSDiva Software Quick Start Guide.
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Creating Compensation Controls

Choose Create Compensation Controls to automatically add compensation 
controls and Analysis objects to your Experiment. A dialog box appears where 
you can add or delete controls, define label-specific controls, or change the order 
of the compensation controls (Figure 3-7).

NOTICE     In the Create Compensation Controls dialog, you can add only 
parameters that are listed in the Parameters tab. To change to a secondary 
fluorophore for any channel, edit instrument settings in the Inspector or 
Instrument frame before you create compensation controls.

Figure 3-7  Creating compensation controls

• Leave the Include separate unstained control tube/well checkbox selected 
when you are running unstained sample as one of your compensation 
controls.

• Deselect the checkbox when you are including unstained sample in each of 
your stained control tubes or wells. In this case, you will need to gate the 
unstained population in each fluorescence histogram before you calculate 
compensation.

• For information about label-specific controls, see Defining Label-Specific 
Controls on page 125.
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When you click OK, a new Specimen named Compensation Controls is added to 
the open Experiment in the Browser, with Tubes for each specified parameter. A 
Tube-specific worksheet is added for each fluorophore, along with an unstained 
control worksheet if the checkbox was selected (Figure 3-8). The Experiment’s 
instrument settings are copied to the Specimen, all compensation values are set to 
zero, and the Enable Compensation checkbox is deselected. 

These Tubes and plots are used to record data prior to calculating compensation. 
PMTs and Laser settings can be set before the compensation Tubes are created or 
any time before the first compensation Tube is recorded.

Figure 3-8  Compensation controls and worksheets

Defining Label-Specific Controls

Create label-specific controls if your experiment contains samples stained with 
the same fluorophore conjugated to different antibodies (labels) that require 
different compensation values. This is especially noticeable in tandem conjugates 
due to lot-to-lot variation. Label-specific controls can be defined during the 
creation of compensation controls (described in the previous section) or you can 
modify existing controls.

Only one set of compensation Tubes can be created per Experiment. 
Compensation cannot be calculated if PMT voltage settings are changed 
while recording compensation Tubes. All Tubes must be recorded with 
consistent PMT voltages.
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1 Choose Instrument > Instrument Setup > Create Compensation Controls or 
Modify Compensation Controls.

The Create (or Modify) Compensation Controls dialog box appears 
(Figure 3-9). 

Note that some of the parameters already contain labels. When a parameter 
name includes a hyphen (indicating it is a fluorophore conjugate) and a 
label has already been assigned in the Experiment Layout dialog box or the 
Inspector, BD FACSDiva software automatically assigns the label to the 
corresponding compensation control. 

2 To add a generic control or a control with a different label, click Add.

• Choose the appropriate fluorophore from the drop-down menu. 

• Use the selection button next to the fluorophore name to drag the new 
fluorophore to the required position in the list.

• Enter a label. 

Figure 3-9  Keeping a generic control while adding label-specific controls

o

3 To edit a control, choose or enter a different label.

4 To delete a control, click the selection button next to the fluorophore and 
click Delete.

generic control

labeled control
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5 Click OK to add the controls to your Experiment.

Label-specific controls and Analysis objects are created automatically. 

• If controls were added, the corresponding controls and worksheets are 
added to the open Experiment and Worksheet frame, respectively.

• If controls were edited, the corresponding controls and worksheets are 
renamed. 

The labels appear in the Browser, the Labels tab of the Inspector, and on 
associated worksheets.

Editing Gates

After you create appropriate compensation controls, you need to verify gates 
before you calculate compensation. Gates in the software-defined Analysis 
objects are Snap-To gates, so minimal editing is required.

1 On any plot, move the P1 gate to the required population.

If the gate does not contain all required events, edit the gate or right-click it 
and choose Recalculate.

2 Right-click the P1 gate and choose Apply to All Compensation Controls.

This applies the P1 gate changes to all worksheets at one time. 

3 If needed, adjust PMT voltages to place populations at the required 
locations.

4 Verify that the P2 gate encompasses the positive population on each 
fluorescence histogram.

If needed, right-click the gate and choose Recalculate.

5 If you do not have a separate unstained control, create an Autointerval gate 
around the negative population in each fluorescence histogram.

If you have an Unstained Control Tube (or Well), you can skip this step.
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Calculating Compensation

After gates have been adjusted, you are ready to calculate compensation. Choose 
Instrument > Instrument Setup > Calculate Compensation. The software 
calculates the overlap as the median fluorescence intensity (MFI) of the positive 
stained control minus the MFI of the negative stained control for each control in 
all channels. If there is a gated unstained population in the Unstained Control 
Tube and a gated unstained population in the Stained Control Tube, the 
population in the Stained Control Tube will be used in the calculation.

If the compensation calculation is not 
successful, an error message will be 
displayed; otherwise, a dialog box appears 
where you can enter a name for the 
compensation Setup: 

Enter a name, and click OK to dismiss the dialog box.

Tip     Include the Experiment name or date to keep track of compensation Setups.

Viewing the Setup Catalog

After a successful compensation calculation is named, all instrument settings 
associated with the compensation calculation are saved in a Setup catalog. A 
saved Setup contains parameter and label information, the threshold and PMT 
voltages for each parameter, and calculated spectral overlap values in the form of 
an MFI table. 

View a list of all saved Instrument Setup sessions by choosing Instrument > 
Instrument Setup > Setup Catalog.
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• To edit a Setup session, select the session and click Rename or Delete. 

• To view the details of a Setup session, select the session and click Details. 

A window appears listing all instrument settings and labels associated with 
the Setup. 

- Click the Spectral Overlap tab to view calculated overlap values in the 
form of an MFI table.

- Click the Lasers tab to view the laser delay setting and area scaling 
value for each laser.

- Click Close to return to the Setup Catalog.

Note that much of the information displayed in the Setup Catalog can be 
printed or exported by printing or exporting a set of linked instrument 
settings. See Printing Instrument Settings on page 121 for more information.

Using Setups

When compensation is calculated by the software, the Experiment is linked to the 
resulting compensation Setup. When the Use global instrument settings 
preference is enabled for the Experiment, the Setup is applied to Tubes in the 
Experiment as the Current Tube pointer is moved. To further optimize settings 
based on a Setup, be sure to unlink the Experiment from the Setup before you 
optimize the settings. See Unlinking a Setup from Instrument Settings on 
page 130.
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A Setup can also be applied to a new Experiment, as described in Applying a 
Setup to Instrument Settings on page 131. When you apply a Setup, if the Setup 
contains label-specific Tubes and Tubes in the Experiment are not labeled, you 
are prompted to choose a compensation value, as described in Applying Label-
Specific Compensation Settings to Tubes on page 133.

NOTICE     Changes to PMT voltages for a Tube that is linked to a Setup could 
invalidate the linked compensation settings. The software warns you when you 
change voltages for a Tube that is linked to a calculated Setup:

• To disregard this message and apply the change, click OK. Click the 
checkbox if you do not want the warning message to appear again.

• To keep the same PMT settings, click Cancel.

Unlinking a Setup from Instrument Settings

You can unlink instrument settings from a calculated Setup if you need to make 
adjustments to the settings. To do so, right-click an Instr Settings icon and choose 
Unlink From SetupName; click Yes in the dialog box that appears.

NOTICE     If you re-link the settings and the preference is enabled to 
Automatically update instrument settings according to latest setup, your 
adjustments will be overwritten by the previous settings.
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Applying a Setup to Instrument Settings

Saved Setup values (spectral overlap, threshold, and PMT voltages) can be 
applied to an Experiment, and spectral overlap values in a Setup can be applied 
to a recorded Tube.

• To apply a Setup, right-click an Instr Settings icon in the Browser and 
choose Apply Setup. 

• To apply spectral overlap values, right-click an Instr Settings icon under a 
recorded Tube and choose Apply Compensation. 

In either case, a Setup Catalog appears where you can select a Setup to apply:

• Click Details to view values associated with the Setup.

• Click Apply to apply values to matching parameters in the instrument 
settings. Only parameters that match those in the Setup are updated. 
Settings are then linked to the Setup, so if you add a parameter that 
matches one in the Setup, values for the matching parameter are updated 
automatically.

• Click Overwrite to replace the existing settings with settings based on the 
selected Setup. (This option is not available for recorded Tubes.) If 
parameters and PMT voltages match, the Setup Catalog is dismissed. If the 
parameters or PMT voltages do not match, the following message appears 
(Figure 3-10 on page 132). 
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Figure 3-10  Instrument Settings Mismatch message

- Click Apply to apply PMT voltages, spectral overlap values, and 
threshold values to parameters in the instrument settings that match 
those in the Setup. Only matching parameters are updated. Settings are 
then linked to the Setup, so if you subsequently add a parameter that 
matches one in the Setup, spectral overlap and PMT values are updated 
automatically.

- Click Overwrite to replace the existing settings with settings based on 
the selected Setup. Parameters that did not match are removed.

NOTICE     If the Setup or instrument settings contain label-specific controls, you 
will be prompted to choose which spectral overlap value to use. For more 
information, see Applying Label-Specific Compensation Settings to Tubes on 
page 133.

Once an instrument settings object has been linked to a Setup, you cannot edit 
compensation values manually. The compensation editor of the instrument 
settings is locked, and the Clear button and Paste Spectral Overlap commands 
are disabled.

Automatically Updating Linked Instrument Settings

The General tab of User Preferences contains a checkbox to Automatically 
update instrument settings according to the latest setup. When this preference is 
selected (which is the default setting), instrument settings for unrecorded Tubes 
that are linked to a named Setup are automatically updated when the Setup 
changes.
132 BD FACSDiva Software Reference Manual



Applying Label-Specific Compensation Settings to Tubes

If your Experiment contains label-specific compensation controls, you will need 
to specify which spectral overlap value to use for each Tube in the Experiment by 
assigning appropriate labels. Label Tubes in one of the following ways:

• Use the Experiment Layout dialog box to label all Tubes in the Experiment 
at once.

• Use the Labels tab in the Inspector to label one Tube at a time.

The software determines whether to use compensation values from generic or 
label-specific controls based on the following criteria.

If a compensation control is label-specific and you record a control that hasn’t 
been assigned a label or whose label does not match the control, a dialog box 
appears where you can choose which control to apply. See Figure 3-11 on 
page 134.

Setup Control Tube Parameters Spectral Overlap Value Applied

Generic Not labeled Generic

Generic Labeled Generic

Generic and label-specific Not labeled Generic

Generic and label-specific Labeled Label-specific, if control label 
matches the parameter label. 
Otherwise, generic value is 
applied.

Label-specific Not labeled Label must be chosen in 
dialog box that appears.

Label-specific Labeled Label-specific, if label of 
Control Tube matches the 
parameter label. Otherwise, 
label must be chosen in 
dialog box that appears.
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Figure 3-11  Choosing a control label

After you choose a control, spectral overlap values are applied using the value for 
the chosen label. 

NOTICE     If you click Cancel and dismiss the dialog box without choosing a 
control, the software will not apply a complete compensation matrix resulting in 
uncompensated channels, as shown in the following figure.

Figure 3-12  Complete (left) vs incomplete (right) compensation matrix using label-specific controls
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Calculating Compensation Manually

When you adjust compensation settings manually, the means for each 
fluorescence-positive population are compared to the means for its negative 
population. Appropriate compensation networks are adjusted to align the means. 

Tip     Compare medians for populations with many outlying events. Compare 
means when cells are clustered more closely together with few outlying events.

Compensation settings for single-color Tubes are combined for a mixed-color 
Tube using the Copy Spectral Overlap and Paste Spectral Overlap commands. See 
Copying Spectral Overlap Values on page 116 for a description of these 
commands. For a demonstration of this feature, practice the tutorial on 
Calculating Compensation Manually in the BD FACSDiva Software Quick Start 
Guide.

Note that compensation calculation is part of instrument settings optimization 
that typically occurs after you have performed daily quality control and adjusted 
the voltages and threshold. Refer to your instrument manual for specific 
instructions. 

NOTICE     If you paste compensation values to a Tube with different Voltage 
settings than the source Tube, a warning message will appear. 
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4

Tools for Data Analysis

During analysis, recorded data is displayed in plots while gates are used to define 
populations of interest. BD FACSDiva software analyzes the data and calculates 
statistics that you can print or export.

This chapter provides an overview of data analysis. Application-specific 
examples of data analysis can be found in your instrument manual.

The following topics are covered in this chapter:

• Worksheets on page 138

• Plots on page 150

• Gates on page 167

• Population Hierarchy on page 178

• Statistics on page 184

• Batch Analysis on page 192

• Working Offline on page 194
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Worksheets

A worksheet is the main work area of BD FACSDiva software—it is where you 
create plots, define gates, show statistics and population hierarchies, and enter 
custom text. Because plots and statistics for a Tube can be on different 
worksheets, multiple worksheets can be used to organize your workflow. For 
example, use one worksheet for instrument QC and sample optimization, and use 
a second worksheet for analysis. Worksheets are shown in the Worksheet frame, 
and can be normal or global. 

Normal worksheets have grey-tinted tabs and contain Tube-specific analysis 
elements, while global worksheets have green-tinted tabs and contain elements 
that can show data from any Tube. Select a Tube’s data for display by moving the 
Current Tube pointer. For more information, see the following section, Normal 
Worksheets, or Global Worksheets on page 139.

To display the Worksheet frame, click the Worksheet button in the Workspace 
toolbar ( ). To toggle between the worksheet and global worksheet view, click 
the Worksheets view button in the Worksheet toolbar ( ).

Normal Worksheets

• To add a new worksheet to an open Experiment, choose Worksheet > New 
Worksheet. A maximum of 30 worksheets is allowed. By default, new 
worksheets are sized to fill the open frame.

• To expand the size of a worksheet, use the Worksheet Inspector to increase 
the number of pages. A worksheet can have up to 250 pages. Page breaks 
are indicated by a dotted line when the Show Page Breaks option is 
enabled. See Using the Worksheet Inspector on page 144.

Tip     Resize the Worksheet frame to view horizontal or vertical scroll bars.

• To find a Tube-specific object on a worksheet, double-click its associated 
Tube in the Browser. The first object associated with the Tube will be 
displayed at the top of the Worksheet frame. (Alternatively, double-click 
any worksheet element to locate the corresponding Tube in the Browser.)
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• To delete a worksheet, click the worksheet tab and choose Worksheet > 
Delete Worksheet.

Switch between multiple worksheets by clicking the 
tabs at the top of the worksheet (see figure). You can 
work within only one worksheet, the active 
worksheet, at a time. (The active worksheet is indicated by a plot icon next to the 
worksheet name.)

NOTICE     While there is no impact on data collection or instrument performance, 
responsiveness can decline as more plots, statistics, gates, and events are 
displayed for each Tube. To improve system response time, limit the number of 
plots displayed in the viewable area of the Worksheet frame.

Global Worksheets 

Global worksheets allow you to create a single Analysis object for acquiring or 
recording data from a set of Tubes. Analysis objects are part of the global 
worksheet, and are not tied to a specific Tube. You can display data for any Tube 
by moving the Current Tube pointer. 

A maximum of ten global worksheets can be set up for each Experiment, and 
each global worksheet can contain up to 10 pages. When the first global 
worksheet is added to an Experiment, a Global Worksheets folder is created in 
which all global worksheets for that Experiment will be stored. Global 
worksheets are displayed in this folder in the order they were created.

All data analysis and Worksheet tools available for normal worksheets are 
available for global worksheets. To move objects between worksheets and global 
worksheets, you must use the copy and paste functions; objects cannot be 
dragged.

NOTICE     If you copy an Analysis object that spans more than 10 pages from a 
normal worksheet to a global worksheet, only objects that fit on the first 10 
pages will be copied.

Tip     Differentiate a worksheet from a global worksheet by the color and title on 
the worksheet tabs. Normal worksheets are titled SheetN when created, and they 
have the same neutral color background as most other tabs. Global worksheets are 
titled Global SheetN when created, and have colored tabs. 
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Create a global worksheet in any of the following ways:

• Click the New Global Worksheet button in the Browser toolbar ( ). 

• Choose Experiment > New Global Worksheet.

• Right-click an open Experiment or a Global Worksheets folder and choose 
New Global Worksheet from the menu.

NOTICE     Analysis objects on global worksheets derive their titles and headers 
from the current Tube. Sort layouts on global worksheets use the population 
hierarchy of the global worksheet, not the Tube. Tube-specific plots cannot be 
made on a global worksheet, and non–Tube-specific plots cannot be made on a 
normal worksheet.

Using Global Worksheets

The following example shows one way in which global worksheets can be used. 
For more examples, see Using Gating Features in the BD FACSDiva Software 
Quick Start Guide, or refer to your instrument manual.

1 Create a global worksheet and generate all required plots.

2 Move the Current Tube pointer to the first Tube for which you are 
acquiring data.

3 Start acquisition or recording. Data will appear on the global worksheet.

4 Create gates, statistics, and population hierarchies as needed.

5 Move the Current Tube pointer to the next Tube and acquire or record 
data.

Data will appear on the global worksheet using the gates created in step 4. 
If the new Tube uses fewer parameters than the previous Tube, data might 
not be displayed in all plots. Any plots that use a missing parameter will 
appear greyed out (the missing parameter is crossed out). See Figure 4-1 on 
page 141.
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Figure 4-1  Plot displaying all parameters (left) and missing parameter (right)

6 Edit the gates to reflect the data from the second Tube. 

NOTICE     Once edited, the gates in step 6 remain as edited, even if you 
return to Tube 1 by moving the Current Tube pointer. Gates are global and 
attached to the global worksheet, not the Tube.

7 To save the analysis with a Tube, copy the Analysis object to the Tube.

You can also enable the user preference to automatically save a copy after 
recording; see General Preferences on page 86.

Using the Worksheet Toolbar

There are five sets of tools on the Worksheet toolbar: the Worksheets view 
button, a Select button, plot tools, gate tools, and worksheet tools. Certain tools 
are enabled only when elements appropriate for the tool are selected. To use any 
enabled tool, click once to select it. To reuse a tool multiple times without 
reselecting it, double-click the tool. It will remain selected until you select another 
tool or press the Esc key.

‘

worksheet tools

Select
button

Worksheets
view button plot tools gate tools
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A summary of tool functions follows.

Worksheets view button—toggles the Worksheet frame between the 
global and normal worksheet view.

Select button—selects (by clicking), moves (by dragging), or resizes 
(by dragging a selection handle of) objects in a worksheet.

Plot Tools

Use Plot tools to create plots, zoom in and out on plot data, and resize plots.

Plot tools—create dot (D), contour (C) or histogram (H) plots. 
Select a Tube, select the tool, and then click in the worksheet to 
create a plot of a default size. For other options, see Creating Plots 
on page 151.

Zoom-In tool—magnifies an area of a plot. Select the tool, click in 
the plot, and drag to define the area of the plot to be enlarged. The 
tickmarks on the axes of the plot adjust to reflect the magnified view. 
A zoomed plot has a magnifying icon in its lower-left corner.

Zoom-Out tool—undoes the last zoom-in action. Select the tool 
and click once in the plot. Each click with the tool undoes the last 
zoom-in action. To return to the originally sized plot in one click, 
hold down the Control key while clicking in the plot.

Increase Plot Size tool—increases the size of plots on the worksheet. 
Select the tool and click once in a plot. The length of the x- and y-
axes doubles each time you use the tool.

Decrease Plot Size tool—decreases the size of plots on the 
worksheet. Select the tool and click an increased plot. The length of 
the x- and y-axes halves each time you use the tool. Plots cannot be 
resized below their original size.

Gate Tools

Use gate tools to define population subsets on plots. The Interval Gate tools are 
the only tools that can be used to gate data on a histogram. For more information 
about gate tools, see Gates on page 167.

Autopolygon-Gate tool—draws a gate automatically around a 
distinct cluster on a dot or contour plot. Once the gate has been 
drawn, its shape and size remain constant, even as new data is 
provided to the gate.

C HD
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Snap-To Gate tool—draws a gate automatically around a distinct 
cluster on a dot or contour plot. Unlike an Autopolygon gate, a 
Snap-To gate recalculates as new data is provided to the gate.

Polygon Gate tool—allows a polygonal gate to be drawn around a 
population on a dot or contour plot.

Rectangle Gate tool—creates a rectangular gate around a 
population on a dot or contour plot.

Quadrant Gate tool—divides a plot into four quadrant gates. Each 
quadrant has its own population statistics.

Interval Gate tool—allows a range of events to be selected on a dot 
or contour plot or histogram.

Autointerval Gate tool—draws an Interval gate automatically 
around a range of events on a dot or contour plot or histogram. 
Once the gate has been drawn, its shape and size remain constant, 
even as new data is provided to the gate.

Snap-To Interval Gate tool—draws an Interval gate automatically 
around a range of events on a dot or contour plot or histogram. 
Unlike an Autointerval gate, a Snap-To Interval gate automatically 
recalculates as new data is provided to the gate.

Worksheet Tools

Use Worksheet tools to customize worksheets. See Editing Worksheets on 
page 145 and Aligning and Resizing Worksheet Elements on page 148.

Customizing tools—allow you to personalize worksheets with 
arrows (A), lines (L), and text (T).

Align tools—align selected objects in a worksheet. A minimum of 
two objects must be selected for the tools to be active. 

Use these tools to align worksheet elements at their left, right, top, 
and bottom edges, respectively, with the last-selected object (object 
with yellow selection handles).

Distribute tools—put the same amount of horizontal or vertical 
space between selected objects in a worksheet. A minimum of three 
objects must be selected for the tools to be active.

Make Same Size tool—makes selected objects in a worksheet the 
same size as the last-selected object. A minimum of two objects 
must be selected for the tool to be active.

A L T
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Using the Worksheet Inspector

Use the Worksheet Inspector to name the worksheet 
or global worksheet, increase the number of pages in 
the worksheet, and hide or show page breaks and 
page numbers.

To view worksheet options in the Inspector frame, 
click the background area of a worksheet. (If you 
click an object on the worksheet, the Inspector shows 
the properties of that object.)

• To change the name of the worksheet, select the 
text in the Name field, enter the new name, and then press Enter. 

• To enlarge the worksheet area, change the values in the Number of Pages 
fields. Additional pages are added in the Vertical or Horizontal direction, to 
a maximum of 250 normal worksheets or 10 global worksheets. The 
product of Horizontal x Vertical cannot exceed 250 or 10, respectively.

• To hide page breaks, deselect the Show Page Breaks checkbox. 

NOTICE     Do not place worksheet elements on the dotted line representing 
a page break. Objects that straddle a page break are split between two 
printed sheets.

• To show numbers on the lower-right corner of each printable page, select 
the Show Page Numbers checkbox. Pages are numbered in the order in 
which they will be printed. When page numbers are shown, they will also 
appear on each printed page.
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Editing Worksheets

Worksheets or global worksheets are used to display plots, gates, population 
hierarchies, and statistics. For information on creating these elements, see the 
corresponding sections in this chapter. Additionally, worksheets can be 
customized with lines, arrows, and text. 

NOTICE     Lines, arrows, and text are not saved with Analysis objects, thus they 
are not included when you copy an Analysis object to another Tube or worksheet, 
or when an Analysis object is saved automatically via user preferences (Save 
analysis after recording through global worksheet).

Adding Lines or Arrows

Use lines to separate header information from the rest of your worksheet, or to 
delineate areas of your worksheet. Use arrows to point to an area of interest.

To add a line or arrow, select the Line ( ) or Arrow tool ( ) and then click in 
the worksheet. Use the Inspector to change the properties of the line or arrow.

The appropriate Inspector is displayed when the line or arrow is selected in the 
worksheet. A selected object is highlighted in yellow (Figure 4-2).

Figure 4-2  Rule Inspector for selected line (left) and Arrow Inspector for selected arrow (right)
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• Specify the line style, direction, and color by making appropriate selections 
in the Rule Inspector. Resize a line on the worksheet by dragging one of the 
black handles on either end of the selected line; move the line by selecting 
the line and dragging.

• Change the style of the arrowhead and the color of the arrow in the Arrow 
Inspector. Change the length or angle of the arrow by dragging one of the 
black handles on either end of the selected arrow; move the arrow by 
selecting the arrow and dragging.

• Delete a line or arrow by selecting it, and then pressing Delete.

Adding Text

You can add text anywhere on a worksheet. Click the Text tool ( ) and then 
click in the worksheet to insert a text box; use the Inspector to change the text 
properties.

• Edit the text in a text box by selecting the current text, then entering new 
text. Click anywhere outside the text box to complete the entry.

• Change the text properties by making selections in the Text Inspector (text 
does not need to be selected). Changes apply to all text within the selected 
text box.

• Move a text box by selecting it, and dragging the border to a new location. 

• Resize a text box by selecting it, and dragging one of the selection handles 
in or out.

• Delete a text box by selecting it, and then pressing Delete.

selected text box
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Duplicating Worksheet Elements

Duplicate an element on a worksheet in one of the following ways:

• Hold down the Control key and drag a worksheet element to a new 
location. The element is duplicated when the mouse button is released.

• Press Ctrl-C to copy an element; press Ctrl-V to paste it in a new location, 
such as on another worksheet. Copied elements can also be pasted to 
another Tube, or to any Microsoft Office application.

• Right-click a plot and choose Duplicate, or select the plot and press Ctrl-D.

Exporting Worksheet Elements

Individual worksheet elements such as plots, population hierarchies, and 
statistics views can be copied to any Microsoft Office application.

1 Select the worksheet element and press Ctrl-C.

2 Open a Microsoft Office document (such as a Word document or 
PowerPoint® slide), and press Ctrl-V.

You can also copy an image of the BD FACSDiva workspace—including the 
worksheet, Browser, and Inspector—and resize it or edit it in a word-processing 
or graphics application.

1 Copy the workspace to the clipboard.

• To copy an image of the BD FACSDiva software workspace, press Alt-
Print Screen.

• To copy an image of the entire screen, press Print Screen.

2 Paste the image into an open window in the word-processing or graphics 
application.

The image is stored in memory until it is pasted into another application.
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Aligning and Resizing Worksheet Elements

Use worksheet tools to align or resize one or more elements on a worksheet. The 
following tools can be used with any worksheet object.

Tip     When you duplicate an Analysis object (eg, by copying and pasting an 
Analysis object or duplicating a Tube with an Analysis object), elements in the 
new Analysis object are added to the available space on the existing worksheet. To 
contain an Analysis object on one page, edit the size or position of worksheet 
elements so they fill a page before the Analysis object is duplicated.

• To move a selected object, position the cursor on the border of the object. 
When the cursor changes to two double-headed arrows, drag the object to 
move it. See Figure 4-3.

• To make objects the same size, hold down the Shift key while selecting two 
or more objects on a worksheet. The object selected last becomes the main 
selected object, indicated by yellow selection handles (Figure 4-3). Click the 
Make Same Size tool ( ); all objects are resized to the same size as the 
main selected object.

Figure 4-3  Selecting multiple objects

Note that individual selected objects can also be resized by dragging a 
selection handle. Position the cursor over the selection handle. When the 
cursor changes to a double-headed arrow, drag the border in the direction 
of the arrow. 

selection handles on
selected dot plot

selection handles on
selected histogram
(main selected object)

cursor showing
object can be moved
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• To align multiple objects, select two or more objects, and click the 
appropriate tool ( ). Use these tools to align to the left, right, top, 
and bottom edges, respectively. Objects are aligned in relation to the last 
selected object.

• To put equal amounts of space between objects, select three or more objects 
on a worksheet. Click the appropriate Distribute tool ( ); the objects 
are distributed equally in a horizontal or vertical direction. 

• To increase the size of a plot, select the Increase Plot Size tool ( ) and then 
click a plot on the worksheet. The length of the x- and y-axes doubles each 
time you use the tool. Use the Decrease Plot Size tool ( ) to return the plot 
to its previous size. Note that plots cannot be reduced below their original 
size.

Tip     You can also use the Zoom In tool to magnify an area in a plot.

Printing Worksheets

Choose one of the following commands from the File menu to set up for printing 
or to print worksheets.

• Choose Page Setup to set the size of the printed page (eg, A4 vs letter), the 
orientation (portrait or landscape), and the margin size. Your options will 
vary depending on the printer configured with your workstation. 

If there are multiple worksheets in the Experiment, options apply only to 
the active worksheet.

• Choose Print Preview to view a thumbnail of all printable pages at 10, 30, 
50, or 100%. Click the close box to return to the worksheet.

• Choose Print to print the active worksheet.

NOTICE     Do not place worksheet elements on the dotted line representing a page 
break. Objects that straddle a page break will be split between two printed 
sheets. 
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Plots

Multiparameter data events can be displayed in dot, contour, density, or 
histogram plots.

Dot Plot—graphical representation of two-parameter data, 
where each axis displays the signal intensity of one parameter 
and each dot represents one or more events (cells or particles)

Contour Plot—graphical representation of two-parameter 
data, where each event has a position in the plot according to 
its intensity values for both parameters

Contour lines provide a third dimension by joining x- and y-
coordinates with similar event counts. These plots are similar 
to topographic maps which use contour lines to show points 
at the same elevation.

Density Plot—graphical representation of two-parameter 
data where each axis displays the signal intensity of one 
parameter and colors indicate the number of events

Density plots are similar to dot plots except colors are used to 
represent the accumulation of events (density) for events with 
the same signal intensity. A density plot simulates three-
dimensional event display.

Histogram—graphical representation of single-parameter 
data, where the horizontal axis represents the increasing 
signal intensity of the parameter, and the vertical axis 
represents the number of events (count)
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Creating Plots

Use menu commands or plot tools to create dot plots, contour plots, or 
histograms. Note that contour plots are not available during acquisition. When 
you create a contour plot during acquisition, a density plot appears by default. 
During analysis, a contour plot appears. To create a density plot during 
acquisition, first create a contour plot, then use the Inspector to change the plot 
type to density. See Formatting Contour Plots on page 162.

• To create a plot using a plot tool, select a plot tool from the 
Worksheet toolbar, and click once on the worksheet to draw a 
plot of default size.

If you prefer to define the plot size, click and drag on the worksheet to 
create a rectangle of the required size.

Tip     To create multiple plots, double-click the Plot tool. The tool will 
remain selected until another tool is selected, or until you press the Esc key. 
You can then repeatedly click in the worksheet and the same plot type will 
be created each time. 

• To create a plot on a normal worksheet using menu 
commands, select one or more Tubes in the Browser, 
right-click the selected Tubes, and choose an option from 
the menu.

If you create plots while the global worksheet view is displayed, plots are part of 
the Analysis object for the current global worksheet. 

If you create plots while the normal worksheet view is displayed, plots are 
associated with the Analysis object of the selected Tube(s), or with the current 
acquisition Tube if no Tube is selected. If more than one Tube is selected before 
you create a plot, plots are drawn for each Tube and staggered on the worksheet. 
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Creating Gated Plots

After gated populations have been defined, use the Drill Down feature to easily 
create a plot showing data from only one population.

1 In a plot showing one or more gated populations, right-click the gate border.

Tip     If the gate border is not shown, first right-click the plot border and 
choose Show Gate > population name.

2 Choose Drill Down from the menu.

A new plot appears with the same plot parameters and axis scale settings, 
showing only data from the selected population.

Duplicating Plots

Duplicate a plot in one of the following ways:

• While holding down the Control key, drag the plot to a new location. The 
plot is duplicated when you release the mouse button.

• Press Ctrl-C to copy a plot; press Ctrl-V to paste it in a new location, such 
as on another worksheet.

• Right-click the plot border and choose Duplicate.
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Editing Plots

You can perform any of the following operations on a plot:

• Move or resize a plot: see Aligning and Resizing Worksheet Elements on 
page 148 or Resizing Plots on page 154.

• Cut or copy a plot and paste it to another worksheet or global worksheet, 
or to any Microsoft Office document: see Exporting Worksheet Elements 
on page 147.

• Duplicate a plot on the same worksheet: see Duplicating Plots on page 152.

• Change plot parameters: see Changing Plot Parameters on page 154.

• Zoom in and out on plot data, or alter plot size: see Plot Tools on page 142 
or Resizing Plots on page 154.

• Change between four- and five-log decade displays for a plot: see Changing 
Log Display on page 155.

• Select and sequence the order of populations to display: see Choosing 
Populations to Display on page 156.

• Show or hide plot grids: see Formatting Plots on page 157.

• Add, remove, or change plot titles and axis labels: see Formatting Plots on 
page 157.

• Display biexponential scales: see Using Biexponential Scaling on page 159.

For each type of plot (Dot, Contour, Density, and Histogram) there are also 
specific formatting and editing features available. See Using the Plot Inspector on 
page 157.
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Resizing Plots

To enlarge a plot, select the plot and drag one of the selection handles. (See 
Aligning and Resizing Worksheet Elements on page 148.) You can also use the 
Increase Plot Size tool to double the size of a plot on a worksheet, and the 
Decrease Plot Size tool to return the plot to its original size.

1 Select the Increase Plot Size tool ( ) and click a plot on the worksheet. 

The size of the plot doubles, making it easier to view individual events. 

2 Select the Decrease Plot Size tool ( ) and click the doubled plot.

The plot returns to its original size. Plots cannot be reduced below their 
original size.

Changing Plot Parameters

To change plot parameters, click the axis label in a plot and choose a parameter 
from the menu that appears (Figure 4-4). You can also change plot parameters 
using the Plot Inspector.

Figure 4-4  Changing plot parameters

parameter menu 
154 BD FACSDiva Software Reference Manual



All parameters specified in the Parameters tab are available. Depending on which 
checkboxes are selected in the Parameters tab, parameters will be listed as 
parameter-A, parameter-H, or parameter-W.

You can also choose Time as a parameter. For more information, see Using the 
Time Parameter on page 113.

Changing Log Display

Log data can be displayed in four- or five-log decade plots. To change the display, 
select the Experiment in the Browser and make the appropriate selection in the 
Experiment Inspector. Log display properties apply to all plots in the Experiment. 

Figure 4-5  Plot displaying log data in four- and five-log decades

Four-log plots display values from 26–262,143; five-log plots display values from 
2.6–262,143. Thus, the first log decade ranges from 2.6–26 or 26–262, 
depending on the selected scale. 

Tip     Use the Show Grid feature to delineate log decades on plots. See Formatting 
Plots on page 157.
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Choosing Populations to Display

Right-click the border of any plot to access a menu 
where you can choose from the following: 

• Show Population Hierarchy—displays the 
Population Hierarchy for the associated Tube. 
See Using the Population Hierarchy View on 
page 179.

• Create Statistics View—displays statistics for 
populations in the plot. See Statistics on 
page 184.

• Show Populations—allows you to select which population(s) to display in 
the plot by selecting the checkbox(es). (Populations can also be selected in 
the Plot Inspector; see Formatting Plots on page 157.)

• Show Gate—shows or hides the gate outline for selected populations in the 
plot. See Hiding and Showing Gates on page 177. This option appears only 
after a gate has been created.

• Bring to Front—allows you to specify which population to display in front 
of the other populations (useful when the events of interest are obscured 
behind another population).

• Send to Back—displays a selected population behind other populations in 
the plot (useful for uncovering events of interest).

• Order Populations by Count—displays smaller populations in front of 
larger populations 

• Duplicate—makes a copy of the plot on the current worksheet.

• Delete—deletes the plot (Alternatively, select the plot and press the Delete key.)

If you gate on a population that has been assigned No Color ( ), no events 
appear in the plot.
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Using the Plot Inspector

The Plot Inspector is used to format plots. Different options are displayed in the 
Inspector when you select one or more plots on the worksheet.

Tip     Select multiple plots to make changes in the Inspector apply to all plots at 
once. Only options available to all selected plots are enabled.

There are four components to the Plot Inspector, accessed by clicking the tabs at 
the top of the Inspector: Plot, Title, Labels, and Dot Plot (or Histogram or 
Contour, depending on the type of plot selected). 

Formatting Plots

Use the Plot tab of the Inspector to view the Tube associated with the plot, to 
view or change the plot parameters and the background color, to turn on 
Biexponential scaling, and to specify the populations to show in the plot.

• Change the plot parameters by choosing a 
parameter from the X or Y Parameter 
drop-down menu (only the X parameter 
can be changed for histograms). All 
parameters specified in the Parameters tab 
are available. In addition, you can choose 
Time.

NOTICE     Parameters can also be changed 
directly on a plot by clicking the axis label 
and choosing a different parameter from 
the menu that appears. See Changing Plot 
Parameters on page 154.

• Turn on Biexponential scaling for the x-
axis, y-axis, or both by selecting the 
corresponding checkbox(es). For more information, see Using 
Biexponential Scaling on page 159.
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• Select the Show Grid checkbox to display gridlines at each log decade in a 
log plot.

Note that gridlines are shown only if the Log checkbox is selected for the 
parameter shown in the plot. See the following examples.

When biexponential scaling is in effect, gridlines delineate the zero-point on 
each biexponential axis:

• Change the plot background color by clicking on the Background Color 
button. A palette appears from which you can choose a new color. 

Tip     Use Plot Preferences to change the default background color for all 
new plots. See Plot Preferences on page 88.

• Select the checkbox for each population to be displayed in the plot. 
Alternatively, deselect a checkbox to hide the population. You can also 

linear fluorescent plot fluorescent plot with
one log parameter

fluorescent plot with
two log parameters
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specify populations using the plot contextual menu. See Choosing 
Populations to Display on page 156.

• Change the population drawing order by deselecting all populations, and 
then reselecting them in the reverse order of how you want them displayed. 
Populations with a drawing order of 1 are displayed in front of populations 
with a higher drawing order.

Using Biexponential Scaling

Digital data can have events with negative values. Biexponential scaling is used to 
show these events on plots and to improve resolution between poorly-resolved 
populations. To activate the feature for either plot axis, select the corresponding 
checkbox in the Plot Inspector. Note how biexponential scaling reveals the 
hidden double-negative population in the following example:

The linear range of the biexponential scale is determined by the extent of negative 
data for each parameter. During acquisition, data is periodically sampled to 
determine the scaling point. Once recording begins, periodic sampling stops if 
scales have already been determined, or after the first time the scaling point is 
determined during recording. Scales are recalculated after recording is finished, 
and anytime instrument settings are changed. If you change a compensation 
coefficient, new scales are calculated.

NOTICE     When scales change due to compensation adjustment or processing of a 
new data file, non-adaptive gates do not change their size or position. Events that 
were inside a gate can fall out of the gate boundary when the biexponential scale 
changes. If you are using non-adaptive gates on a biexponential plot, always 
check gated populations after the scale changes.

no biexponential scaling biexponential scaling: both axes
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Note that width, ratios, and time are always shown on a linear scale; 
biexponential scaling does not apply for these parameters. In addition, original 
event data is maintained as the basis for statistical calculation and FCS export 
regardless of the data display.

For more information about working with biexponential plots, see the following:

• Formatting Plots on page 157 describes how gridlines are displayed on 
biexponential plots.

• Hiding and Showing Gates on page 177 describes gating limitations.

• Batch Analysis on page 192 describes how to batch-analyze data files using 
the same biexponential scales.

To practice using this feature, try the batch analysis tutorial in the BD FACSDiva 
Software Quick Start Guide.

Changing the Plot Title and Axes Label Fonts

Use the Title tab of the Plot Inspector to specify and format the plot title. Use the 
Labels tab to specify whether to hide or show axes labels and to format the axes 
labels.

Figure 4-6  Inspector tabs for formatting plot titles and labels
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• Within the Title tab, click the Title Content checkboxes to add Tube, 
Specimen, or Population names to the plot title. Each checked field will 
appear in the plot title separated by a hyphen (eg, Specimen_001-
Tube_003). 

To create a custom title, click the checkbox next to the blank field and enter 
a title in the field.

• Within the Labels tab, choose to show or hide x- and y-axis labels by 
selecting or deselecting the appropriate checkbox. 

• Within the Title and Labels tabs, format the plot title, axes labels, and tick-
mark labels by making selections in the appropriate Font formatting box.

Formatting Dot Plots

Use the Dot Plot tab of the Inspector to specify how many events to show in the 
plot during analysis. Choose from the following:

• Select the upper radio button and enter any 
number of events, from 1% of the total events 
to the total number of events acquired.

• Select the lower radio button and choose a 
percentage of the total events from the drop-
down menu, or enter a percentage value in the 
field. The percentage is determined from the 
total number of events, eg, displaying 25% of events for a 4,000-event file 
will show every fourth event, not the first 1,000 events.

The minimum number of events to display is 1% of the total number of 
events.
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Formatting Contour Plots

Contour plots are not available during acquisition. 
During analysis, use the Contour tab of the Plot 
Inspector to specify the type, scale, and appearance 
of the Contour plot. 

• Choose a scale method from the drop-down 
menu. The default method is probability. 

- Choose Probability to calculate contour 
levels as a percentage of the total event 
number. With this method, contour levels 
are not based on the maximum number of 
events. Instead, the area between each 
pair of contour lines contains an equal 
percentage of the total events. The 
starting value (the outermost contour) is 
half the percentage value entered. For 
example, with 20% probability the 
outermost contour represents 10% of the total number of events, the 
next contour represents 30%, then 50%, 70%, and 90%. 

- Choose Linear Density to calculate contour levels as a percentage of 
the maximum event number (peak height), with equal spacing between 
contour lines. The starting value (the outermost contour) is half the 
value entered. For example, with 20% linear density the outermost 
contour represents 10% of the peak height, the next contour represents 
30%, then 50%, 70%, and 90%. Equal spacing tends to put most of 
the contour lines on the higher peaks (representing larger numbers of 
events) and might not show lower features.

- Choose Log Density to calculate contour levels as a percentage of the 
maximum event number (peak height), with logarithmic spacing between 
contour lines. Log-density contours begin at the innermost contour using 
the peak height percentage you entered, and continue until they reach a 
threshold value of 1. For example, with 50% log density, the innermost 
contour represents 50% of the peak height. Each successive contour line 
represents 50% of the preceding contour, so the next contour represents 
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25% of peak height, then 12%, 6%, 3%, and 1%. This method shows 
more detail in the lower regions, while still showing peak heights.

For an example showing each scale method, see the following figure.

Figure 4-7  Contour plot at 20% probability (left), linear density (middle), log density (right)

• Select the Smooth Contours checkbox to reduce irregularities in the 
contour lines. Smoothing does not affect statistics calculated for contour 
plots. However, when contours are smoothed, population colors can 
appear outside the gates that define them. Deselecting smoothing will 
disable other options for formatting contour plots. See Figure 4-8 for an 
example of an unsmoothed plot.

• Select the Show Outliers checkbox to display data (points) that fall outside 
the lowest contour level.

• Select the appropriate radio button under Appearance to change the look 
of the contour plot using contour lines only (in their population colors), fill 
color only, or contour lines and fill color. When fill color is used, color 
shading lightens as contour levels increase (Figure 4-8).

Figure 4-8  Contour plot with smoothing deselected (left); contour lines and fill color (right)
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Formatting Density Plots

Use the Contour tab of the Plot Inspector to change 
a Contour plot to a Density plot, and to specify the 
scale and appearance of the Density plot. 

• Choose the plot resolution, from 128, 256, or 
512 bins. Data from adjacent bins are added 
to condense higher resolution data (more bins) 
into the chosen number of bins.

• Choose a scale method from the drop-down 
menu. The default method is probability. 

- Choose Probability to calculate density 
levels as a percentage of the total event 
number. With this method, density levels 
are not based on the maximum number of events. Instead, the number 
of events between each level contains an equal percentage of the total 
events. The starting level (outermost color) is half the percentage value 
entered. For example, with 10% probability the lowest level represents 
5% of the total number of events, the next level represents 15%, then 
25%, 35%, and so on.

- Choose Linear Density to calculate density levels as a percentage of the 
maximum event number (peak height), with equal spacing between 
density levels. The starting value (the lowest level) is half the value 
entered. 

- Choose Log Density to calculate density levels as a percentage of the 
maximum event number (peak height), with logarithmic spacing 
between density levels. Log-density levels begin at the innermost 
contour using the peak height percentage you entered, and continue 
until they reach a threshold value of 1.
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For an example showing each scale method, see the following figure.

Figure 4-9  Density plots at 5% probability, linear density, and log density

• Select an option under Density Appearance to display density levels in 
multiple colors, with a different color for each level; in the population 
color, where the color starts from the population color and fades to white 
as the levels rise; or in grayscale, where the color starts from gray and 
lightens to white as the levels rise (Figure 4-10).

Figure 4-10  Density plots with multicolor, population color, and grayscale appearance
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Formatting Histograms

Use the Histogram tab of the Inspector to format histograms. The y-axis scale 
can show either event counts or percentage of events in the histogram. For either 
method, you can set the maximum value or have it automatically calculated by 
the software.

• Select Automatic Counts if you want the 
y-axis to scale automatically to the highest 
peak in the histogram.

• Select Automatic Percentage if you want the 
histogram to scale automatically to the 
highest percentage of the histogram data. 

The software finds the highest peak in each 
histogram and divides the number of events 
in the highest peak by the total number of 
events in the histogram. This percentage is 
used as the maximum value for the y-axis, 
and changes automatically as the data 
displayed in the plot changes.

• Select a value from the Percentage to Ignore menu to disregard outlying 
events when calculating the y-axis scale. 

A high number of events at either end of the x-axis can skew the maximum 
value. When a value is specified, the software disregards the selected 
percentage of bins at each end of the x-axis when automatically calculating 
the y-axis scale. 

• Select Manual Counts to display a fixed count on the y-axis. Enter an 
integer between 1 and 50,000 events in the numeric field.

• Select Manual Percentage to display a fixed percentage value on the y-axis. 
Enter an integer between 1 and 100 in the numeric field.

• Select the Fill Histogram checkbox to fill in the area between histogram 
peaks. Deselecting the checkbox will show the individual bins. (Individual 
channel bins are more apparent on a zoomed-in histogram.)
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• Select the Smooth Histogram checkbox to display smaller spikes around 
the histogram peaks. Smoothing does not affect histogram statistics.

Gates

Gates are used to identify and define subsets of data, or populations, on plots 
with linear, logarithmic, or biexponential scales. After defining gates, you can 
combine them to create joined, intersected, or inverted gates. Gated populations 
can be used to generate statistics and limit the number of events collected or 
stored in the database. You can restrict a plot to display one or more populations, 
display populations in a hierarchical view, and use the Population Hierarchy view 
to create subsets within defined populations. 

Gates are defined using tools on the Worksheet toolbar ( ). 
There are three types of gating tools: 

• Manual gating tools such as the Polygon or Rectangle Gate tool allow you 
to define gate boundaries. See Drawing Manual Gates on page 168.

• Automatic gating tools such as the Autopolygon or Autointerval Gate tool 
automatically define gate boundaries for a selected population. Gate 
boundaries remain static after they are defined. See Creating Automatic 
Gates on page 170.

• Snap-To gating tools such as the Snap-To or Snap-To Interval Gate tool 
automatically define gate boundaries, but the boundaries change when data 
in the gate changes. See Working With Snap-To Gates on page 171.

smoothing
turned on
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To practice using gate tools, try the gating exercises in the BD FACSDiva 
Software Quick Start Guide.

Tip     To create multiple gates, double-click a gate tool. The tool remains selected 
until you press the Escape key, select another tool, or click the same tool again.

NOTICE     Because of how digital data is displayed on a log scale, populations can 
be split or events can be hidden next to the plot axis. When you are drawing a 
gate, make sure to include all events. When events are on the axis, extend the gate 
boundary past the axis to capture all events or use biexponential scaling to 
visualize all events.

NOTICE     If you change the number of log decades for plots after gates have been 
defined, gated populations might be affected.

Drawing Manual Gates

With manual gating tools, the user defines gate boundaries. Manual gates include 
Polygon, Rectangle, Quadrant, or Interval gates. 

Note that populations defined by intervals and quadrants retain the color of their 
parent unless you have specified otherwise in User Preferences (see Gate 
Preferences on page 87). You can also change the color of a population using the 
Population Hierarchy Inspector; see Changing the Color of Events on page 180. 

Use the Polygon Gate tool to create a Polygon gate on a dot, density, or 
contour plot.

1 Select the tool and click in the plot to establish the starting point (first 
vertex).

2 Move the cursor to create the next vertex and click. 

3 Continue moving the cursor and setting vertices; double-click the last vertex 
to complete the gate.

Use the Rectangle Gate tool to create a Rectangular gate on a dot, density, or 
contour plot. 

1 Select the tool and click in the plot to position the gate.

2 Drag diagonally until the gate outline is the required size.
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Examples of each type of gate are shown in the following figure. The histogram 
shows events from the Polygon gate. Notice how the population color does not 
change when you draw an Interval gate.

Figure 4-11  Polygon (P1), Rectangle (P2), and Interval (P3) gates

Examples of each type of quadrant gate are shown in the following figure. Each 
plot shows events from the Polygon gate in the previous example. Notice how the 
population color does not change when you draw a Quadrant gate.

Use the Interval Gate tool to select a range of events in a plot. Interval gates can 
be used on dot, density, or contour plots, as well as histograms. 

1 Select the tool and click in the plot to position the left edge of the interval.

2 Drag the mouse to position the right edge.

Use the Quadrant Gate tool to divide a dot or contour plot into four separate 
populations. Each quadrant population can be named and colored individually. 
Quadrant populations can be used for subsetting or sorting.

1 Select the tool and click in the plot.

2 Drag the mouse to position the intersection of the quadrant markers; the 
cursor location is indicated by the coordinates at the bottom of the plot 
(Figure 4-12 on page 170).

3 (Optional) Drag a pivot point to rotate the top or right segment, or drag an 
offset handle to offset a segment from the center point.

For pivoted or offset segments, Shift-click on the quadrant boundary to return 
the gate to its rectilinear form.
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Figure 4-12  Rectilinear, pivoted, and offset quadrant segments

Creating Automatic Gates

With automatic gating tools, gate boundaries are defined when you click on a 
population in a plot. Unlike Snap-To gates, gate boundaries remain static after 
they are defined. Automatic gates include Autopolygon and Autointerval gates. 

Always inspect populations defined by automatic gates to ensure all 
required events have been included.

Use the Autopolygon Gate tool to automatically create a Polygon gate around 
a population in a dot, density, or contour plot.

1 Select the tool and click a distinct population in the plot. 

2 Verify that the gate includes required events.

Use the Autointerval Gate tool to automatically select a range of events in a 
dot, density, contour, or histogram plot. 

1 Select the tool and click on a peak in the plot. 

2 Verify that the gate includes required events.

x and y coordinates of cursor location

pivot point offset handle
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Working With Snap-To Gates

Two types of Snap-To gates are available: Snap-To polygon gates and Snap-To 
interval gates. Snap-To gates are like Autopolygon and Autointerval gates in that 
a gate is drawn automatically when you click on events in a plot. Unlike their 
respective counterparts, however, Snap-To gates are automatically redrawn when 
data in the gate changes. 

Figure 4-13 illustrates the difference between an Autopolygon gate and a Snap-
To polygon gate. Notice that the Snap-To gate outline appears thicker to 
differentiate the Snap-To feature. The Snap-To gate changes after data is recorded 
while the Autopolygon gate remains the same.

Figure 4-13  Autopolygon (P1) vs Snap-To gate (P2)

Use the Snap-To Gate tool to automatically create a Snap-To polygon gate 
around a population in a dot, density, or contour plot.

1 Select the tool and click a distinct population in the plot. 

2 Verify that the gate includes required events.

Use the Snap-To Interval Gate tool to automatically select a range of events in a 
dot, density, contour, or histogram plot. 

1 Select the tool and click on a peak in the plot. 

2 Verify that the gate includes required events.

recorded datalive acquisition
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NOTICE     Snap-To gates do not work well with diffuse clusters or rare events. 
Also, populations defined by Snap-To gates (and any populations derived from 
them) cannot be sorted.

A Snap-To gate will change under the following circumstances:

• after recording data, if the Snap-To gate was created during live acquisition 
or on a plot without any data displayed

• if a change to the gate hierarchy results in a change to the data appearing in 
the Snap-To gate

• if you edit one of the polygon vertices

NOTICE     After moving a vertex, the Snap-To gate does 
not readjust automatically. You can force the gate to 
readjust by right-clicking on the gate boundary or on the 
population in the Population Hierarchy view (see Using 
the Population Hierarchy View on page 179) and 
choosing Recalculate from the menu that appears. 

Adjusting the Movement of Snap-To Gates

A Snap-To gate is automatically redrawn when the data in the plot changes, such 
as when live acquisition is finished or new data is read into the plot. When 
updating, the Snap-To gate searches for a cluster closest to where it was originally 
placed. If no cluster can be found, the system beeps and the Snap-To gate 
maintains its original position.

You can change how far the gate moves to find a new cluster by adjusting the 
Movement value. The Movement range is a percentage of the plot width, or 
resolution, from 0–100%. A higher Movement value allows the Snap-To gate to 
travel greater distances to locate a cluster. The Snap-To gate retains this setting if 
another data file is read into the plot or the gate is applied to a new data file.

1 Select one or more Snap-To gates in a plot.

2 In the Inspector, deselect the Auto Movement checkbox.
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When the checkbox is selected, movement of the Snap-To gate is limited to 
the software default value of 18 (not much movement).

3 Adjust the slider control toward the right until the gate encompasses the 
population of interest.

Alternatively, enter a value in the Movement field and press Return.

Adjusting the Size of Snap-To Gates

Cluster variability can cause BD FACSDiva software to draw a Snap-To gate 
around only a portion of a population. Use the Size feature to adjust automatic 
sizing of the gate. A higher Size value allows the Snap-To gate to encompass a 
greater number of outlying events; a lower value restricts the gate to fewer 
outlying events. The Snap-To gate retains this setting if another data file is read 
into the plot or the gate is applied to a new data file.

1 Select one or more Snap-To gates in a plot.

2 In the Inspector, deselect the Auto Size checkbox.

When the checkbox is selected, the software automatically determines 
population size.

slider control
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3 Adjust the slider control toward the right 
until the gate encompasses the entire 
population.

Alternatively, enter a value in the Auto 
Size field and press Return.

Tip     Display gate statistics to view the 
effects of the gate changes.

The following figure shows how adjusting Auto Size affects the Snap-To 
gate in the plot.

Figure 4-14  Snap-To gate with automatic sizing (left) and user-adjusted sizing (right)

Tethering Snap-To Gates

A Snap-To gate requires a minimum number of events in order to find a cluster. 
To automatically gate a small number of events or analyze an area of a plot that 
might or might not contain events, you can tether one or more manual gates to a 
Snap-To gate. Tethered gate(s) move relative to the Snap-To gate.

This feature is useful when you expect changes in the population of interest in 
relation to another population. You can use tethered gates to help automate rare 
event analysis. Tethered gates have the same properties as regular gates. For 
example, a plot can be gated and statistics can be generated from a tethered gate.

slider 
control

Auto Size on Auto Size off
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The following restrictions apply to tethered gates.

• For Snap-To polygon gates, only Interval gates with the same X parameter, 
or two-dimensional gates with the same X and Y parameters can be 
tethered. For Snap-To interval gates, only one-dimensional gates with the 
same X parameter can be tethered.

• Only manually drawn gates can be tethered to Snap-To gates.

• Only one Snap-To gate can be tethered to a manual gate; however, one 
Snap-To gate can be tethered to many manually drawn gates.

• If you move, resize, or reshape the Snap-To gate, the tethered gates remain 
the same. When you read in the next or previous file, the Snap-To gate 
reverts to its previous position, size, or shape.

• If you move the tethered gate, the relative position is remembered and used 
when reading in the next or previous file.

• A tethered one-dimensional gate can move only on the X axis (horizontally).

Follow these steps to create a tethered gate. For an example showing how 
tethered gates adjust for subsequent data files, try the batch analysis tutorial in 
the BD FACSDiva Software Quick Start Guide.

1 Create a polygon gate (P1) and a Snap-To gate (P2) in an appropriate plot.

2 Select P1 in the plot.

3 In the Gate Inspector, select the value in the Tethering field.

A menu appears listing all Snap-To gates in 
the current plot and other plots that share 
the current plot’s parameters. 

4 Choose P2 from the Tethering menu.

The P1 gate boundary changes and a chain-
link icon appears next to the gate label to 
indicate that the gate is tethered, as shown 
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in the following figure. Note that a tethered gate has a bold outline similar 
to a Snap-To gate.

Editing Gates

Any gate can be moved or resized, but you cannot add a vertex to or delete a 
vertex from an existing gate. Statistics are automatically updated after a gate is 
edited. Changes to a parent gate will affect all populations derived from that gate 
(see Population Hierarchy on page 178).

1 Click once on a gate to select it.

Selection handles appear on the gate.

2 Make changes to the selected gate; click outside the plot to deselect it.

• To resize a gate, drag any of the selection handles to a new location.

• To delete a gate, select the gate and choose Edit > Delete.

Alternatively, right-click the gate and choose Delete from the menu. 
Gates derived from a deleted gate are also removed. For Snap-To gates, 
any gates tethered to a deleted gate are untethered.

• To move a gate, drag the border of the gate. Note that the label moves 
with it. You can move the gate label independently by dragging just the 
label.
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NOTICE     To avoid confusion, keep gate labels close to the populations they 
identify. Labels for quadrant gates in rectilinear or offset mode cannot be 
moved outside their respective quadrants, however labels for pivoted 
quadrant gates can be moved past their respective segments.

Note that non-adaptive gates on biexponential plots keep their on-screen 
size and shape regardless of the plot’s scaling. You might have to move 
gates in response to new event positions as the scale changes.

Hiding and Showing Gates

The boundaries of defined gates and their gate labels can be hidden or shown in 
any plot that shares the same parameters as the plot containing the original gate. 
To do so, right-click the border of the plot and choose Show Gate from the menu 
(Figure 4-15).

• If the gate boundary and label are currently showing, they are hidden.

• If the gate boundary and label are currently hidden, they are shown.

Figure 4-15  Hiding a gate boundary and label

NOTICE     You cannot show a gate in a lin/log plot if the gate was created on a 
biexponential plot, and you cannot show a gate in a biexponential plot if the gate 
was created on a lin/log plot.
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Population Hierarchy

All gates and their defined populations are listed in a Population Hierarchy view. 
Use the Population Hierarchy to see all populations defined for a Tube and to 
view the relationship between gated populations.

For example, to define cell subsets during immunophenotyping of a whole blood 
sample, you first identify the lymphocytes, and then individual cell populations. 
The Population Hierarchy view shows how these populations are identified by 
first defining a subset of lymphocytes from the whole blood sample (All Events), 
and then separating the lymphocytes into T, B, and NK cells. See Figure 4-16.

Figure 4-16  Immunophenotyping hierarchy and corresponding Population Hierarchy view

Tip     To avoid errors when defining population subsets, always keep the 
Population Hierarchy in view. A population can remain selected after you change 
its name or color, and you can accidentally create a subset with the next defined 
population when you did not intend to. This is immediately apparent when the 
Population Hierarchy is in view.

To show the Population Hierarchy view, do one of the following.

• Right-click a Tube or plot and choose Show Population Hierarchy.

• Select a Tube or plot and then press Ctrl-G.

• Select a Tube or plot and choose Populations > Show Population Hierarchy.

You can move or resize a Population Hierarchy view just like any other worksheet 
element; see Aligning and Resizing Worksheet Elements on page 148. 

whole blood

lymphocytes

T cells
B cells

NK cells

CD4+ CD8+
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Using the Population Hierarchy View

Use the Population Hierarchy view to

• rename populations—Select any population and enter text to change its 
name. The new name will appear on all plots displaying that population.

• define population subsets—For an example, try the gating tutorial in the 
BD FACSDiva Software Quick Start Guide.

• change the color of defined populations—Double-click the color box next 
to the population name and choose a new color from the menu. See 
Changing the Color of Events on page 180.

• view gate properties for any population—Place your cursor over any 
population to see the plot parameters its gate was drawn on, or its 
relationship to other gated populations.

• view the relative percentages of different populations—To see how these 
numbers are calculated, see Calculating Statistics on page 189.

NOTICE     Because some events reside in more than one population, sibling 
percentages do not always add up to 100%. Invalid values are represented 
by ####.

• display statistics for a single population—Right-click any population in the 
Population Hierarchy view and choose Create Statistics View from the 
menu that appears.

• delete populations—Select any population and press the Delete key.

gate properties
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Using Population Hierarchy Inspectors

Click anywhere inside the Population Hierarchy header to see the Hierarchy 
Inspector; click a population in the view to see the Gate Inspector. 

• Use the Gate Inspector to change the population name and the color of 
events in a gated population. (You can also change a population name or 
event color directly in the Population Hierarchy view.)

• Use the Hierarchy Inspector to select which information should appear in 
the Hierarchy view and to change the font.

Changing the Color of Events

By default, populations defined by quadrants and intervals are not assigned a 
color ( ) in the Population Hierarchy view; they retain the color of their parent 
gate. The default settings can be changed using User Preferences (see Gate 
Preferences on page 87). For all other gate types, populations are assigned the 
color of the last gate they satisfy.

Population colors can also be changed manually after a gate is defined:

1 Double-click the color box in a Population Hierarchy 
view or click the Color box in the Gate Inspector.

2 Choose a new color from the menu that appears or click 
the No Color box ( ) to leave the gated events uncolored.

Gate Inspector

Hierarchy 
Inspector

color box
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Creating Population Subsets

To restrict a subset to a certain population of events, do the following: 

1 Select a population in the Population Hierarchy view.

2 Select the appropriate gate tool.

3 Draw a gate in a plot.

Alternatively,

1 Create a new plot, right-click inside the white border of the plot, and 
choose Show Population > Population name (Figure 4-17).

2 Draw a gate around a subpopulation of the displayed events.

In either case, the new population appears indented below the selected 
population in the Population Hierarchy view (Figure 4-17).

Figure 4-17  Creating population subsets

If you display a population that has been assigned No Color in a 
subsequent plot, no events will appear in the plot. If you plan to further 
subdivide any population, first assign it a color.

T-cell subsets
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Defining a Derived Gate

You can use one or more previously defined gates to create a derived (Boolean) 
gate. Derived gates consist of the following:

• Inverted gates use the NOT operator to select events outside a defined gate. 
Any event outside the specified gate satisfies the inverted gate. 

To define an inverted gate, right-click an existing population in the 
Population Hierarchy view and choose Invert Gate.

• Intersected gates use the AND operator to combine two or more individual 
gates. Only events that are in the specified gates satisfy an intersected gate.

To define an intersected gate, select two or more populations in the 
Population Hierarchy view. Right-click the selected populations and choose 
Intersect Gates.

inverted gate

intersected gate
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• Joined gates use the OR operator to combine two or more individual gates. 
An event that falls in any of the specified gates satisfies the joined gate.

To define a joined gate, select two or more populations in the Population 
Hierarchy view. Right-click the selected populations and choose Join Gates.

• Rest of gates select all remaining events that do not fall into any of the child 
gates of a parent gate. Thus, you can only access the Rest of option when 
you select a gate that already contains children. 

To define a Rest of gate, right-click a parent population in the Population 
Hierarchy view and choose Rest of. Events in the Rest of population retain 
the coloring of their parent unless you choose to change the color. The 
color was changed in the following example to illustrate the events.

joined gate

“Rest of” gate
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Statistics

BD FACSDiva software generates statistics from the linear values of acquired 
events. Statistics can be displayed for any parameter and calculated for any 
defined population. Statistics are displayed on the worksheet, like a plot, and can 
be exported to a file. 

NOTICE     During acquisition, statistics are calculated on the number of currently 
displayed events. Statistics are updated as the display changes. For this reason, 
responsiveness can decline as more statistics are calculated on a greater number 
of displayed events. After recording, statistics are recalculated on the total 
number of recorded events.

To display a statistics view, do one of the following:

• Right-click a Tube (normal worksheet view) or global worksheet icon 
(global worksheet view) in the Browser and choose Create Statistics View 
(or press Ctrl-R). The resulting statistics view lists the number of events and 
%Parent for all populations defined for the Tube.

• Right-click any plot and choose Create Statistics View. The resulting 
statistics view lists the number of events, %Parent, and means of the plot 
parameters for all populations displayed in the plot.

• Right-click a population in the Population Hierarchy view and choose 
Create Statistics View. The resulting statistics view lists the number of 
events and %Parent for the selected population.

You can move or resize a statistics view like any other worksheet element. See 
Aligning and Resizing Worksheet Elements on page 148.
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Selecting Statistics to Display

Use the Statistics Inspector to change the font of the statistics view; use the Edit 
Statistics View dialog box to specify the statistics to display. To access this dialog 
box, do one of the following:

• Click the Edit Statistics View button in the 
Statistics Inspector.

• Right-click a statistics view and choose Edit 
Statistics View from the menu.

There are three components to the dialog box, 
accessed by clicking the tabs labeled Header, 
Populations, and Statistics. See Figure 4-18.

Editing Header Information

Use the Header tab to specify information to be included in the header of the 
statistics view. 

Figure 4-18  Statistics editor
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• Select the Use 2 columns for display checkbox to display header 
information in two columns.

• Display a header item by selecting its checkbox; delete an item from the 
header by deselecting its checkbox.

• Select the All checkbox to display all header items.

• Reorder header items by selecting any row and dragging it to a new 
position in the list.

Editing Population Statistics

Use the Populations tab to select the populations and types of population 
statistics to be displayed in each row of the statistics view.

• To include a population in the statistics view, select the checkbox next to 
the population name in the Show Population column. To include all 
populations, select the checkbox at the top of the column.

• Specify additional population information to display by selecting the 
corresponding checkboxes. 

To ensure that statistics views include a Tube identifier, always include the 
Specimen and Tube name in the header of statistics views.
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- Select the All checkbox in the population row to display all 
information for that population. 

- Select the checkbox in a column header to display that information for 
all selected populations.

- Select individual checkboxes in a population row to display a subset of 
the listed information.

• Enter the number of integers (0 through 4) to display to the right of the 
decimal point for the %Parent and %Total Population statistics.

• Delete a population or statistic from the statistics view by deselecting its 
checkbox.

Editing Parameter Statistics

Use the Statistics tab to specify which parameter statistics are to be calculated 
and displayed in each column of the statistics view. Note that responsiveness can 
decline as you calculate more statistics on a greater number of displayed events. 
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• Within each row, select checkboxes for each statistic to display for that 
parameter, or select the All checkbox to display all statistics for that 
parameter.

• Within each column, select the checkbox in a column header to display that 
statistic for all parameters.

• In the All column, select the checkbox above the column header to display 
all statistics for all parameters.

• In the Decimal Places row, enter the number of integers (0 through 4) to 
display to the right of the decimal point for the statistic in the column 
header.

• At the bottom of the editor, select a radio button to specify how statistics 
should be sorted: by Parameter (eg, FITC Mean, FITC CV, PE Mean, PE 
CV) or by Formula (eg, FITC Mean, PE Mean, FITC CV, PE CV). 

NOTICE     Statistics can be displayed for any Tube parameter, as well as for 
the Time parameter. If a label has been specified for a parameter, it will 
appear before the parameter name.

For an explanation of how statistics are calculated, see the following section.
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Calculating Statistics

During acquisition, statistics are calculated on the number of currently displayed 
events. Recorded statistics are calculated on the total number of recorded events. 
All data originating from the digital electronics is linear and statistics are always 
calculated on linear data. When compensation is turned on, statistics are 
calculated on the compensated data.

Invalid values are represented by #### in a statistics view.

NOTICE     Event data can be out of range when the compensation matrix is 
applied. In plots, the out-of-range data stacks at the margins of the plot but 
statistics are calculated on the out-of-range data.

The following statistics can be calculated:

• Number of events—total number of events in the defined population

• Parent—name of the next population up in the hierarchy

• % Parent—number of events in the defined population divided by the 
number of events in the parent gate (next population up in the hierarchy), 
expressed as a percentage

• % Total—number of events in the defined population divided by the total 
number of events in the Tube (all events), expressed as a percentage

• Mean—average linear value for events in the defined population, defined as

where n = number of events in the population, and Xi is a 
value for a particular parameter, where i = 1 to n

• Geometric mean—logarithmic average of the events in the defined 
population 

X Xi
i 1=

n

∑ 
 
 

n⁄=
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This mean is less sensitive to outliers than the regular mean. The geometric 
mean is defined as

where n = number of events in the population, and Xi 
is a value for a particular parameter, where i = 1 to n

NOTICE     The geometric mean cannot be calculated for events with 
negative values. If you include the geometric mean for populations with 
negative values, the resulting statistics will be invalid (####).

• Standard deviation (SD)—a measure of the spread around the mean for 
events within a defined population, defined as

• Coefficient of variation (CV)—the SD divided by the mean within a defined 
population, expressed as a percentage

The CV is defined as

• Median—linear value with an equal number of values above and below it

If the median of the data occurs between two values, those two values are 
added and divided by two to get the median.

NOTICE     During acquisition, BD FACSDiva software uses a faster but less 
accurate method to calculate the median. Thus, after analysis, the median 
value can differ slightly from what is observed during acquisition.

• Min—minimum linear value within a defined population

• Max—maximum linear value within a defined population

Xgeo 10

Xilog
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Exporting Statistics

You can export statistics for use in a spreadsheet, word processing, or other 
third-party application. Statistics information (including header text) is exported 
to a specified file type. To export statistics, do the following.

1 Select one or more statistics views.

2 Choose File > Export > Statistics.

3 Enter a name for the statistics file and specify a storage location in the 
dialog box that appears (Figure 4-19).

Tip     To append statistics to an existing file, locate and select the file, and 
click Save. When prompted, click Append. Results will be appended to the 
selected file.

Figure 4-19  Exporting statistics

4 Specify the file type (CSV or Text), and click Save.

• Use CSV (comma-separated value) files for spreadsheet applications 
such as Microsoft Excel. Note that commas in the text of exported 
fields will cause the text to be split into two cells in the spreadsheet 
application.

• Use Text for word-processing applications such as Microsoft Word.
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Batch Analysis

Use the batch analysis feature to automatically advance a selected set of Tube 
data through an analysis template on a global worksheet. To practice using this 
feature, try the tutorial in the BD FACSDiva Software Quick Start Guide.

1 Select an Experiment, Specimens, or Tubes in the Browser.

If you select an Experiment, all available data will be processed; if you 
select a Specimen, only Tubes under the selected Specimen will be 
processed. Note that Tubes without data are skipped during a batch 
analysis.

2 Right-click the selected item(s) and choose Batch Analysis.

The following dialog box appears:

3 Select the type of analysis to be done.

• Select Auto to analyze all files with no user intervention. Data is 
displayed in the global worksheet for the amount of time specified in 
the View Time field (in seconds) before analysis of the next Tube 
begins. You can make adjustments to your analysis during this pause, 
or let analysis proceed automatically.

• Select Manual to pause the batch after data is loaded for each Tube. 
Click the Continue button to proceed with analysis of the next Tube. 
The View Time field is disabled when you select Manual analysis.

NOTICE     If you make changes to the analysis during a pause, the changes 
remain in effect for the remainder of the Tubes in the batch.
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4 For an automatic batch analysis, choose the amount of time to pause (from 
0–60 seconds) after each Tube’s data is loaded.

NOTICE     Choose zero only if you want to process the batch without 
reviewing the data between Tubes.

5 Specify whether to print worksheets or export statistics before data for the 
next Tube is loaded.

• Select the Print checkbox to print a copy of the analysis for each Tube. 

• Select the Statistics checkbox to export statistics to a single CSV file for 
the batch. The resulting file can be opened with a spreadsheet 
application such as Microsoft Excel. 

Each Tube adds a new row of results to the file. For each population in 
the statistics view, the software adds parameter statistics in the order in 
which they appear in the statistics view. A new header row is added if 
you add or delete statistics or parameters during batch analysis. You 
cannot add, remove, or edit statistics views while the batch is running.

6 For exported statistics, specify the file name and storage location in the 
dialog box that appears.

By default, files are exported to D:\BDExport\Statistics.

Tip     To append data to an existing file, select the file in the export file dialog 
box, and click Save. When prompted, click Append. Results will be 
appended to the selected file.

7 Specify whether to let biexponential scales fluctuate, if applicable.

When the Freeze Biexponential Scales checkbox is selected (default option), 
biexponential scaling does not change during batch analysis—all data is 
processed using scales from the Tube with the Current Tube pointer. To 
allow scaling to change for each Tube, deselect the checkbox.

NOTICE     If you are using non-adaptive gates on a biexponential plot, verify 
that populations are within the intended gate after the scale changes.
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8 Click Start to begin batch analysis.

A progress bar appears in the Status field showing the batch progress as a 
percentage (number of Tubes completed vs total number of Tubes in the 
batch). A message informs you when batch analysis is complete.

Working Offline

When using BD FACSDiva software for offline analysis (ie, the software is not 
connected to an instrument), most instrument, acquisition, and sorting controls 
are unavailable.

During offline operation, you can set up Experiments or analyze recorded data. 
Display data for a recorded Tube by clicking the Current Tube pointer in an open 
Experiment; see Using the Current Tube Pointer on page 52. Analysis objects can 
be edited, moved, copied, and fine-tuned using gates and drill-down 
functionality. Population hierarchies can be derived and statistics can be 
calculated and exported based on data previously acquired.

Tip     When you set up an Experiment offline, you might need to create Tube-
specific instrument settings and disable the Use global instrument settings 
preference in order to maintain the settings when you go online. For example, 
when setting up an Experiment for instrument optimization, if your first Tube uses 
a different set of parameters than your second Tube and the global instrument 
settings option is checked, Experiment-level instrument settings will be updated to 
match the first set of parameters when that Tube is recorded, and these settings 
will remain in effect when you record the next Tube. By disabling the preference, 
individual Tube-specific settings are maintained.
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5

Data Management

The following topics are covered in this chapter:

• Working with BD FACSDiva Data on page 196

• Exporting and Importing Data on page 201

• Exporting and Importing Experiments on page 208

• Using the Data Manager Utility on page 211
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Working with BD FACSDiva Data

Unlike other BD software, BD FACSDiva software does not generate separate 
files for data display, instrument settings, and data. The software stores and 
accesses all experimental data from a single database. As you create Experiments 
in the Browser (see Experiments on page 58), the software writes Experiment 
components to the database.

Any changes to an open Experiment, related Browser elements, or worksheet are 
automatically saved when you close an Experiment, quit the software, or click 
the Save tool on the Workspace toolbar ( ). The database contains a record of 
all Browser items, worksheet elements, Experiment settings, and instrument 
control settings.

Recorded event data is saved separately in FCS 3.0 floating-point format.* Green 
highlighting on a Tube icon in the Browser signifies data has been saved for that 
Tube. To analyze data in another software application or on a different 
BD FACSDiva workstation, data must be exported using the FCS Export option 
in the software (see Exporting FCS Files on page 201).

* For more information, see http://www.isac-net.org.

To ensure that data can be accessed by the software, do not move, rename, 
or delete the BDFACS.db file, BDFACS.log file, or BDData folder inside the 
BDDatabase folder. Do not change the name of any file or folder within the 
BDData folder.
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Maintaining Data

Because all data is saved in a database, the database can fill up the hard drive. It 
is important to maintain the database by keeping the size below recommended 
limits, backing up the database on a regular basis, and deleting Experiments, 
Specimens, or Tubes that are no longer needed.

• The number of events that can be recorded for a single Tube varies 
inversely with the number of gates and parameters (scatter parameters, 
fluorophores, area, height, width, and ratios). For optimal performance, 
limit the number of parameters to only those that are required.

• Monitor the disk capacity (see Verifying Database Size on page 199). The 
amount of hard disk space required for the database must not exceed 
15 GB (the remaining disk space is reserved for a backup copy). When you 
are approaching the limit, delete unneeded Experiments or back up 
Experiments and store them in an offsite storage location.

• Back up the database weekly.

• Be sure you have successfully completed a copy, record, duplicate, print, 
save, or delete operation before closing BD FACSDiva software. Because 
some operations take time to complete, you risk losing unsaved data if you 
terminate the software prematurely. 

Defragment the hard disk on a regular basis (eg, weekly). Diskeeper® defragmen-
tation software is installed on workstations purchased through BD Biosciences. 
To run the program, choose Start > Programs > Executive Software Diskeeper. 
You can program the software to defragment the disk automatically on a preset 
schedule. 

To preserve the integrity of your data, follow these precautions:

Data loss can occur if the defragmentation process is interrupted. 
BD recommends that you back up your data before running the 
defragmentation procedure and allow sufficient time to defragment the 
drive. 
Chapter 5: Data Management 197



• BD Biosciences recommends that you disable sleep mode on your computer 
monitor when running BD FACSDiva software. Pressing keys while the 
system is waking up could execute an unwanted command that might 
result in loss of data without your knowledge.

Table 5-1 summarizes options for maintaining the BD FACSDiva database using the 
tools provided with the software. Follow the procedures established in your 
laboratory for scheduling data backups. General guidelines are provided in the table.

Table 5-1  Data management options

Option Function When to Do See...

Export FCS Preserves FCS 2.0 or 3.0 list-mode dataa 
for analysis by a compatible software 
application or reanalysis (In case of 
data loss, files can be imported back 
into BD FACSDiva software.)

a. Analysis objects are not retained; only FCS files, Browser hierarchy, and instrument settings are included.

After each 
significant 
Experiment

page 201

Export 
Experiments

Relocates Experiments to a specified 
drive with the option to remove them 
from the current database on 
completion of export

When 
necessary to 
free up disk 
space

page 208

Delete 
Experiments

Frees up space in the database and hard 
drive by removing unnecessary or 
outdated components

When 
necessary to 
free up disk 
space

page 200

Back up 
database

Copies the current database to a 
specified drive

Weekly page 212
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Optimizing Data Processing

To save memory (and disk space for permanent storage), it is recommended that 
you save only parameters that are being used (for example, by deleting UV 
parameters when not running a UV experiment).

While there is no impact on data collection or instrument performance, 
responsiveness can decline as more plots, statistics, gates, and events are 
displayed for each Tube. To improve system response time, limit the number of 
plots displayed in the viewable area of the Worksheet frame.

Verifying Database Size

The database should not exceed 40–45% of the available disk space. (The 
remaining space is reserved for a backup copy of the database.) To determine the 
size of the database, do the following.

1 Use Windows Explorer to view the contents of the BDDatabase folder. 

2 Select the BDData folder, the BDFACS.db file, and the BDFACS.log file.

3 Right-click the selected items and choose Properties. 
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A window appears showing the size of the selected components.

Tip     To determine the amount of disk space being used, open the disk in 
Windows Explorer. The disk capacity and space used is shown.

Deleting Experiments

Do the following to delete unneeded Experiments. 

1 Export FCS files or Experiments or back up the database to safeguard 
important data.

Tip     When exporting Experiments, select the checkbox to automatically 
delete the Experiments after export; the remaining steps are not needed.

2 In the BD FACSDiva Browser, select the Folders or Experiments you want 
to remove.

NOTICE     When you delete a folder, you delete all Experiments within the 
folder.

• To select multiple contiguous elements, click the first element; then 
hold down the Shift key while you select the last element.

• To select multiple discontiguous elements, hold down the Control key 
while you select each element to be removed.

3 Press the Delete key.

Alternatively, right-click selected elements and choose Delete from the 
contextual menu.

If the sum of all data files is approaching 15 GB (or 40–45% of the total 
disk space), delete or archive (export and delete) Experiments to free up 
space on the drive. 

Deleting Experiments also deletes any associated event data. Back up the 
database or export Experiments or FCS files before you delete Experiments.
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Exporting and Importing Data

Data for one or more Tubes can be exported to an FCS file that can be read by 
other BD software and third-party applications. Files can be exported in FCS 2.0 
or 3.0 format. To accommodate other software applications, FCS 2.0 log data is 
scaled down to four log decades during export. 

NOTICE     Instrument settings are written to the FCS file but cannot be opened as 
a separate file in BD CellQuest Pro or BD CellQuest software. Instrument 
settings are not transferable between different cytometers. To include Analysis 
objects in the export (plots, gates, and statistics views), export the entire 
Experiment. See Exporting and Importing Experiments on page 208.

Use commands in the File menu to export and import Experiments and FCS files. 

Exporting FCS Files

Note that you can enable a user preference to export FCS files automatically after 
each Tube is recorded. See FCS Preferences on page 88. When files are exported 
automatically, they are exported as FCS 3.0 with all parameters included. The 
FCS 3.0 format allows a floating point average to be maintained.

Follow the steps in this section to export FCS files when the automatic export 
preference is disabled. 

When you export compensated data with negative values (this is possible in 
BD FACSDiva software; see Using the Compensation Tab on page 115) as 
FCS 2.0, the negative values are set to zero in the exported file. When the 
file is imported and analyzed in another software application or in 
BD FACSDiva software, statistical results can be different from the original 
file. 
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1 Select Experiments, Specimens, or Tubes to export.

Data can be exported from closed or open Experiments; multiple items can 
be selected for exporting at one time. Individual FCS files will be generated 
for each Tube in a selected Specimen or Experiment.

Note that Experiment- and Specimen-level keywords are exported with 
Tubes. User-defined keywords are included in the header of FCS files.

2 Choose File > Export > Export FCS.

Alternatively, right-click the selected item(s) and choose Export FCS.

3 Specify the FCS file version and parameters to export in the dialog box that 
appears (Figure 5-1).

Figure 5-1  Export Parameter options

.

When multiple files are selected, options apply to all exported files. 
202 BD FACSDiva Software Reference Manual



• Select the file format: FCS 2.0 (1024 or 10-bit resolution) or 3.0 
(262,144 or 18-bit resolution). When FCS 3.0 is selected, only linear 
data can be exported; the Log option is disabled for all parameters.

To make an exported file compatible with BD CellQuest Pro software, 
export it as FCS 2.0 with a maximum of 16 parameters (8 parameters 
for BD CellQuest software). BD recommends exporting only Area 
measurements, not Height. To analyze compensated data, make sure 
the Enable Compensation checkbox is selected for each exported Tube. 
Remember to run files through BD FACS Convert software before 
attempting to open them in BD CellQuest Pro or BD CellQuest 
software. Refer to the BD FACSConvert User’s Guide for instructions.

• Select Linear or Log for each parameter to be included in the data file; 
click None for parameters to exclude. (Log is available only for 
FCS 2.0 files.)

FCS 2.0 log data is always exported in four decades; if the data spans 
five decades, only the upper four decades are included. You cannot 
select Log for the Time parameter; it is always exported as Linear.

Tip     Minimize the file size by excluding unnecessary parameters (select the 
None radio button). For FCS 3.0 files, make sure to include all parameters 
included in compensation calculations. See Important Considerations on 
page 206.

4 Click OK. 

5 In the Save Export dialog box, verify the file storage location.

• Click the Browse button to change the file storage location. Navigate 
to a different directory in the dialog box that appears.

drive\folder\subfolder
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• Click the Details button to view the relative directory path and file 
name for each exported Tube. Note that the file names are taken from 
the Specimen_Tube names in the Browser and cannot be changed.

Tip     To avoid confusion, store exported FCS files in a folder different from 
exported Experiments. BD Biosciences recommends that you store exported 
FCS files in the BDExport\FCS folder that is set up for you during software 
installation.

6 Click Save to export the files.

Importing FCS Files

To convert imported data to the 18-bit linear format read by BD FACSDiva 
software, the software performs the following calculations.

• Linear data saved in FCS format from another software application is 
normalized to the range of BD FACSDiva linear data using the following 
formula:

where XLIN = linear BD FACSDiva data; XFCS = linear data in FCS file; 
resolution = resolution in FCS file (256; 1024; or 262,144)

• Log data imported from FCS files is converted to linear data using the 
following formula:

where XLIN = linear BD FACSDiva data; XFCS = log data in FCS file; 
#dec = number of decades in FCS file (usually four); 
res = resolution in FCS file (256 or 1024)

This places the data on the same scale as BD FACSDiva four-log data, from 
26–262,144.

XLIN XFCS
218

resolution
----------------------×=

XLIN 10

xFCS #dec×
res

-------------------------- 218

10#dec
--------------×=
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Follow these steps to import an exported file. The same procedure can be used to 
import an FCS 2.0 or 3.0 file from any BD Biosciences software application.

1 Open the Experiment that will contain the imported files.

Files can be imported into an open Experiment only. You can open an 
existing Experiment or create a new one.

2 Choose File > Import > FCS files.

3 Locate the files you want to import in the dialog box that appears.

• Use the buttons in the dialog box to find the files to be imported.

• Select multiple files by holding down the Control key as you click the 
file names.

NOTICE     You can select any type of file, but only those files saved in a valid 
FCS 2.0 or 3.0 format will be imported.

FCS files within an exported Experiment do not contain the same 
information as FCS files exported using the Export FCS command. Do not 
import FCS files within an exported Experiment using the Import FCS files 
command. 

change drive up one folder level
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4 Click Import.

A progress bar appears showing the status of the import.

For each valid FCS file, a Tube is created in a Specimen in the currently 
open Experiment. The Specimen name is determined by keywords in the 
FCS file. If any of the following keywords is defined, the first defined 
keyword is used as the specimen name: $SRC, SAMPLE ID, PATIENT ID. 
Otherwise, a default name of Specimen_00x is used.

In the example shown to the right, the new 
Specimen is appended with _002 since the 
Experiment already contains a Specimen_001.

If the FCS file contains the TUBE NAME keyword, 
the value for that keyword is used as the Tube 
name. If no TUBE NAME keyword exists, the FCS 
file name is used as the Tube name.

Important Considerations 

Note the following behavior when exporting or importing FCS files.

• Any plots, gates, and statistics views associated with a Tube are not 
included with an FCS file. To include Analysis objects, export or import the 
Experiment, rather than the FCS file.

• While importing an FCS file, if the software determines that the file is too 
large to fit into memory, the data will be truncated and a warning message 
displayed.

• Data cannot be acquired in an imported Tube unless the data was imported 
as FCS 3.0, and the file was generated using BD FACSDiva software v2.0 
or later. 
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• If an imported Tube does not contain instrument settings from 
BD FACSDiva software v2.0 or later, the instrument settings cannot be 
copied, and the Duplicate Without Data option is disabled when the Tube 
is selected in the Browser.

• When you export FCS 2.0 files, the Enable Compensation checkbox must 
be selected for each Tube in order to export compensated data. If the files 
are exported as uncompensated data (Enable Compensation checkbox 
deselected), data can be recompensated after importing.

When you import FCS 2.0 files, the files cannot subsequently be 
uncompensated after importing if the files were exported as compensated 
data (Enable Compensation checkbox selected). Compensation values will 
be set to zero in the Inspector although the data appears compensated in 
the plots. Data can be further compensated by increasing the 
Compensation values.

• When you export FCS 3.0 files, a valid compensation matrix might not be 
created if a Tube is exported with only a subset of its recorded parameters 
(not all parameters chosen in the Export Parameters dialog box). In this 
case, only compensated data is exported. 

If the Tube contains enough parameters to construct a valid compensation 
matrix, uncompensated data is exported with the corresponding 
compensation matrix. 

FCS 2.0 log data is scaled down to four log decades during export, which 
can also impact statistical results. After importing an FCS 2.0 file, any events 
that were below channel 26 are placed at 26, which can change statistics.

When you export compensated data with negative values (this is possible in 
BD FACSDiva software; see Using the Compensation Tab on page 115) as 
FCS 2.0, the negative values are set to zero in the exported file. When the 
file is imported and analyzed in another software application or in 
BD FACSDiva software, statistical results can be different from the original 
file.
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Exporting and Importing Experiments

Experiments can be exported to the hard drive or an offsite storage location using 
the Export option on the File menu. When the export is complete, you can 
choose to have the software remove the exported Experiments from the Browser, 
which removes them from the database, frees disk space, and can improve 
computer performance.

An exported Experiment contains all Browser elements and their hierarchical 
structure as well as worksheets and associated Analysis objects (plots, gates, 
statistics views). Experimental elements are exported as an XML file, while 
experimental data is exported in FCS 3.0 file format. To read the contents of the 
Experiment, import it back into BD FACSDiva software using the Import 
Experiments command.

Exporting Experiments

1 Select one or more Experiment icons in the Browser.

Tip     If one of the Experiments is open or expanded, use the Ctrl key to select 
only Experiment icons.

2 Choose File > Export > Experiments.

FCS files within an exported Experiment do not contain the same 
information as FCS files exported using the Export FCS command. Do not 
import FCS files within an exported Experiment using the Import FCS files 
command. To prevent confusion, BD Biosciences recommends that you 
store exported Experiments in the BDExport\Experiments folder that is set 
up for you during software installation.

Make sure you choose the Experiments command, rather than the 
Experiment Template command. Data is not included when you export an 
Experiment as a template.
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3 Make appropriate selections in the Export Experiments dialog box 
(Figure 5-2).

Figure 5-2  Exporting Experiments

• Verify the Experiments listed are those you intended to export. If not, 
click Cancel and repeat steps 1 through 3.

• Select the Delete experiments after export checkbox if you want to 
delete the listed Experiments from the Browser after export. 

• Specify the directory where the Experiments will be stored. Enter the 
directory path by typing, or click the Browse button and select the 
storage location in the location dialog box that appears.

Tip     To avoid confusion, store exported Experiments in a folder separate 
from exported FCS files.

4 Click OK.

The export process begins. If the Delete experiments after export checkbox 
was selected, each Experiment will be deleted from the Browser 
immediately after its successful export.

NOTICE     Exported Experiments cannot be imported into previous versions 
of BD FACSDiva software.
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Importing Experiments

Experiments from the current or previous versions of BD FACSDiva software can 
be imported using the Import Experiments command. If an identically named 
Experiment already exists in the Browser, the imported Experiment is appended 
with _00x, where x is the next consecutive number for Experiments of the same 
name.

NOTICE     Only BD FACSDiva Experiments can be imported using this command. 
To import data from another application, use the Import FCS files command as 
described in Importing FCS Files on page 204.

1 Choose File > Import > Experiments.

2 Locate the Experiment to be imported in the dialog box that appears 
(Figure 5-3).

Figure 5-3  Location dialog box for importing Experiments

3 Select the folder containing the required Experiment and click Import.

NOTICE     If you select a folder that contains only data, a warning message 
appears. Select only folders containing valid BD FACSDiva Experiments.
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Using the Data Manager Utility

The BD FACSDiva Data Manager utility is installed during BD FACSDiva 
software installation. It can be used to back up the current database to disk or a 
mapped network drive and to replace the current database with a backed-up 
copy. To back up your database to another storage media (CD or tape), refer to 
the documentation provided with your computer.

To launch Data Manager, do the following.

1 Quit BD FACSDiva software, if necessary.

Data Manager cannot launch when BD FACSDiva software is running.

2 Launch BD FACSDiva Data Manager by double-
clicking the shortcut on the desktop.

The following window appears:

Do not relocate the Data Manager utility or run it from a batch file located 
outside the BD FACSDiva application directory.

shortcut icon 
on desktop
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The Data Manager window has two tabs. Click the appropriate tab to initiate the 
following actions.

Backing Up the Database

During a backup, the Data Manager utility copies the current database and 
associated list-mode data to a specified location. Backup files can be stored in any 
location on the hard drive provided sufficient memory is available.  

If the workstation is connected to a network, files can be backed up directly to a 
mapped network drive. See Mapping a Network Drive on page 214. 

NOTICE     Backing up does not free up space on the hard drive as the original files 
are retained. 

Tip     To back up directly to a DVD, use the Data Manager utility to direct-format 
the DVD and then back up to the DVD. Otherwise, back up to the drive and use 
DVD Writer to copy the backup onto the DVD.

Tab Action See...

Backup Create a backup copy of the BDFACS database on a 
specified drive.

the following 
section

Restore Replace the current database with a backup copy from 
a specified drive.

page 215

It is strongly recommended that you back up files to a hard disk or network 
device other than the one containing the database. If you back up to the disk 
containing the database and the hard disk crashes, both the BD FACSDiva 
database and the backup copy will be lost.

Before backing up the database, make sure you have adequate storage space 
on the backup media. Exceeding the capacity of the hard disk can result in 
system errors and potential data loss.
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1 Launch Data Manager.

See Using the Data Manager Utility on page 211. The Data Manager 
window appears with the Backup tab displayed.

2 Verify or change the path of the backup folder in the Directory field.

To change the path, click the Browse button. After mapping a network 
drive, files can be backed up directly to the network. See Mapping a 
Network Drive on page 214.

Tip     BD Biosciences recommends saving each backup in a separate folder and 
not replacing a previous backup. To prevent confusion, create a new, dated 
folder for each database backup. Click the Browse button and use buttons in 
the Select Directory dialog box to create and select a new folder. 

3 Click Backup.

A progress box appears, and a message is shown when the backup is 
complete. 

4 Use Windows Explorer to verify the presence of the backup files in the 
specified location. 
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Data Manager adds three items to the specified folder during a backup:

• a copy of the BDFACS.db database

• a copy of the BDFacs.log

• a copy of the BDData folder containing all FCS files in the database at 
the time of backup

Mapping a Network Drive

If your workstation is connected to a network, use the following instructions to 
create a network drive. Once the network is mapped, you can view the contents 
of the drive by clicking its icon in Windows Explorer or in My Computer. Files 
can be backed up directly to a mapped network drive using the Data Manager 
utility.

1 Launch Windows Explorer.

Choose Start > Programs > Accessories > Windows Explorer.

2 Choose Tools > Map Network Drive.

3 Choose a Drive letter from the Drive drop-down menu.

4 Enter the path of the network backup folder in the Folder field, ie, 
\\servername\foldername.

Alternatively, click the Browse button and navigate to the required folder.

5 Click Finish.
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Restoring a Database

Use the Restore tab of the Data Manager utility to replace the existing database 
with a backup copy. Note that when you restore data from a backup, Data 
Manager automatically stops the Sybase Adaptive Server Anywhere™ service. 
Therefore, make sure you have privileges to stop and restart system services 
before you begin the restore. 

NOTICE     When you restore data from a previous release of the software, you 
need to reinstall the software after restoring the database. This will upgrade the 
database to the latest compatible format. 

1 Launch Data Manager.

See Using the Data Manager Utility on page 211. The Data Manager 
window appears with the Backup tab displayed.

2 Click the Restore tab.

3 Locate your database backup.

To change the path, click the Browse button, or enter the path in the 
Directory field. 

4 Click Restore.

During a data restore, the current database is overwritten by the backup 
copy. Once the restore is in progress, it cannot be stopped or cancelled. To 
save your current data, make a backup before restoring a previous 
database.
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The following message appears:

5 Click OK to continue.

The Data Manager utility verifies that the user has logged in as the 
administrator. If the verification passes, Data Manager restores the backup 
files to the D:\BDDatabase directory.

A progress box appears, followed by a message that the backup is 
complete. 

NOTICE     If an error occurs during this phase of the Data Manager Restore 
process, Sybase Adaptive Server Anywhere might have to be restarted 
manually. See General Software Troubleshooting on page 220 for 
instructions.

6 Click OK to dismiss the message.
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6

Troubleshooting

The tips in this section are provided to help you troubleshoot issues that might 
arise when using BD FACSDiva software. For instrument-specific 
troubleshooting, refer to your instrument manual.

If additional assistance is required, contact your local BD Biosciences technical 
support representative. See Technical Assistance on page xiii.

Troubleshooting suggestions in this chapter are grouped under the following 
headings: 

• Installation Troubleshooting on page 218

• Electronics Troubleshooting on page 219

• General Software Troubleshooting on page 220

• Instrument Setup Troubleshooting on page 224

• Analysis Troubleshooting on page 225

• Data Manager Troubleshooting on page 227

• Printing Troubleshooting on page 229
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Installation Troubleshooting

Observation Possible Causes Recommended Solutions

VxWorks download 
failure

Instrument power 
switched off

Verify the instrument power is on.

Electronics not fully booted Reset the instrument main power 
and restart the computer. After 
turning on the instrument main 
power, wait 5 minutes before 
beginning the software 
installation.

Communication failure 
between workstation and 
instrument

• Quit the software and then 
restart it. 

• If restarting does not work, 
reset the instrument electronics 
by switching the power off, and 
then on. Restart the computer. 

Ethernet cable disconnected 
between workstation and 
instrument

Unplug and then plug in the cable 
connectors and make sure they are 
secure. 

IP address changed Enter the correct IP address. Call 
BD Biosciences for assistance.

Software installed for wrong 
cytometer

Uninstall the software, and then 
reinstall it. Make sure you select 
the correct cytometer at the 
Cytometer Selection screen.

Software message “Error 
1301: Source file not 
found for Data1.cab”

D: drive not recognized by 
installer as a logical drive

Copy contents of CD to C: drive 
(Temp folder) and then click the 
Setup.exe icon.
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Electronics Troubleshooting

Observation Possible Causes Recommended Solutions

“Instrument 
Disconnected” in 
Instrument frame

Instrument power 
switched off

Verify the instrument power is on.

Communication failure 
between workstation and 
instrument

• Quit the software and then 
restart it. 

• If restarting does not work, 
reset the instrument electronics 
by switching the power off, and 
then on. Restart the computer. 

Ethernet cable disconnected 
between workstation and 
instrument

Unplug and then plug in the cable 
connectors and make sure they are 
secure. 

IP address changed Enter the correct IP address. Call 
BD Biosciences for assistance.

“Upgrading firmware…” 
in Instrument frame

Firmware loading incomplete Wait two minutes. If the message 
remains, restart the computer.

“Master DAQ 
Overflow” in 
Instrument frame

Event rate too high Decrease the event rate or verify 
the threshold.

Too many Analysis objects on 
worksheet or too many events 
displayed

Delete Analysis objects, decrease 
the Display value, or delete 
parameters from the instrument 
settings Inspector.

“Instrument not 
responding” Status 
message

Unknown Reset the instrument electronics 
by switching the power off, and 
then on. Restart the computer.

NOTICE     If this occurs during 
sorting, turn off the deflection 
plates before resetting the 
electronics.
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General Software Troubleshooting

Observation Possible Causes Recommended Solutions

Software not launching FTP service started by 
another application

Stop the FTP service for the other 
application. 

1 Choose Start > Settings > 
Control Panel. 

2 Double-click the Administrative 
Tools icon, and then the 
Services icon.

3 Select the conflicting FTP 
service; then click the Stop 
button.

4 Launch BD FACSDiva 
software.

Database loading Verify that the Start Services 
buttons are available. If the 
buttons are disabled, the database 
is still loading. A large database 
can take 30 minutes or more to 
load.

Conflicting application, 
driver, or security update 
installed

Contact your service 
representative for assistance.

Unable to access 
database

Adaptive Server Anywhere 
not running

Verify that the database server has 
been started.

1 Choose Start > Settings > 
Control Panel and double-click 
the Administrative Tools icon.

2 Double-click the Services icon. 

3 Select Adaptive Server 
Anywhere. If the Start button is 
enabled, click the button to 
start the database server. If the 
buttons are greyed out, the 
database could be loading. 
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Software not responding Saving or loading 
large data file

Look for activity on the screen. If 
there is no activity, restart 
BD FACSDiva software.

Too many histograms 
displayed

If you have more than six 
histograms displayed in the 
viewable area of the worksheet, 
move them down on the 
worksheet and scroll up.

Too many plots or gates Reduce the number of plots or 
streamline your gating strategy.

Other applications running in 
the background

Quit all other applications. Do not 
run scheduled tasks such as virus 
scans or disk defragmentation in 
the background when you are 
running BD FACSDiva software.

Calculating large number of 
statistics

Calculating statistics is a memory-
intensive operation. If you are 
calculating many statistics on a 
large number of displayed events, 
wait 1–2 minutes before you use 
the software. Use the Processes tab 
in the Windows Task Manager to 
verify memory usage.

Software frozen Press Ctrl-Alt-Delete; then click 
the Task Manager button. Locate 
BD FACSDiva software in the 
Windows Task Manager, and click 
End Task.

 Unsaved data will be lost.

Software message 
“Hardware key not 
accessible...”

Security module 
disconnected

Verify that the security module is 
securely connected in the USB port 
(see step 15 on page 27), and then 
restart BD FACSDiva software.

General Software Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Error message in Status 
tab

Communication, fluidics, or 
sorting error

Shut down the computer and the 
instrument, and then restart them. 
If the message reappears, contact 
technical support. Make sure you 
provide the exact wording of the 
status message.

Shortcut keys 
(Ctrl-X) or Delete key 
not functioning

Keys not activated Use the menu selections to activate 
the keys. After the initial 
activation, the shortcut keys and 
Delete key can be used.

Numeric keypad 
not functioning

Num Lock key reset Press the Num Lock key on the 
keyboard and try the keypad again.

No wireless keyboard or 
mouse response

Keyboard or mouse too far 
away from workstation

Move the keyboard or mouse 
closer to the workstation.

Obstruction between 
keyboard or mouse and 
workstation

Remove the obstructing object.

Batteries low 1 Replace the batteries. (Refer to 
the documentation provided 
with the keyboard or mouse.)

2 Restart the computer.

Error 12 software 
message

Driver not installed Reinstall the software.

Plot tool disabled No Tube selected in Browser 
(normal worksheets only)

Select a Tube to enable the tool.

No instrument settings 
editor

Current Tube pointer not set Click to set the Current Tube 
pointer.

General Software Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Faulty screen display or 
slow user interface 
response 

Other program running Close all other open programs.

Pointer shadow enabled Choose Start > Settings > Control 
Panel. Double-click the Mouse 
icon and click the Pointers tab. 
Deselect the checkbox to Enable 
pointer shadow; then click OK.

Graphics hardware 
acceleration too fast

Decrease the hardware 
acceleration setting.

1 Right-click the desktop and 
choose Properties. 

2 Click the Settings tab; click the 
Advanced button; then click the 
Troubleshooting tab. 

3 Move the hardware 
acceleration pointer to the left.

4 Repeat all steps for the second 
video card, if applicable.

General Software Troubleshooting (continued)

Observation Possible Causes Recommended Solutions

pointer
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Instrument Setup Troubleshooting

Observation Possible Causes Recommended Solutions

Error creating 
compensation controls

Naming conflict with existing 
control or worksheet

1 Locate the control or worksheet 
that is named (ParameterName) 
Stained Control, and change the 
name. 

2 Create the compensation 
controls again.

Error calculating 
compensation

PMT voltages not consistent 
between compensation 
controls

Re-record all compensation 
controls with the same PMT 
settings.

Insufficient single-stained 
controls for a Setup

Calculate compensation 
manually. See Calculating 
Compensation Manually on 
page 135.

Wrong number of gates for 
control plot(s)

• Display a Population Hierarchy 
view and remove extra gates on 
control plots, if needed.

• When no unstained control is 
included, create a gate around 
the negative population for 
each single-stained control.

No data for one or more 
controls

Record data for all controls.

No root gate for first control Create a P1 gate in the FSC vs SSC 
plot for the appropriate control.

Wrong fluorochrome run for 
Stained Control 

Rerecord all compensation 
controls and recalculate. 

Insufficient events in gated 
population

Adjust the gate to encompass more 
events for the appropriate control.
224 BD FACSDiva Software Reference Manual



 

Error calculating 
compensation 
(continued)

Insufficient separation 
between positive and negative 
populations

Refer to your instrument manual 
for suggestions on how to 
optimize fluorescent signal. 

Rerecord the compensation 
controls, draw new gates, and 
calculate the compensation again.

If automatic compensation fails, 
perform compensation manually. 
See Calculating Compensation 
Manually on page 135.

Analysis Troubleshooting

Observation Possible Causes Recommended Solutions

Fewer events than 
expected in gated 
population

Current Tube pointer on 
wrong Tube

Move the pointer to the correct 
Tube.

On-axis events left out of gate When drawing a gate, make sure 
events on the axis are included.

Plot zoomed Unzoom the plot or make the gate 
bigger.

Laser delay set incorrectly Adjust the laser delay settings. 
Refer to your instrument manual 
for instructions.

Window extension set 
incorrectly

Adjust the window extension. See 
Using the Window Extension on 
page 101.

Instrument Setup Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Missing Analysis objects 
on worksheet 

Analysis objects obscured by 
other objects

Double-click the Tube containing 
the Analysis objects of interest. 
Select the objects on the worksheet 
and move them to another 
location.

No events in plots Current Tube pointer not set Click to set the Current Tube 
pointer next to the appropriate 
Tube.

Data no longer linked to 
Experiment

Contact BD Biosciences for 
assistance in locating the missing 
data.

Duplicated plots out of 
the page boundary

Page positioning lost during 
duplication

Before copying an Analysis object, 
arrange the plots and statistics 
views at the upper and lower 
edges of the page. Use the Next 
button to duplicate Tubes; page 
positioning is maintained.

Differing statistics 
between exported and 
imported file

Compensated data with 
negative values set to zero 
during FCS 2.0 export

• Export the original data as 
FCS 3.0.

• Export FCS 2.0 data with 
compensation disabled.

• If statistical differences are 
significant, rerecord the file.

Analysis Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Data Manager Troubleshooting

Observation Possible Causes Recommended Solution

Data Manager utility not 
launching

BD FACSDiva software in use Quit BD FACSDiva software 
before launching Data Manager.

Message during Backup: 
“Unable to complete 
task. Exit value is: x.”

Attempted to back up 
database into BD FACSDiva 
directory

Do not back up the database into 
the Program Files\BD FACSDiva 
Software folder. Back up the 
database to a different disk 
location.

Software message: “An 
error occurred while 
attempting to restore the 
database.”

No valid backup in specified 
directory

Verify that the directory path is 
entered correctly.

Unable to read or write 
FCS file when attempting 
import or export

Incorrect file name or file 
path

Verify source and target file names 
and paths.

File in use by another 
program

Verify that the file is not in use by 
another program.

File created with an 
unsupported FCS version

Files for import or export must be 
created with a supported FCS 
version (2.0 or 3.0).

Errors in file If the FCS file is corrupt, 
regenerate the file before import 
or export.

Incorrect data in file FCS files must contain list-mode 
data and must have the correct 
byte order.

Data limit exceeded 
(FCS 2.0 only)

FCS 2.0 file format can write up 
to 99,999,999 bytes of list-mode 
data.

Multiple parameters with 
same name in file

Make sure all parameters for an 
FCS file have unique names.
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Unable to read or write 
FCS file when attempting 
import or export 
(continued)

File read-only or hidden Verify that the file is not set as a 
read-only or hidden file.

Data type within file other 
than Integer or Float

When creating the FCS file, data 
type must be either Integer or 
Float.

Incorrect resolution for one 
or more log parameters 

Log parameters must have 1024 
resolution.

Incorrect keyword value Verify that all keywords are 
correctly specified.

Unable to append data to 
an existing FCS file

Instrument settings changed 
since original data collected 

When appending data, make sure 
the instrument settings match 
those of the data already recorded.

File is FCS 2.0 You cannot append data to an 
FCS 2.0 file. Select an FCS 3.0 file 
instead.

One or more Tubes not 
exported

No data in Tubes selected for 
export

Verify that the Tubes selected for 
export contain data. Tubes with 
no data will be skipped.

Incorrect parameters in Tubes 
selected for export

Verify that the Tubes selected for 
export contain the required 
parameters.

Data truncated in 
imported file

File too large to fit in 
available memory

Move the file to a workstation 
with 2 GB of RAM to maximize 
available import space.

Data Manager Troubleshooting (continued)

Observation Possible Causes Recommended Solution
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Printing Troubleshooting

Not all print drivers are compatible with BD FACSDiva software. For optimal 
printing results, BD Biosciences recommends that you use only PCL-native print 
drivers. Emulated or Postscript printer drivers are not recommended. Many 
printers have multiple print drivers available. Check with your printer 
manufacturer to obtain an appropriate driver.

Print spooling problems can occur on some Tektronix Phaser printers, causing 
excessive amounts of data to be spooled. When this occurs, the print spooler can 
corrupt the data. If you experience problems printing through the print spooler, 
try one of the following.

• Print directly to the printer. See the following section.

• Print to file and print the resulting file. See Printing to File on page 230.

• Use a third-party application to print to a PDF file, and then print the PDF 
file.

Printing Directly to the Printer

To set up printing directly to the printer, follow these steps.

1 Choose Start > Settings > Printers.

2 Right-click the appropriate printer icon and choose Properties.

3 Click the Advanced tab.

4 Select the Print directly to the printer radio button (Figure 6-1 on 
page 230).

NOTICE     When using this print option, BD FACSDiva software is not 
available during printing.
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Figure 6-1  Printing directly to the printer

Printing to File

PrintFile is a utility that prints .prn files. Your field service engineer installed it 
during instrument installation. To print files via the PrintFile utility, follow these 
steps.

Enabling the PrintFile Utility

1 Choose Start > Programs > PrintFile > PrintFile and click Settings.

2 Click to deselect the Enable spooler function checkbox and click Save.

3 Click Exit in the PrintFile window.

button 
selected
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Printing

1 In BD FACSDiva software, choose File > Print.

2 Choose the correct printer from the Name drop-down menu.

3 Click to select the Print to file checkbox; click OK.

4 Enter the directory path and file name in the Print to File dialog box; click 
OK.

NOTICE     Always include the .prn file extension at the end of the file name.

The file is saved to the specified directory.

5 Use Windows Explorer to locate the resulting .prn file; double-
click the icon to open the file.

A Print dialog appears. The PrintFile utility is launched and its 
window appears in the background.

checkbox 
checked
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6 In the Print dialog box, click OK.

The file prints on the selected printer. The PrintFile utility remains open. 
Follow the instructions in the window to print subsequent files.

7 Click Exit to quit the PrintFile utility program.
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Appendix A

Menus and Keyboard Shortcuts

This appendix provides a guide to all software menus and a list of the available 
keyboard shortcuts. For more information, see the following:

• Software Menus on page 234

• Contextual Menus on page 235

• Keyboard Shortcuts on page 236
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Software Menus

Choose a menu command in order to perform the corresponding task. When 
keyboard shortcuts are available, they are listed next to the command.
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Contextual Menus

Right-click the indicated object to access the following menus.

Experiment Instrument Settings Global Worksheet

Specimen Tube Analysis
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Keyboard Shortcuts

Keyboard shortcuts are provided for the following functions.

Plot

Objective Key Combination Condition to Activate Shortcut

Start/stop acquisition Click Browser 
pointer

To start, Current Tube pointer must be set 
(green); to stop, acquisition or recording 
must be in progress (yellow or orange 
pointer)

Start/stop recording Alt-click Browser 
pointer

To start, Current Tube pointer must be 
green or yellow; to stop, recording must be 
in progress (orange pointer)

Start batch analysis Alt-S Batch Analysis dialog must be active

Pause batch analysis Alt-P Batch Analysis dialog must be active

Continue batch 
analysis

Alt-N Batch Analysis dialog must be active

New Folder Ctrl-N User icon or folder must be selected.

New Experiment from 
a template

Ctrl-E Item must be selected in Browser.

Open Experiment Ctrl-O Closed Experiment must be selected.

Close Experiment Ctrl-W Open Experiment must be selected.
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Find Experiment Ctrl-F Item must be selected in Browser.

Save Experiment Ctrl-S

New Specimen from a 
panel template

Ctrl-M Item must be selected in an open 
Experiment.

New Tube with an 
analysis template

Ctrl-T Specimen or Tube must be selected in an 
open Experiment.

Duplicate (Without 
Data)

Ctrl-D • Specimen or Tube must be selected in 
an open Experiment (not available for 
imported Tubes).

• Plot must be selected on worksheet.

Cut Ctrl-X Item must be selected in Browser or on 
worksheet.

Copy Ctrl-C Item must be selected in Browser or on 
worksheet.

Paste Ctrl-V Appropriate recipient must be selected in 
the Browser, or nothing must be selected 
for a worksheet element.

Show Population 
Hierarchy

Ctrl-G Tube must be selected in an open 
Experiment or plot must be selected on 
worksheet.

Create statistics view Ctrl-R Tube must be selected in an open 
Experiment or plot must be selected on 
worksheet.

Print active worksheet Ctrl-P Experiment must be open.

To show or hide the following frames:

Browser Ctrl-Shift-B

Instrument Ctrl-Shift-N

Inspector Ctrl-Shift-P

Worksheet Ctrl-Shift-W

Objective Key Combination Condition to Activate Shortcut
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Acquisition Controls Ctrl-Shift-C

Acquisition Status Ctrl-Shift-T

Sorting Ctrl-Shift-S

Carousel Controls Ctrl-Shift-L

Objective Key Combination Condition to Activate Shortcut
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Appendix B

Digital Theory

This chapter gives a brief overview on the following:

• How Digital Signals are Measured on page 240

• Threshold on page 241

• Parameter Values on page 241

• Ratios on page 242

• Compensation on page 242

• Electronic Aborts on page 242
239



How Digital Signals are Measured

In analog mode, pulses are sampled once per event. In digital mode, instrument 
electronics continuously digitize signals to measure the light from the PMTs and 
FSC diode at a speed of 10 MHz, or 10 million times per second. This is done 
with 14-bit analog-to-digital converters that measure light in 16,384 discrete 
intervals. See Figure B-1. 

Figure B-1  Generation of digital data
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FITC
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FSC

SSC
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laser delay

FSC

SSC

FITC

APC

laser delay

analog signals

measure 10,000,000 times/second

10 MHz
FSC

SSC

FITC

APC

00001369631000000000

00023565321000000000

00014678764100000000

000000000001469641000

digital data

digitize in 16,384 levels

14 bits
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Threshold

Because BD FACSDiva data is digital, thresholds can be set as numerical values 
including logical and/or expressions. A threshold can be set on any signal from 
any laser. 

Parameter Values

A parameter is a measurement of a cell property that is determined as the cell 
passes through the laser beam. Each parameter is the output of a single 
photomultiplier tube or photodiode, measuring fluorescent or scattered light. 

Digital data can be measured for different pulse parameters. BD FACSDiva 
software can measure area, height, and width for up to 16 channels (depending 
on your instrument and installed options). Time is also a recorded parameter (see 
Using the Time Parameter on page 113).

• area = sum of all pulse heights (out of 262,144 for a typical pulse)

• peak (or height) = maximum digitized value of the pulse (out of 16,384)

• width = scaled area/height x 64K 

Digital data is displayed on a 262,144 scale. 

Area vs Height

Collecting area measurements for digital data provides greater resolution and 
scalability.

• When measuring area, the electronics add all measurements under the 
pulse, in effect increasing the resolution from 16,384 levels to close to 
300,000 (for most practical applications). This is equivalent to 
approximately 18 bits (218 = 262,144).

To place BD FACSDiva data on the same scale (18-bit resolution), the 
software multiplies all height measurements by 16. 
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• When sheath pressure is low, events remain in the laser beam for a longer 
period, thus increasing the area measurement. In this case, a user-defined 
area scaling factor is used to bring area measurements back on scale. For 
example, area scaling can be used to align area measurements to height 
measurements. See Using Area Scaling on page 99.

Ratios

When working with digital data, ratios are not measured parameters. Ratios are 
calculated mathematically from uncompensated linear data and can be calculated 
between any two parameters, including area vs height.

Compensation

BD FACSDiva compensation is based on mathematical calculations performed by 
real-time digital signal processors rather than on the hardware calculations 
performed by analog electronics. All data is collected as uncompensated linear 
data, thus compensation can be adjusted during acquisition (ie, during setup 
mode) or during the analysis of recorded data. During analysis, data can also be 
converted to log.

Electronic Aborts

Under recommended operating conditions, all events are characterized, 
regardless of how closely they follow previous events. Thus, the rate of electronic 
aborts should be close to zero. 

A small number of electronic aborts can be observed when a window extension is 
used. The window extension increases the amount of time during which the 
signal is measured. When two events pass closer together than the window 
extension allows, the system cannot precisely determine to which event the 
measured signal should be allocated. Therefore, it aborts both events. The 
number of electronic aborts is displayed in the Acquisition Status frame (see 
Acquisition Status on page 108).
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Because aborted events are excluded from compensation calculations and are not 
passed on to the host computer, the system attempts to keep up with the data rate 
by aborting events as it approaches its throughput limit. The rate at which these 
aborts start to be generated depends on how many parameters you acquire and 
how much compensation needs to be calculated. 

If the abort rate exceeds 10–20% of the total event rate, slow the sample 
differential or exclude debris by raising the threshold. The abort rate plateaus at 
half the event rate, and any additional events will be ignored, except during a 
purity sort. In that case, the total event rate will decrease rapidly as the system 
tries to sort. In no case will the system compromise the purity of sorted samples.

For more information about the window extension, see Using the Window 
Extension on page 101.
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Glossary

acquisition Tube Tube selected for acquisition or recording, as indicated by a 
green pointer

analysis Numerical or graphical examination of data

Analysis object Worksheet elements used to analyze a Tube; includes Plots, 
gates, population hierarchies, and statistics views

area scaling Correction factor to place area measurements on the same scale 
as height measurements

batch analysis Software feature that automatically advances a selected set of 
Tube data through an analysis template on a global worksheet

Browser List of all experimental data in a hierarchical view; interface for 
setting up Experiments and recording data

channel Output from the channel DAQ board which measures the input 
of a single detector. Bins on a histogram are also referred to as 
channels.

coefficient of variation 
(CV)

The standard deviation of the data divided by the mean of the 
data; typically expressed as a percentage (also known as Relative 
Standard Deviation)

When applied to channel data measured on a population of cells, 
the CV is a measure of variation independent of the population 
mean.

compensation Process by which spillover fluorescence is removed from 
secondary parameters so that fluorescence values for a 
parameter reflect only the fluorescence of the primary 
fluorophore
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contour plot Graphical representation of two-parameter data in which 
contour lines show the distribution of events 

Similar to a topographical map, contour lines show event 
frequencies as peaks and valleys.

Current Tube pointer Pointer or plot icon next to Tubes in an open Experiment in the 
Browser. Indicates the Tube currently selected for data 
acquisition, recording, or data display on a global worksheet

When the software is connected to the instrument, the pointer 
can also be used to control acquisition.

data file A collection of measured values from a single Tube combined 
with text describing the data that has been stored to disk

density plot Graphical representation of two-parameter data in which 
colored dots show density for events with the same signal 
intensity

A density plot simulates three-dimensional event display.

derived gate Combination of one or more defined populations using the 
Boolean operators AND (intersected gate), OR (joined gate), or 
NOT (inverted gate)

dot plot Graphical representation of two-parameter data 

Each axis of the plot displays values of one parameter; a dot 
represents an event (particle).

Experiment Group of elements used to acquire and analyze data from the 
flow cytometer

An Experiment can include any combination of the following: 
global worksheets, Specimens, Tubes, FCS data files, keywords, 
plots, gates, statistics, population hierarchies, worksheets, text, 
lines, or arrows.

flow cytometry 
standard (FCS)

Standard format for flow cytometer data files
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frame Software element displaying main software components

Frames can be hidden or shown, resized, and closed. The 
visibility, size, and position are saved when you quit the software 
and are restored when you start the software the next time.

gate Two-dimensional boundary defining a subset of the total sample 
population

See also derived gate, interval, population.

global worksheet Worksheet for which elements can be used to display multiple 
data sets by moving the Current Tube pointer

See also worksheet, Worksheet frame.

histogram Graphical representation of single-parameter data

The horizontal axis of the graph represents the increasing signal 
intensity of the parameter, and the vertical axis represents the 
number of events (count).

Inspector Software interface for viewing or modifying the attributes of a 
single object or set of objects on the worksheet or in the Browser

instrument settings Collection of values for parameters measured, photomultiplier 
(PMT) voltages, threshold, compensation, and the calculated 
parameters Log and Ratio

interval One-dimensional boundary defining a subset of the total sample 
population

See also gate, population.

laser delay Amount of time between signals from different laser intercepts

panel template Group of labeled Tubes commonly used together in the same 
experiment

Any Specimen can be exported as a panel. Along with the 
Specimen name and collection date, an exported panel contains 
a group of Tubes and any parameter labels defined for each 
Tube. Exported Specimen panels can also include global 
worksheets and their associated Analysis objects.
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parameter Measurement of a cell property that is ascertained as the cell 
passes through the laser beam

Each parameter is the output of a single photomultiplier tube or 
photodiode, measuring fluorescent or scattered light.

population Data subset defined by a gate or interval

Snap-To gate Gate drawn automatically when you select a peak or cluster of 
events in a plot

Unlike static gates, Snap-To gates are automatically redrawn 
when data in the gate changes.

Sort Layout Floating window containing sorting instructions and controls 
(available only on sorting instruments)

The Sort Layout designates which device will be used to collect 
sorted particles and which particles will be sorted into each sort 
location. Up to four sort counters can be displayed in the 
window to give ongoing status during a sort.

Specimen Browser object representing the type of material to be analyzed, 
the collection date, and user-defined keywords

spectral overlap Fluorescence detected in a channel other than the one for which 
it is intended

stopping gate Population for which events are to be counted

storage gate Population for which events are to be recorded

tethered gate Static gate linked to move relative to a Snap-To gate

threshold A trigger signal and level of discrimination to eliminate 
unwanted events

Only events with parameter values above the threshold will be 
analyzed.

Tube Browser object representing instrument settings, acquisition 
criteria, parameter labels, recorded event data, Analysis objects, 
user-defined keywords, and Sort Layouts for a single sample

window extension Extension of the time during which a pulse is sampled
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window gate Time during which a pulse is sampled, based on the threshold 
value and window extension

worksheet Tabbed area within Worksheet frame for displaying data for a 
specific Tube. All objects on a worksheet are printed with a 
single Print command.

See also global worksheet, Worksheet frame.

Worksheet frame Window for viewing Analysis objects on worksheets or global 
worksheets
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Index
A

aborts, electronic
about 242
count 108
rate 108

Acquire button 104
acquisition

counters 108
criteria 75, 105
events to record 69
into imported Tubes 206
pointer See Current Tube pointer.
starting 104, 106
starting automatically 86
status 108
stopping 75, 104, 106
time 109
Tube 52, 104, 108

Acquisition controls
about 104
starting acquisition 104, 106

Adaptive Server Anywhere See database.
adding

arrows 143, 145
elements to Browser 53
institutions 37
instrument configurations 94
label-specific controls 125
lines 143, 145
pages to worksheets 144
parameters 95, 111

passwords 40
text 146
threshold parameters 114
users 36
worksheets 138

adjusting
compensation 115
instrument settings 110
voltages 112

administration 36
Administrator access 38
Adobe Acrobat Reader, installing 24
aligning worksheet objects 143, 148
analysis

about 137
batch 192
pointer 53
saving with Tubes 87, 141
templates 77, 79
troubleshooting 225

Analysis objects
about 79
aligning 143
copying 81
lost during import 206
missing 226
saving with Tubes 87, 141

And threshold values 114
appending

data 105, 113, 228
statistics 191, 193
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applying Setups 131, 132
area parameters 112, 241
area scaling

about 99, 242
FSC 99
viewing settings 74, 102, 129

arrows
adding 143, 145
deleting 146
formatting 146

assistance, technical xiii
Auto Movement, adjusting 172
Auto Size, adjusting 173
Autointerval gates 143, 170
Autopolygon gates 142, 170
axis labels

changing 157
hiding/showing 160
scale 113, 155

B

Backspace key, troubleshooting xiii
backup, database

about 212
frequency 198
restoring 215

batch analysis 192
BD FACSDiva software See software.
BDDatabase files, importance 28, 196
biexponential scaling

about 159
during batch analysis 193
enabling 157, 159
gating limitations 159, 177
showing zero point 158

blue Acquisition pointer 107
Boolean

gates 182
keywords 84

Bring to Front 156
Browser

about 16, 48
adding new elements 53
buttons, customizing 89
deleting elements 200
functions 49
organizing 56
reordering Experiments 49
resizing 46
searching 50
shortcuts 49
toolbar 53

C

calcium flux 113
calculating

compensation
manually 135
using Instrument Setup 128

statistics 106, 184, 189
CellQuest Pro, exporting files for 19, 

203
changing

instrument configurations 96
passwords 40

clearing status messages 98
coefficient of variation (CV) 190
color

arrows 146
Current Tube pointer 107
default gate preferences 87, 168
density appearance 165
fill, contour lines 163
lines 146
plot background 158
population events 179, 180

compatibility, software 19
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compensation
See also Instrument Setup.
about 122, 242
adjusting 115
calculating

manually 135
troubleshooting 224
using Instrument Setup 128

controls 122, 124
disabling 115
gates 127
incomplete 134, 207
label-specific controls 125
using labeled controls with 133
with exported files 207

components
software 16
workspace 44

computer requirements 17
configuration, instrument

about 93
adding 94
changing 96
deleting 96
editing 95

contextual menus 235
contour plots

about 150
creating 142
formatting 162

controls
acquisition 104, 106
compensation 122, 124
instrument (software) 91, 92
label-specific 125
single-stained 123

conventions, user’s guide xii
converting

files 19
imported data 204

copying
Analysis objects 81
plots 147
Spectral Overlap values 116
worksheet objects 147

counters
abort 108
acquisition 108
clearing 105

creating
Experiments 54, 58
folders 53
gated plots 152
gates 167
global worksheets 55, 140
instrument settings 54
keywords 82
Plate Layouts 55
plots 142, 151
population subsets 179, 181
Snap-To gates 171
Sort Layouts 55
Specimens 54
Tubes 54, 104
Tube-specific settings 118
worksheets 138

Current Tube pointer
about 52, 106
advancing position 107

customer support xiii
customizing Browser buttons 89
cytometer type, selecting 23
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D

data
analysis tools 137
appending 105, 113, 228
converting 204
deleting 200
displaying 53, 106
exporting 201
FCS 107, 196
finding 50, 66
importing 201
linear 113, 203, 204
log 113, 155, 203
maintaining 197
management options 198
missing 226
optimizing processing 199
overwriting 105
preserving integrity 197
restoring backup 215
saving 61, 196
truncated 206, 228

Data Manager
backing up data 212
launching 211
not launching 227
relocating 211
restoring data 215
troubleshooting 227

database
about 196
backing up 212
backup frequency 198
files, importance 28, 196
installing 23
limits 197
maintaining 197, 199
not starting 220
renaming items in 49
restoring 215
size limits 199

Decrease Plot Size 149, 154
default global worksheet 89
defining

keywords 82
populations 167

defragmenting disk 20, 197
delay, laser 74, 98
Delete key, troubleshooting xiii, 222
deleting

arrows 146
data 200
Experiments 200
gates 176
instrument configurations 96
keywords 85
lines 146
parameter labels 68
parameters 96, 112
plots 156
populations 179
ratios 117
text 146
threshold parameters 114
users 39
worksheets 139

density plots
about 150
formatting 164

derived gates 182
detectors, assigning 93, 111
digital

data parameters 241
signal measurement 240

disabling
compensation 115
users 39

disk
backing up to 212
defragmenting 20, 197
restoring backup from 215
space, maintaining 197
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Display All 51
display, troubleshooting 223
displaying

See also showing.
Browser 48
data 53, 106
Inspector 47
log 60, 112
population statistics 179
populations 156, 158
statistics 156, 184

distributing objects 143, 148
documentation, electronic 17
dot plots

See also plots.
about 150
creating 142
formatting 161

downloading VxWorks 26, 218
drawing order, population 156, 159
Drill Down feature 152
duplicating

plots 152, 156
Tubes 74, 87
worksheet objects 147

E

editing
gates 176
headers, statistics views 185
instrument configurations 95
keywords 68
parameter statistics 187
plots 153
population statistics 186
Statistics views 185
templates 64
text 146
worksheets 145

Elapsed Time 109

electronic
aborts 108, 242
documentation 17
troubleshooting 219

error messages
An error occurred... 227
check instrument status 98, 222
Error 12 222
Error 1301 218
FTP Service... 220
Hardware key... 221
Instrument Disconnected 219
Instrument not responding 219
Master DAQ overflow 219
No Instrument... 222
Upgrading firmware 219

events
changing color 179, 180
displaying 106, 161
not showing in plots 181, 226
processed 109
troubleshooting 225

Events to Record 69, 75, 105
Experiment Layout 67
Experiments

about 58
creating 54, 58
deleting 200
editing keywords 68
exporting 66, 208
finding 50, 66
hiding shared 51, 65
importing 59, 66, 210
importing data into 205
Inspector 60
naming conventions 61
opening 60
renaming 49
reordering 49
saving 61, 196
sharing 65
templates 59, 61
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exporting
analysis templates 79
data 201
Experiment templates 61
Experiments 66, 208
FCS files 19, 88, 201, 206
file conversion 19
keywords 82
log data 203
panel templates 71
parameters 202
plots 147
statistics 191
status reports 103

F

FACSDiva software See software.
FCS files

automatic export preference 88, 89
compatibility 19
compensating after import 207
exporting 201, 206
importing 204, 206
in Experiments 205, 208
keywords 82
minimizing size 203
troubleshooting 227
truncated data 206, 228
version 203

files
compatibility 19
installation locations 28
printing to 230

filling histogram peaks 166

finding
data 66
Experiments 50
plots 138
Tubes 138

fluorochromes
assigning detectors 93, 111
spectral overlap 115, 122, 123

folders
creating 53
moving Experiments into 57
searching within 51, 67

formatting
axis labels 160
contour plots 162
density plots 164
dot plots 161
histograms 166
plots 157

frames
about 44
Acquisition Controls 104
Acquisition Status 108
Browser 48
Inspector 47
Instrument 92
moving 46
resizing 46
restoring defaults 47
showing/hiding 45, 237
Worksheet 138

FSC area scaling 99
FTP conflict 220
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G

Gate Inspector 180
gated plots, creating 152
gates

about 167
Autointerval 143, 170
automatic 170
Autopolygon 142, 170
Boolean 182
changing globally during setup 127
color 87, 168
compensation 127
creating 167
deleting 176
derived 182
editing 176
hiding/showing boundaries 156, 177
intersected 182
Interval 143, 169
inverted 182
joined 183
manual 168
not visible 156, 177
Polygon 143, 168
preferences 87
Quadrant 143, 169
Rectangle 143, 168
Rest of 183
Snap-To 143, 171
Snap-To–Interval 143
Stopping 75, 105
Storage 75, 105
tethered 174
tools 142
viewing properties 179

general preferences 86
geometric mean 189
global instrument settings 119, 129

global worksheets
See also worksheets.
about 138, 139
creating 55, 140
customizing 145
default 89
differentiating 139
exporting analysis templates 79
setting as default 70
using 140
viewing 138, 142

green
Current Tube pointer 107
Tube highlighting 107, 196

grids, showing 158

H

hardware requirements 17
header, statistics view 185
height parameters 112, 241
help, online 17
hiding

gate borders 156, 177
page breaks, numbers 144

Hierarchy Inspector 180
histograms

about 150
creating 142
filling 166
formatting 166
smoothing 167

I

importing
data 201
Experiments 59, 66, 210
FCS files 19, 204, 206

Increase Plot Size 149, 154
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Inspectors
about 47
arrow 145
Experiment 60
Gate 180
Hierarchy 180
instrument settings 110
line 145
Plot 157
Specimen 70
Statistics 185
troubleshooting 222
Tube 74
Worksheet 144

installation troubleshooting 218
installing

Adobe Acrobat Reader 24
BD FACSDiva software 19, 21
database 23
JRE 25
security module 27
Sybase 25, 30
VxWorks 26, 218

institutions, adding 37
instrument

adding configurations 94
changing configurations 96
configuration 93
controls, software 91, 92
deleting configurations 96
disconnected 35, 219
not responding 219
selecting 23
serial number 97, 101
status 97
status report

printing 103
viewing 101

instrument settings
about 78, 109
adjusting 110
applying compensation Setups 131, 

132
components 110
creating 54
global 119, 129
Inspector 110
parameters 111
preferences 87
printing 121
Tube-specific 76, 118
unlinking compensation Setups 130
viewing 78, 109

Instrument Setup
about 123
calculating compensation 128
creating compensation controls 124
creating label-specific controls 125
gates 127
global gate changes 127
troubleshooting 224
using labeled controls with 133
viewing Setup catalog 128

intersected gates 182
Interval gates 143, 169
invalid statistics 189
inverted gates 182

J

Java Runtime Environment (JRE) 16, 25
joined gates 183

K

keyboard
not responding 222
shortcuts 53, 110, 234, 236
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keywords
about 82
defining 82
deleting 85
editing 68
finding 50, 66
naming convention 83
predefined 85

L

labels
axis 160
in compensation Setups 133
moving 176
parameter 68, 75, 94
plot 160

label-specific controls 125
lasers

assigning parameters 93
delay 74, 98
naming 98
viewing settings 74, 102, 129

layout, Experiment
about 67
acquisition settings 69
creating labels 68
editing keywords 68

linear data
calculating statistics 189
display 113
exporting FCS files 203
normalization formula 204

linear density scaling 162, 164
lines

adding 143, 145
deleting 146
formatting 146

log
changing display 112, 155
data conversion formula 204
data, exporting FCS files 203
decades 60, 155
density scaling 162, 164
display considerations 113, 155
displaying 112

logging into software 34, 36

M

manual
compensation calculation 135
gates 168

manuals 17
mapping network drives 214
Master DAQ overflow error 219
maximizing frames 46
maximum linear value 190
mean, calculating 189
measuring digital signals 240
median 190
memory requirements 17, 199
menu commands 44, 234, 235
Microsoft

Office, copying to 147
service pack 18, 20

minimum linear value 190
mouse not responding 222
moving

frames 46
plots 148
Snap-To gates 172
text 146
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N

naming
compensation Setups 128
Experiments 61
keywords 83
lasers 98
populations 179, 180
Specimens 70
Tubes 74
worksheets 144

network drives, mapping 214
Next button 104
numbering worksheet pages 144
Numeric keywords 84

O

offline work 53, 103, 194
opening Experiments 60
Or threshold values 114
orange Acquisition pointer 107
organizing

Browser 56
worksheets 138

overwriting data 105

P

pages, worksheet 144
panel templates 71, 73
parameters

about 111, 241
adding 95, 111
calculating statistics 187
changing on plot 154, 157
crossed out 140
deleting 96, 112
detecting 93
editing 95
exporting 202
labels 68, 75, 94

measuring 112
ratio 117
threshold 114
Time 113, 154

passwords, adding 40
pasting Spectral Overlap values 116
Percentage to Ignore 166
performance, optimizing 199
photomultiplier (PMT) voltages

adjusting 112
change warning 130

Plate Layouts, creating 55
plots

about 150
aligning 143
background color 158
changing parameters 154
contour 150, 162
copying 147
creating 142, 151
deleting 156
density 150, 164
dot 150, 161
duplicating 152, 156
editing 153
exporting 147
finding 138
formatting 157
gated 152
greyed out 140
histogram 150
Inspector 157
log decades 60, 113, 155
magnifying view 142
moving 148
no events in 181, 226
number of events in 106, 161
resizing 142, 148, 154
title content 160
tools 142
troubleshooting 226
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pointer
Current Tube 52, 106
starting acquisition with 86

Polygon gates 143, 168
Population Hierarchy 178, 179
populations

about 167
calculating statistics 186
defining 167
deleting 179
naming 179, 180
reordering 156, 159
showing statistics 186
showing/hiding in plots 156, 158
subsetting 179, 181
viewing statistics 179

preferences
about 86
FCS export 88, 89
gates 87
general 86
instrument settings 87
template 89

preserving disk space 197
print drivers, recommended 229
printing

direct to printer 229
instrument settings 121
PrintFile utility 230
status reports 103
to file 230
troubleshooting 229
worksheets 149

probability scaling 162, 164
processed events 109

Q

Quadrant gates 143, 169
quick start guide 17
quitting software 41

R

rates
electronic abort 108
threshold 108

ratios 117, 242
recalculating Snap-To gates 172
recording, starting/stopping 105, 106
Rectangle gates 143, 168
reinstalling software 19
report, instrument status 101
requirements, system 17
resizing

Browser 46
frames 46
plots 142, 148, 154
worksheets 138, 144

Rest of gates 183
Restart button 105
restoring database 215
right-click menus 235
Rule Inspector 145

S

saving
analyses 87, 141
data 196
Experiments 61, 196

scaling
area 99, 242
biexponential 157, 159
freezing during batch analysis 193
histogram 166
log display 113, 155
method, plot 162, 164
ratios 117

searching Browser 50
security module

installing 27
troubleshooting 221
Index 261



Select button 142
Selectable keywords 84, 85
selecting cytometer type 23
Send to Back 156
Sentinel System Driver 16
serial number, instrument 97, 101
service pack, Microsoft 18, 20
services, starting/stopping 220
Setup, compensation

about 128, 129
applying to instrument settings 131, 

132
feature See Instrument Setup.
naming 128
unlinking from instrument 

settings 130
viewing catalog 128

shared Experiments, hiding 51, 65
sharing Experiments 65
shortcuts

Browser 49
contextual menus 235
keyboard 53, 110, 234, 236
keys, troubleshooting 222
software 28

showing
See also displaying.
events in plots 161
frames 45
gate borders 156, 177
grids 158
outliers, contour plots 163
page breaks, numbers 144
populations 156, 158

signals, digital 240
single-stained controls 123
sizing tools 143
sleep mode, disabling 198
smoothing

contour lines 163
histogram peaks 167

Snap-To gates
about 171
adjusting

Auto Movement 172
Auto Size 173

creating 143, 171
recalculating 172
tethering gates to 174

Snap-To–Interval gates 143
software

about 16
administration 36
compatibility 19
components installed 16
installing 19, 21
instrument controls 91
logging in 34, 36
menus 44, 234
not responding 221
preparing to install 20
quitting 41
requirements 18
shortcuts 28
starting 34
troubleshooting 220
uninstalling 29
upgrading 19

sorting
creating Sort Layouts 55
Experiments 49
viewing settings 102

source file not found 218
Specimens

about 70
creating 54
default worksheet with 70
finding 50, 66
Inspector 70
instrument settings 118
naming convention 70
panel templates 71, 73
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Spectral Overlap values
applying to labeled Tubes 133
calculating 128
copying 116
viewing 115, 128

spooling problems 229
standard deviation (SD) 190
Standby, instrument 103
starting

acquisition 104, 106
acquisition automatically 86
Data Manager 211
recording 105, 106
services 220
software 34

statistics
appending 191, 193
calculating 106, 184, 189
exporting 191
invalid 189
showing populations 186
specifying parameters 187
troubleshooting 226
values after import 201, 207
view

displaying 156, 184
editing 185

status
Acquisition 108
clearing 98
instrument 97
messages 97
report See instrument status report.

stopping
acquisition 75, 104, 105, 106
Gate 75, 105
recording 105, 106
services 220
software 41

Storage Gate 75, 105
String keywords 84
subsetting populations 179, 181
Sybase SQL Anywhere 16, 25, 30
system requirements 17

T

technical assistance xiii
templates

analysis 77, 79
Browser buttons and 89
editing 64
Experiment 59, 61
preferences 89
Specimen panels 71, 73

tethered gates 174
text, adding 143, 146
threshold

about 114, 241
count 108
rate 108

throughput 199
Time parameter

displaying 154
exporting 203
in calcium flux 113
values 113

time, acquisition 109
titles, plot 160
toolbars

Browser 53
Worksheet 141
Workspace 45
Index 263



troubleshooting
analysis 225
Data Manager 227
Delete key xiii, 222
electronics 219
events 225
FCS files 227
FTP Service error 220
function keys 222
general software 220
Inspector 222
installation 218
Instrument Setup 224
plots 226
printing 229
screen display 223
security key 221
statistics 226
status messages 98, 222
VxWorks download 218
wireless keyboard, mouse 222

Tubes
about 74
acquisition 52, 104, 108
analysis templates with 77
creating 54, 104
duplicating 74, 87
exporting analysis templates 79
finding 50, 66, 138
green highlighting 107, 196
Inspector 74
instrument settings 76, 118
naming convention 74
optimal number 199
-specific worksheets 86, 104
troubleshooting 228

typographical conventions xii

U

uninstalling software 29
unlinking Setups 130
upgrading

firmware error 219
software 19

USB security module 27, 221
user preferences 86
users

adding 36
administrators 38
deleting 39
disabling 39
guide, electronic 17

V

verifying database size 199
vertexes, moving 172, 176
View Own 51, 65
viewing

gate boundaries 156, 177
gate properties 179
instrument settings 78, 102, 109
Instrument Status report 101
options 46
page breaks, numbers 144
Setup catalog 128
shared vs private Experiments 51, 65
Spectral Overlap values 115, 128
worksheets 138, 142

views
Population Hierarchy 178
statistics 156, 184

voltages, PMT
adjusting 112
change warning 130

VxWorks download 26, 218
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W

width parameters 112, 241
window extension

about 101, 242
viewing settings 102

windows See frames, views.
working offline 53, 103, 194
worksheets

about 138
adding pages to 144
aligning objects on 148
annotating 143, 146
creating 138
deleting 139
duplicating objects 147
editing 145
exporting elements 147
global See global worksheets.
Inspector 144
naming 144
organizing 138
preferences 86
printing 149
resizing 138
toolbar 141
tools 143
Tube-specific 86, 104
viewing 138, 142

workspace
components 44
exporting 147
toolbar 45
view options 46

workstation requirements 17

Y

y-axis scaling 166
yellow Acquisition pointer 107

Z

Zoom tools 142
Index 265
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